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1 Introduction

eRAD PACS™ is a picture archive and communication system (PACS) and teleradiology system used to
receive DICOM images, scheduling information and text reports, organize and store them in an internal
format, and make that information available across a network via web and customized user interfaces.
eRAD PACS is for hospitals, imaging centers, radiologist reading practices and any user who requires
and is granted access to patient image, demographic and report information. eRAD PACS provides
information management and distribution services. The system is comprised of acquisition components,
a central system manager component, diagnostic and review workstation components and an archiving
component.

The sections that follow provide instructions on installing, configuring and using the eRAD PACS viewer.
Operator instructions for all versions of the viewing application are contained in this document.

1.1 General Safety Information
eRAD PACS system components are not approved for direct patient contact applications.

Do not operate the eRAD PACS system components and associated cables in the presence of moisture.

To avoid excessive product leakage and maintain product compliance to medical protective guidance
requirements, the PACS and workstations power cords shall be connected directly to hardwired AC
receptacles.

Federal law prohibits this device from being sold to or used by anyone other than a medical professional.
Do not carry the eRAD PACS system components by the connecting cables.

Follow all safety labels on the equipment.

1.2 Indications of Use

The eRAD PACS system acquires image and patient information from any of several types of medical
imaging modalities. The system’s open software architecture enables hospital network users to enter,
review, archive and print patient demographic information, images and clinical reports received from
imaging modalities, a hospital information system (HIS) and/or a radiology information system (RIS). The
patient demographics and order information can be routed through the hospital network structures and
sent along with the diagnostic images to remote hosts for viewing and to printers for hard copy imaging.
The open system architecture allows for the adoption of changes in technology so that hardware can be
switched while maintaining consistent workflow.

Lossy compressed mammography images and digitized film screen mammography images must not be
reviewed for primary image interpretations. Mammography images may only be interpreted using an FDA
approved monitor that offers at least 5 mega-pixel resolution and meets other technical specifications
reviewed and accepted by FDA.

1.3 Patient Contact

The PACS system components are not approved for direct patient contact applications. The user must
follow hospital cleaning and decontamination policies and procedures.

1.4 Product Safety

The eRAD PACS system has been classified as an acceptable application of use in accordance with
Medical Device regulations. The use of accessory equipment and/or hardware not complying with the
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equivalent product safety and EMC requirements of this product may lead to a reduced level of safety
and/or EMC performance of the resulting system.

1.5 Contact Information

For more information concerning eRAD PACS, or to report a problem with this manual or the software,
contact eRAD technical support.

eRAD, Inc. Technical Support

United States/North America
9 Pilgrim Road
Greenville, SC 29607-5701
Office: +1.864.234.7430
Support: +1.866.414.3723
FAX: +1.864.234.7412

Europe
Maros u. 12
Budapest H-1122, Hungary
Voice: +36.1.489.4700
FAX: +36.1.489.4709

1.6 Abbreviations

The following abbreviations are used throughout this document:

DICOM...... Digital Imaging Communications in Medicine

EIM .......... eRAD/Image Medical Corporation
HL7 ........... Health Level 7
EP.ccverne eRAD PACS

1.7 References

The information contained in this manual references information from other sources, including eRAD
PACS’s online help and other paper documents. Refer to the following sources of information for
additional details on eRAD PACS viewer and server components.

e eRAD PACS Operator Manual

e eRAD PACS browser’s online help
e eRAD PACS viewer’s online help
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2 Getting Started

The eRAD PACS viewer is an application that displays diagnostic quality medical images for review by
radiologists, clinicians and other healthcare personnel. Access to the data generated during an imaging
procedure requires a validated user session. The information in this section provides instructions for
setting up your workstation for eRAD PACS and initiating a user session. The instructions that follow
assume you have access to a workstation that satisfies the minimum required configuration.

eRAD PACS viewers the following system requirements:

System Requirement Specification
Operating System Microsoft Windows 2000, XP or Vista
Minimum RAM 512MB
Recommended RAM 1GB or twice the size of the largest study loaded into the viewer
at one time. 2GB if 3-D or AVI plug-ins are used.
Recommended graphics Direct3D 9.0 and PixelShader 2.0, or later versions.
controller features
Browsers IE 6.0 or later, Mozilla 5.0 or later
Network A networked PC with a connection to the eRAD PACS server

eRAD PACS consists of two viewing applications. They are the active-X viewer and the standalone
viewer. The active-X viewer is a viewing application a user downloads and installs on any compliant
workstation. The active-X workstation executes along side other applications running on the same
workstation.

The standalone viewer is designed to operate without communicating with an eRAD PACS server. This
version of the viewing application is used almost exclusively from a removable CD or DVD, and displays
only the study information contained on the CD/DVD media.

Both viewing applications share the same graphical user interface and offer similar toolsets. With few
exceptions, the instructions for setting up and controlling these viewing applications are the same. When
the instructions for one differ from the other, this manual makes note of the exception and provides
specific details concerning the feature.

2.1 Workstation Setup

Before starting, the workstation must be removed from its shipping package, assembled according to the
manufacturer’s instructions, powered on, and configured to boot up and allow a user to log on.
Furthermore, this manual assumes the workstation has access to the local area network or the Internet,
whichever is required. If the workstation does not meet these minimum requirements, contact your
system administrator, computer manufacturer or ISP for further assistance preparing your workstation for
eRAD PACS.

The eRAD PACS viewer executes on any supported Microsoft Windows platform. The default
workstation configuration is often suitable. The area that most often requires modification is the monitor
and display controller setting. eRAD PACS supports single and multiple monitor configurations, and a
variety of bit depths and resolutions. The instructions in this section describe how to set up Microsoft
Windows monitors to run eRAD PACS.

The information provided in this section assumes the workstation is running a version of Microsoft
Windows that eRAD PACS supports. There are differences between Microsoft 2000, XP and Vista that
may impact the information contained in this manual. By default, all Windows operations are shown for
Windows 2000.
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2.1.1 ADJIUSTING MONITOR CONFIGURATION

Before initiating eRAD PACS, make sure your Microsoft Windows monitor settings are configured for the
best results. Your workstation should be configured for a 32-bit color map or the highest possible color
map if 32-bit is not available. For a single landscape monitor, it is best to set the screen resolution for
each monitor to at least 1280 by 1024. Smaller resolutions are supported if necessary.

Display Properties B I |

Bockgcund || Seresn Saver | mmim | Effects Setings | To check or change the resolution on your Windows computer:

» Open the display settings panel from the desktop by right
clicking on a blank area and selecting Properties. You
can also open the display setting window from the
Windows Control Panel.

» Select the Settings tab.

» Adjust the resolution with the slider bar under Screen

Daplap

Fhap v Pl Morior o HVIDI GeFoece? Ulia Area. The recommended screen resolution is 1280 by
Colors —— - 1024 pixels.
I_m—_ _IEI o » Set the Colors drop down to 32-bit color, or the highest
TCE4 b TEE press . .
- - possible setting.
TS || Wt » Click Apply, and then OK. When prompted to save the
I e settings, click OK.

If you are using a display controller with its own setup page, click on Advanced and then select the tab
that corresponds to the display controller. Follow the instructions in the display controller documentation
to set up the monitor.

2.1.2 CONFIGURING MULTIPLE MONITORS

The eRAD PACS viewer supports one to four monitors. Each monitor can run at different resolutions. It
is possible to mix color and grayscale monitors as well.

eRAD PACS uses the Microsoft Windows display settings to identify the monitors. In the Display
Properties window, when more than one monitor is available, Windows labels them, starting with ‘1’ and
continuing up to the maximum number available. Use these numeric labels when configuring monitors in
eRAD PACS as described in section 4.2.1.

For multiple monitor configurations, you can set the display settings for multiple, independent Microsoft
Windows environments on each monitor, or a single Windows environment that spans across all
monitors. If you select the single Windows environment, you will have to configure the eRAD PACS
viewer so it knows to split its user interface properly across the monitors. Refer to section 4.2.1 for
information on configuring monitors in eRAD PACS.

2.2 Accessing eRAD PACS Server

eRAD PACS is a web-enabled system that the user accesses with a web browser. As a result, many of
the familiar conventions you find when visiting other web sites are available in eRAD PACS. There is the
home page, which is usually the first page you encounter when you gain access to the server. Most of
the system’s information is collected in a hierarchy of other pages that you access by clicking on
hyperlinks. You can click on the browser's Back button to return to the previous page. You can save a
particular page in your Favorites folder. You can even create a link to the eRAD PACS on another web

page.
The eRAD PACS server is organized by a set of tabs displayed across the top of the browser window.

The specific tabs that are available to you depend on the privileges your system administrator assigned to
your user account. The first row of tabs provides access to the general functional areas. Examples
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include Worklist, Administration and Archive. The eRAD PACS viewer is available to the information
displayed on the Worklist page.

2.2.1 INITIATING A BROWSER SESSION

To use the eRAD PACS active-X viewer, you need a workstation connected to a network with access to
the eRAD PACS server, and a supported web browser. Launch the web browser and enter the URL of
the eRAD PACS server into the address line. The URL depends on your facility’s configuration. |If it is
not configured as the browser's home address, ask your system administrator for the URL. The URL can
be a hostname or an IP address. The following examples are all acceptable eRAD PACS URLs:

pacs.eradimagemedical.com == c
http://pacs.eradimagemedical.com |G- & [x & G Jwe oo @ 30 L0 - B
https://192.168.0.1 8 it seonssenetloon VB &

CRADPACS ey
Your workflow solution

It

Sign of

When the browser reaches the eRAD
PACS server, it displays the Main page.
Figure 2.2-1 shows eRAD PACS’s default
Main page. Note that your main page may Signonto
appear different due to customization. SEACEACE

User I
Password:

Regardless of which URL you entered, T s

eRAD PACS forces your connection to use startin eRAD

secure HTTP if the server is configured to M Your workflow solution-
provide secure communications to your
workstation. If HTTPS is required, you
may be prompted to verify the digital
certificate. You can find instructions on
how to accept the digital certificate and [€= LX)

save it as a trusted key in your browser in Figure 2.2-1 eRAD PACS Main Page
the eRAD PACS Operator's Manual.

ne ol hin. wysiemm in resiricted 82
onty

2.2.2 SIGNING ON FROM THE BROWSER

To sign on to the eRAD PACS server, you must possess a unique user account, assigned by your system
administrator. The user account is used to identify you throughout the system. This allows eRAD PACS
to download your personal profile from the server, providing you with the same custom interface
regardless of your location. eRAD PACS also uses your account information to tag your actions
automatically, so you do not have to explicitly enter your identification information each time you create,
modify or delete data.

All versions of the Main page contain sign on fields on the left side of the page as well as a series of tabs
near the top and running the width of the page. The tabs are used to access different eRAD PACS
pages. Before you sign on, the only pages available are the Main page and the Info page.

Enter your User ID and password in the fields on eRAD PACS’s Main page. Note that

EZ‘:L‘EM l;:hi both the User ID and password are case sensitive. By default, e(RAD PACS takes you

to the Worklist page after it verifies your account information. If you wish to go to a

different page, chose your preferred starting point from the pull-down menu just beneath

l#”""d the account ID and password fields. Click on Sign On, or press the return key, to
continue.

Instruction Summary — Signing On
» Launch Internet Explorer or Netscape Navigator.
» Enter your eRAD PACS server URL from your Favorites list, or by typing the IP address into the
address textbox.
» Enter your User ID and password. Both are case sensitive.
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» Click the Sign On Button.

2.2.3 SIGNING ON FROM THE VIEWER
It is possible to log out of eRAD PACS while a study is displayed in the viewer. El————

You can explicitly request to log out from the browser, or the eRAD PACS can |~
automatically log you out after a period of inactivity. If the eRAD PACS viewer Pesswordsauied

is open when this happens, a login prompt appears on your screen. To log into N [151%

eRAD PACS, enter the password for the account displayed in the Name field, Posno [
and click Sign On. Note that both the User ID and password are case Cance
sensitive.

If you want to change the user account, cancel the popup window, and log on from the browser, or use
the Sign On item in the File menu.

2.3 Installing the eRAD PACS Viewer

The different eRAD PACS viewer applications have slightly differing installation procedures. The sections
below provide instructions for downloading the viewer initially, and for upgrading to a new version when
one is available.

The active-X viewer requires specific user privileges from eRAD PACS. These are defined in their
respective section. Be aware that differences exist when downloading the viewer setup package
depending on the browser version or operating system you use. While the wording or figures may be
different than what is printed in this manual, the general procedure is the same.

To install an application on a Windows 2000, XP or Vista workstation, the Windows user account must
have Windows Administrator or Power User privileges. Sometimes it is easier to run the eRAD PACS
viewer setup program as an administrator while logged on as the current user, rather than logging in as
an admin. For instructions on how to run the setup program as an administrator in Windows 2000, XP or
Vista, see section 2.3.1.

2.3.1 ADMINISTRATOR ASSISTED VIEWER INSTALLATION

On Windows 2000, XP and Vista systems, your Windows user account must have administrator or power
user privileges before you can install the eRAD PACS viewer. In most cases, the system administrator
will log into Windows using an account with these privileges to install the viewer. Sometimes, it is easier
to instruct Windows to install eRAD PACS viewer with an administrator account’s privileges using the
current account. Windows provides this function with the Run As command.

To use the Run As command, you need to know the ID and password of an account with administrator
privileges, but you do not have to log out of Windows. Follow these instructions to install eRAD PACS
using the Run As command.

Step 1. Download the eRAD PACS viewer by selecting the Download Viewer tab on the
worklist page, and select to save it to your workstation.

Step 2. Locate the file, pbsetup.exe unless you changed the name when saving it, using
Windows Explorer, the Microsoft Management Console (MMC), or the Control Panel.

Step 3. Press and hold down the SHIFT key as you right-click the file icon, and select Run As
from the popup menu.

Step 4. In the dialog box, select the option Run the program as the following user, and enter
the user name and password of a Windows account that has administrator privileges.

Step 5. Click OK to start the installation process.

The install process proceeds as described in the section detailing the installation procedure for the
specific viewer you are installing or upgrading.
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2.3.2 INSTALLING ACTIVE-X VIEWER

To download and install the eRAD PACS active-X viewer, your user account must have Open privileges,
which your system administrator can assign to you. If you log into a workstation using an account that
has Open privileges, eRAD PACS checks for the viewer and attempts to install it automatically if it is not
found.

After you log on to the eRAD PACS server and go to the Worklist page, a popup notice may appear on
the screen. If you do not have Windows administrator rights, the notice simply informs you that the viewer
is unavailable and instructs you to contact the system administrator in order to download and install a
copy onto the workstation. If you have Windows administrator rights or if you are upgrading to a newer
version of the viewer, the notice asks if you want to download and install the latest viewer. When you
consent to the upgrade, eRAD PACS downloads the viewer and invokes the installation wizard.
Depending on your version of Windows, you have the option to download and store the eRAD PACS
setup file and activate it manually, or to download and activate (Open) it when complete. There is no
need to save the setup file to disk, so select to Open the file when the download completes.

In some instances, eRAD PACS initiates the viewer installation process without prompting the user. This
occurs when the workstation is running certain versions of Microsoft Windows and when using certain
versions of Microsoft Internet Explorer. When the download completes, the installation wizard starts
automatically.

To manually download and install a copy of the eRAD PACS viewer, click
the Download Viewer tab in the second row of tabs under the Worklist tab.
Carrections @ eRAD PACS downloads the viewer and invokes the installation wizard. As
in the automatic install, there is no need to save the setup file to disk, so

chose to Open the file when the download completes.

— Adrin

The eRAD PACS installation wizard takes you through the installation process step by step. Figure 2.3-1
shows the initial screen of the installation wizard. The process is as follows:

Step 1. The InstallShield© Wizard launches. Read the
information, take any necessary actions and
click Next. Press the Ctrl and Esc keys
simultaneously to view the task bar if you need
to quit any other applications. It is not required
to quit Internet Explorer or Netscape 440 S Vs - asene
Navigator. ~ 18 vk D P e s

Step 2. Read the License Agreement and click Yes if
you agree to the terms.

Step 3. If the default location for eRAD PACS is
acceptable, click Next. Otherwise, select a _
new location and click Next. S Lt i el s

Step 4. Click Finish when the install is completed.

hrs:a!ﬁug eRAD PACS Viewer®

ne
Befue g s Setun progiam

Bt Clck N 3 cardnun st thes Srfug pro xparn

AAFHIRG, Thes grugrem i probeciod by cusymh lovs ared
damattnal bt

“He 7 Canced
The viewer does not start automatically. Either open a
study or manually start the viewer by selecting it from
the Program Files menu under the Start button in the . .
system tray. When eRAD PACS is executing, it Figure 2.3-1 Install Wizard Screen
appears as an icon in the taskbar.
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Instruction Summary — Downloading the Viewer

» Log on and go to the eRAD PACS worklist page.

» If you are prompted to download the viewer, click Yes. Otherwise, click the Download Viewer tab.

» If asked to save or open, select Open. When the download completes, select Open to run the setup
program.

» InstallShield© Wizard will take you through the setup. Accept the defaults, click on the Next button to
advance, and click Finish to complete.

» You will return to the Work List. Single-click on a patient name to launch the viewer and load the
images.

2.3.3 INSTALLING STANDALONE VIEWER

The eRAD PACS standalone viewer is used most frequently to display images stored on a CD or DVD.
You can create a CD/DVD containing images and results stored in eRAD PACS, and an application to
display them, a number of ways. To guarantee the viewer installed on a CD/DVD is the eRAD PACS
standalone viewer, follow the instructions in the eRAD PACS Operator's Manual for creating removable
media. The information in this section assumes the CD/DVD was created according to the instructions in
that manual.

The eRAD PACS standalone viewer never gets installed on the workstation. Instead, it loads directly
from the CD/DVD. Insert the CD/DVD into the drive on your workstation and close the drawer. If you
have the Windows auto play feature enabled, the standalone viewer automatically launches itself and
runs from the CD/DVD. If you prevent auto play from launching the standalone viewer, it does not start
automatically, or you need to start the standalone viewer manually for any reason, go to the Start menu,
select Run..., and browse through the CD/DVD for the file hamed pbcdview.exe. Click OK to start the
eRAD PACS standalone viewer.

The standalone viewer executes until you explicitly terminate it. If a copy of the eRAD PACS active-X
viewer resides on the same workstation, the eRAD PACS standalone viewer does not affect it. In order
for the standalone viewer to execute properly, the CD/DVD must remain in the drive at all times.

Note: Removing the CD/DVD from the drive when running the eRAD PACS standalone viewer may cause the application
to lock up. While the application is loaded, the CD/DVD must remain in the drive at all times.

2.3.4 UPDATING THE VIEWER

Upgrades to eRAD PACS take place on the server. The workstation learns that an upgrade occurred the
next time a user uses it to communicate with the server. This communication takes place when you log
on to eRAD PACS, or even in the middle of an existing user session.

The first time you refresh your worklist after an eRAD PACS upgrade, a
popup notice may appear on the screen. If you do not have Windows
administrator rights, the notice informs you that a new version of the YYour eRAD PACS Viewer Diagnastic Viewer
viewer is available and instructs you to contact the system Fluginis not up to date.
administrator in order to download and install a copy onto the Update: to 5.2 [Build 02.B]?
workstation. If you have Windows administrator rights, the notice asks

if you want to download and install the latest viewer. The option to skip L

an upgrade is available so you can download and install it when

convenient. You should always perform the upgrade as soon as possible. If you clear the notice without
installing the viewer, eRAD PACS will prompt you once each day until you do upgrade.

eRAD PACS Viewer

When you consent to the upgrade, eRAD PACS downloads the viewer and invokes the installation
wizard. Depending on your version of Windows, you have the option to download and store the eRAD
PACS setup file and activate it manually, or to download and activate (Open) it when complete. Select to
Open the file when the download completes.

Page 8



eRAD eRAD PACS

Your workflow solution Viewer Manual

On occasion, an eRAD PACS viewer upgrade is mandatory in order for it to communicate with the
upgraded server. When this condition exists, the prompt to upgrade is not displayed. The download and
install process initiates immediately when you access the worklist the first time after the server has been
upgraded.
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3 Viewer Overview

All versions of the eRAD PACS viewer contain the same basic components. They consist of the main
screen workspace, which contains the area for displaying images, the menu bar, the docked toolbars, the
thumbnail panel and the status bar. Figure 3-1 illustrates the basic parts of the eRAD PACS viewer.

Main screen menus

Toolbars
Main viewing
workspace
Image
frame
Thumbnail
Panel
Status Bar / Figure 3-1 eRAD PACS Viewer Overview

The sections in this chapter provide information on the many components and constructs that make up
the eRAD PACS viewer.

3.1 Toolbars

There is an assortment of toolbars in eRAD PACS viewer. Most of the toolbars are available from the
main viewer workspace. A few are specific to one or more popup windows that you can display at various
times when using the viewer. The toolbars are defined as follows:

Standard Basic study and file control tools
Toolbox Cursor modes and general viewer control tools
Orientation Image orientation tools
Window/Level Window width and center controls
Annotation Annotation modes

Grid layouts General grid layouts

Tile layouts Tile modes for each frame in a grid
Templates Hanging protocol template controls
Report formatting Format report text

Cine controls Cine display controls

Link controls Frame linking controls

Audio controls Audio controls for dictation tools
Status bar Dynamic status information
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From the View menu, select the Toolbars item to display a list of available toolbars. If a check appears
next to the label, the toolbar is displayed in the main workspace. The toolbar is either docked to the
workspace’s border, or floating as a detached window somewhere on the monitor. Display toolbars on a
more permanent basis by selecting them in the Settings panel in the Customize Settings window. (See
section 4.2.1 for more information.) To hide a toolbar, select the item from the Toolbar item in the View
menu to remove the check mark, or uncheck the setting on the Settings panel in the Customize Settings
window.

Some toolbars are also available in different eRAD PACS viewer panels. To display a toolbar in the
respective panel, select the toolbar from the View menu item in the panel. For more information, refer to
the section in the manual that discusses the specific panel.

To relocate a toolbar in the eRAD PACS viewer's main workspace, click the surrounding gray area and
drag the toolbar to the desired location. To dock a toolbar to the workspace border, click and drag it back
to any location outside the main image area. The toolbar snaps back into place.

Instruction Summary — Show/Hide Toolbars
To show/hide a toolbar for this session only:
» From the View menu, click on Toolbars, and select the toolbar you want to display. A
checkmark appears by the name when the toolbar is displayed on your screen.

To show/hide a toolbar for this and future sessions:
» Select Customize Settings from the Settings menu.
» Click the Settings tab to view the setting panel.
» In the Toolbars section, click the checkbox to insert a check mark for the toolbar(s) you
want to display.
» To hide a toolbar, click the checkbox to clear the check mark for the toolbar(s) you want
to hide.

3.1.1 STANDARD TOOLBAR

The Standard toolbar provides tools for opening and closing studies. It contains buttons to
¥ | display a list of studies available for display, close a study, open the next and previous
studies, bookmark the current study, and restore a bookmarked study. By default, the
Eﬂ EE Standard toolbar is not displayed on the main screen. To display the Standard toolbar,
select Standard from the Toolbar item in the View menu at the top of the main screen. All
Eﬂ the functions controlled by the buttons on the Standard toolbar are also available from the
File menu, and in some cases via hot key sequences.

Function Button Menu Item Hot Key Description
Show study list View->Study Panel F2 Display the list of available studies. In the

active-X viewer, this function displays the
browser’s worklist. In the standalone viewer
and in registered active-X viewers, this
function displays the Study List panel.

Close study % File>Close study Close all the studies that are currently
loaded in the viewer.

Bookmark study EJ] File->Bookmark Ctrl-Alt-B Save the display state of the current study
or studies, and allow the user to open a new

study. Refer to section 5.1.4 for more
information. All works in progress, including
report, dictation, key images, and
annotations are preserved. Bookmarking is
recursive, using a last-in, first-out order.

Restore book- File>Restore Ctrl-Alt-R Close the current study and restore the last
marked study : bookmarked study.
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Function Button Menu ltem Hot Key Description
Open next study EE File>Open next study Ctrl-Alt-Up Open_ the next study on the user's active
worklist.
Open previous T=m| File>Open previous study Ctrl-Alt-Down Open the previous study on the user's
study Eﬁ active worklist.

3.1.2 TooLBOX TOOLBAR

The Toolbox toolbar provides tools .
for setting the eRAD PACS ||[i @/ 0|zz{~{t(s¢ PiF:el — Eﬂ o &) £|
viewer’'s cursor mode, adjusting

the image magnification ratio, resetting the display characteristics of an image frame, and displaying the
report panel. The various buttons are grouped into two main groupings, the cursor modes and the display
characteristics. To display the Toolbox toolbar, select Toolbox from the Toolbar item in the View menu at
the top of the main screen. The functions available in the Toolbox toolbar are also available from the
Settings and Tools menus, and in some cases via hot key sequences.

| &g

Function Button Menu Item Hot Key Description
Normal mode % | Settings>Cursor>Normal  Ctrl-N This is the general cursor mode, used to select an
image or object within the display. Refer to

section 4.1.1.1 for more information.

Magnify mode Q Settings—>Cursor>Magnify  Ctrl-M Magnify the image. Left-click to apply an

automatic zoom factor. Right-click to define a
zoom region. Refer to section 4.1.1.2 for more
information.

Key image Settings—>Cursor->Report Attach the selected image along with its current
mode attachment display settings and annotations to the report.
Refer to section 4.1.1.3 for more information.

Link mode Settings—>Cursor->Cine link Link one or more image frames together. Double-
click the Link mode button to automatically link all
related frames. Single-click the Link mode button,
and then click and drag the cursor between two
frames to manually link the data. Refer to section

4.1.1.4 for more information.

IE

ROI with W/L
mode

Settings—>Cursor->ROI with Define a region of interest and apply the

WI/L calculated window/level curve within it to the
image(s) in the frame. Click and drag the mouse
to define the region of interest. Drag the region
around to position it. Refer to section 4.1.1.5 for
more information.

ra

Settings—>Cursor->Cropping Remove extraneous information from the viewable
image in the frame. Click and drag the mouse to
define the area to keep. Resize the area by
dragging the region’s borders. Double-click on the
image to restore the original image. Refer to
section 4.1.1.6 for more information.

Crop mode

ISy

Settings—>Cursor->Magic X Locate a defined point in one image on all other
images that share the same frame of reference.
Refer to section 4.1.1.7 for more information.

Magic X mode

3¢/

Magic glass View->Magic Glass Alt-M Display a floating magnifying glass for zooming in
mode on the image data behind it. Refer to section
4.1.1.8 for more information.

T

Zoom gauge B Quickly zoom in and out of the selected image by
dragging the gauge. The magnification factors is
8:1, 4:1, 2:1, 1:1, 1:2, 1:4 and 1:8.

Tools>Zoom->Fit to window Ctrl-F Fit the selected image to the size of the frame.
This is also useful to reset the image size after
using magnification and cropping tools.

Fit image to
window

S
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Function Button Menu Item Hot Key Description

Actual image Elﬂ Tools>Zoom—>Actual size  Ctrl-Alt-A Display the selected image at its real-world size.

size When active, the zoom mode renders the images
in real-world size. When inactive, the zoom mode
will render the images in pixel size, matching an
image pixel to a monitor pixel. Refer to section
5.5.5.4 for more information. For actual size zoom
mode to work, both the monitor and the image
need to be calibrated. When you first enable
actual size zoom mode, you are automatically
prompted to confirm the monitor calibration. If the
selected image does not already contain pixel size
and spacing information, you are also
automatically prompted to define it.

Reset image x| Tools>Reset->Image size Display the selected image with no magnification

size O or interpolation of any kind applied. The resulting
image contains only original pixel values.

Reset image v | Tools>Reset>Image Reset the image(s) in the selected frame to the

position L position original position, which usually means centered in
the image frame.

Reset image « Tools>Reset>Image Reset the image(s) in the selected frame to the

orientation i_ orientation original orientation.

Reset image .. X[ Tools>Reset>Window/Lev Reset the image(s) in the selected frame to their

window/level e el original window and level setting.

Invert |]+I| Tools=>Invert Invert the slope of the applied window/level curve.

grayscale

Color/grayscal Tools->Grayscale Toggle the applied palette between color and

e palette grayscale.

Open report
panel

View->Report Panel F8

Display the full size report panel. Note that the
hot key displays the last report panel (full or
compact) used. Refer to section 3.6.3 for more
information.

3.1.3 ORIENTATION TOOLBAR

JJ 2| ]az| 3

The Orientation toolbar provides tools for flipping and rotating images. To
display the Toolbox toolbar, select Orientation Tools from the Toolbar item in
the View menu at the top of the main screen. The functions available in the

Orientation toolbar are also available from the Tools menus, and via hot key sequences.

Function Button Menu Item Hot Key Description
Flip horizontal ik Tools->Transform->Flip horizontally Ctrl-H Flip image(s) in selected frame horizontally.
Flip vertical aadl Tools>Transform->Flip vertically Ctrl-U Flip image(s) in selected frame vertically
-
Rotate right & Tools->Transform->Rotate right Ctrl-R Rotate image(s) in selected frame to the
..IL 5 o
right 90°.
Rotate left i Tools>Transform->Rotate left Ctrl-L Rotate image(s) in selected frame to the
[ 9
= left 90°.
Flip overlay 5F Tools>Transform->Flip image info Flip the text overlay horizontally.
text s =

3.1.4 WINDOW/LEVEL TOOLBAR

The Window/Level toolbar
provides tools for adjusting
an image’s window center

‘Windnwl 214 —J— Level [ 107 —J— I"Inilial v[ Save |

and window width. The toolbar consists of text boxes for reporting the current window/level settings and
explicitly defining them, sliders for quickly adjusting them, and a text box for creating and applying preset
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window/level settings. To display the Window/Level toolbar, select Window/Level from the Toolbar item in
the View menu at the top of the main screen. Adjusting the window and level setting is also available
through mouse controls.

The left slider bar controls the window width. The right slider bar controls the window center. The drop-
down menu allows you to select a predefined window/level settings and create a label for the current
settings. Some defaults always exist, including Initial, and Actual Range. See section 4.4.1 for
information on creating and applying preset window and level values.
3.1.5 ANNOTATION TOOLBAR
" - The Annotation toolbar provides tools for adding
& | '-”-”| é_|:£|ﬁiﬁ|33| lT:J| °\..| T |12;3| 3 | graphics and measurements to images. You can add
annotated text to a key image attached to a report,
identify a specific region of interest (ROI), and calculate the average Hounsfield unit within a region of
interest. In addition, you can draw pointers to a specific viewing area within an image, and use the
measuring tools for determining the distance and angle between two points on an image. To display the
Annotations toolbar, select Annotation Tools from the Toolbar item in the View menu at the top of the

main screen.

The functions available in the Annotation toolbar are also available from the Settings
menus, and via mouse controls.

Function Button Menu Item Description

Annotation ‘.;3 | Settings>Cursor>Annotation> General annotation mode, used for adding new

mode Select annotation, and for selecting existing ones for editing and
deleting. When in this cursor mode, spin the middle
mouse button to flip through the individual annotation
tools. Refer to section 6.1.5 for more information.

Distance .al  Settings>Cursor>Annotation> Perform linear measurements. The image must be

measurement Measure distance calibrated in order for the results to appear in units of
distance.

Angle e Settings—>Cursor->Annotation> Perform angular measurements.

measurement ; Measure angle

Cobb angle :I Settings>Cursor>Annotation> Calculate and display a Cobb angle.

measurement = Measure Cobb angle

Hounsfield & Settings—>Cursor>Annotation-> Calculates and displays the average pixel value within the

value Hounsfield value defined area.

Region of o Settings—>Cursor->Annotation> Calculates the area within the defined region of interest.

interest area Region of interest The image must be calibrated in order for the results to
appear in units of area.

Free form CC] Settings>Cursor>Annotation> Calculates the area within the defined region of interest.

region of Freehand region The image must be calibrated in order for the results to

interest area appear in units of area.

Add pointer n\- Settings—>Cursor>Annotation> Add a point graphic and an optional text string to the

Pointer image.
Add text T Settings>Cursor>Annotation> Define a text string and place it on the image.
Text

Key image 1% Settings—>Cursor->Annotation-> Display a sequential number on the key image. This

index number Report figure number annotation tool is available only when applied to a key
image in the report panel.

Spine labeling l Settings—>Cursor>Annotation> Display labels identifying vertebral disks and interspaces.

tool g Spine labeling tool

3.1.6 GRID LAYOUT TOOLBAR

The Grid Layout toolbar provides preset matrices for
displaying series in the main viewing workspace.
This toolbar is available by default in the layout
manager, and can be displayed in the main viewing area as well. The majority of the preset matrix

][ owl =] ol ffcial]
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options split the screen into symmetrical groups of image frames. The custom grid button, Q pops up a
window so you can define a custom grid by specifying the number of rows and columns you want to

appear in the workspace area. The button is used to apply a single grid layout across multiple
monitors. For example, if you use a 1-up grid layout with a 12-up tile layout, you get 12 images displayed
on the current screen, similar to a sheet of film displaying CT images. If you want the 12-up to continue
onto a second monitor, select the span multiple monitor button, and the second monitor displays the
second set of 12 images.

To display the Grid Layout toolbar, select Grid layouts from the Toolbar item in the View menu at the top
of the main screen. In the layout manager, select Grid layouts from the View menu.

3.1.7 TILE LAYOUT TOOLBAR

The Tile Layout toolbar applies a tile pattern to a selected frame, controlling the number of
B Il| images displayed in the frame. This toolbar is available by default in the layout manager, and
m=(um| can be displayed in the main viewing area as well. With a 1-up tile mode, the image frame
displays the images in stack mode, facilitating cine operations. For any other tile mode, the
| BEE| specified number of images appears in the frame. When you scroll through the images, one
image is removed from the displayed set, the remaining images shift up or down, and one
image is added. The custom tile button, B, allows you to define a custom tile setting by
specifying the number of rows and columns you want to appear in the workspace.

To display the Tile Layout toolbar, select Tile layouts from the Toolbar item in the View menu at the top of
the main screen. In the layout manager, select Tile layouts from the View menu.

3.1.8 TEMPLATE TOOLBAR

The Template toolbar contains a list of available hanging

|MH Lumbar Spine | Hl %l protocol templates and template sets. This toolbar is available

by default in the layout manager, and can be displayed in the

main viewing area as well. To display the Template toolbar, select on Templates from the Toolbar item in

the View menu at the top of the main screen. In the layout manager, select Templates from the View
menu.

To apply a template to the loaded study, click on the toolbar to display a list of templates. Select the
template. To save the current layout as a template, click in the text box, enter the label, and click to save.
To create a hanging protocol set, click the create HP set button, select the templates to add to the set,
enter a label, and save. To advance to the next template in an applied set, click the next HP set button.

Function Button Description
Save u Save the current layout as a hanging protocol template.

Create HP set % Create a hanging protocol set from existing hanging protocol templates.

Modify HP set % Edit an existing hanging protocol set.

Next HP set % Go to the next template in this applied hanging protocol set.

3.1.9 REPORT FORMATTING TOOLBAR

The Report Formatting toolbar exists in the report panel, and
T Al ~| 110 ~| contains text format controls. The available controls are the
text font type and size, bold, italic, underline, color, alignment,
and bullets. The spell checker is also available from the
formatting toolbar. To display the formatting toolbar, open the
full report panel, click on the View menu and select formatting tools. To apply one of the format settings,
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select the setting and type into the respective text field. Change the current text format by highlighting an
existing word or section of existing text and then clicking on the format button. You can apply the
formatting controls using keyboard shortcuts as well.

Function Button Hot Key Description

Font Select the font type from the pull-down list.

Font size Select the font size from the pull-down list.

Bold ‘ Ctrl-B  Set the text to bold.

Italic Ctrl-1 Set the text to italics.

Underline Ctrl-U Underline the text.

Text color o Change the text color. From the popup window, select a predefined color, of

customize one yourself.

O 2 1SN

Align left Align the text along the left margin.

Align center Center the text equidistant between the left and right margin.

Align right Align the text along the right margin.

Bullet — Insert a bullet in front of the text. The indentation is handled automatically.
Spell check '\/ Open the spell checker.

3.1.10 CINE CONTROL TOOLBAR

The Cine toolbar provides controls for automatic playback of a cine il
loop. This toolbar consists of a Play/Stop button, speed controls Flay -
and a loop direction control. To display the Cine toolbar, select

Cine control from the Toolbar item in the View menu at the top of the main screen. The Cine toolbar is
also available from the Cine menu, along with menu items for the functions found on the toolbar.

Speed ————

3.1.11 LINK CONTROL TOOLBAR

The Link toolbar provides controls for linking one or more _ _

image frames together. eRAD PACS will automatically JI Lik 1 =] T~ Minor I Magic glass [~ Unhaok
link series in frames that are marked by the modality as

sharing the same frame of reference. If this information is not encoded in the image object, you can
manually link one or more frames together. Section 5.4 contains information on creating and using links.

eRAD PACS supports up to 7 individual link groups. The Link toolbar displays the link group assigned to
the selected frame, and fields for enabling/disabling link controls. The link controls manage the mirror
state, whether multiple magic glass windows exist and to temporarily suspend link functions. To display
the Link toolbar, select Link controls from the Toolbar item in the View menu at the top of the main
screen. Link controls are also available from the mouse.

3.1.12 Aubpio CONTROL TOOLBAR

The Audio toolbar on the full s
report panel provides controls for ‘ »|o|x| ——F [ N 1.00
recording and playing back :
dictation. It contains a record button, a play/stop button, and a delete button for removing portions of a
recording. The first gauge displays and adjusts the current location of the recording. The text field
displays the position in the recording in seconds. The second gauge controls the playback speed. A
value of 1.00 replays at the acquired rate. Slow down/speed up the playback by shifting the gauge to the
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left/right, respectively. To display the Audio Control toolbar, open the report panel, and select Audio

Controls from the View menu.

3.1.13 PRESENTATION TOOLBAR

The presentation toolbar provides access
to a number of image presentation tools.
To display the presentation toolbar, select

FEEEE EE

o &)k @B 5

Presentation tools from the Toolbar item in the View menu at the top of the main screen.

Function

Button

Menu Item

Hot Key

Description

Show all localizer lines

#|

Settings—>Localizers=> Show
localizer lines on all images

F12

Display the localizer line(s) of selected
images on orthogonal images

Hide all localizer lines |3§;§| Settings—>Localizers>Hide F12 Hide localizer lines
localizer lines on all images
Show all hash marks |% Settings—>Localizers=> Show Alt + Display the localizer lines for all images in
hash marks on all images F12 the selected series on orthogonal images
Hide all hash marks J% Settings—> Localizers->Hide Alt + Hide all localizer lines
hash marks on all images F12
Show image info View-> Show image info F10  Show/hide the demographic overlay data
Show scout overlays |@ View->Show scout overlays Ctrl + Show/hide scout images a overlays on
F11  selectimages in an image frame
Show orientation |L_"n| View->Show orientation F11 Show/hide the orientation markers on
images in an image frame
Show orientation cube I@ Alt + Show/hide the orientation cube on images
F11 inanimage frame
Show annotations ‘ﬂ View->Show annotations F9 Show/hide annotations
Show mammography |i| Show/hide mammography CAD markers
CAD
Show overlays | View->Show overlays Ctrl + Show/hide image overlays defined for
o F9 images displayed in an image frame
Show presentation | & Show/hide presentation state details
state overlays (overlays, annotations, etc.) for images
displayed in an image frame
Step scale rulers fsc View->Show scale Ctrl + Show/hide the scale rulers in image frames
F10

3.1.14 STATUS BAR

The Status Bar displays status messages as eRAD PACS performs some action. The status bar location
is fixed, at the bottom of the screen. It displays the current working state, the loading progress, and the
coordinates of the cursor in an image. Section 3.5 explains the information available on the Status Bar.

3.2 Menus

The eRAD PACS viewer menus at the top of the application window organize all of the functions and
configuration tools. The list includes the File menu, View menu, Settings menu, Tools menu, Cine menu,
Collaboration menu, and the Help menu. Additional menus may exist depending on the plug-in modules
eRAD PACS loads when it initializes. These include the Post-processing menu and the Templating
menu. Information on these conditional menus is available in Chapter 7. Other menus exist in the
different eRAD PACS panels, although many of them are repeated or subsets from the main application
window, included on the panel for convenience. Using the mouse, left-click on the menu label at the top
of the screen to reveal the available options and submenus.
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The eRAD PACS viewer menus are available as a popup menu, accessible from anywhere in the main
viewer workspace. To display a popup menu, position the cursor over the main workspace and click the
right mouse button. The popup menu disappears when you click any mouse button. If you are using a
single-button mouse, hold down the Shift key and click the mouse button to display a popup menu.

3.2.1 FILE MENU

Exit

Section 5.5.12.7

3.2.2 VIEW MENU

eRAD PACS's File menu provides access to functions to sign on | Gpenprevious study Cirl-+Alt+Up
and off, open and close study files, bookmarking and restoring  ©Opennextstudy Col+Alt+Doun
bookmarked sessions, saving images to files, printing images to = Clase study
Microsoft Windows and DICOM-compatible printers, clearing the _ Sesevers
eRAD PACS viewer cache, connect to collaboration session, and = Bookmark Ctrl+Alt+8
terminate the viewer session. Restor Gl
Update plugins
Menu ltem For details, see ... Send image to server
Open previous/next study Section 5.1.3 EZTE‘ET;::? server
Close study Section 5.5.12.7 Delete series
Close views Section 5.5.12.7 e Ctrl4Shift4T
Bookmark/Restore Section 5.1.4 Save series ... Ctrl+shift+5
Update plug-ins Section 7 Copy image to dipboard Ctrl4+Shift+C
Send image/series Section 5.5.12.1 At cak
Delete image/series Section 5.5.12.1 ;geﬂjg-‘;c[?ﬁzbsl . -
Save images/series Section 10.1 3gé&smms v TEmplposCS.p
Copy image to clipboard Section 10.1 4 getpbs[3].phs
Print Section 11 Empty cache
Empty cache Section 4.2.6 Signon ...
Signon ... Section 2.2.3 Sign Off
Slgn off Section 2.2.3 Connect to collaboration ... Cirl+Alt+C
Connect to collaboration ... Section 9 Quit cirl+q

eRAD PACS'’s View menu provides access to the toolbars, individual panels, the panning magnifying

glass, and controls for displaying and hiding different image overlays.

Toolbars > » v Templates
i v Window/Level
ViRl =2 FEST) v Presentation kools
v Thumbnail panel Ale+T v Annotation tools
Layout manager Fa v Cff Grid |ayouks
Info panel F7 Full Link, conkral
Repart panel Fa P —>  Compact Zine contral
v Showe overlays Chrl+F3 v Off v Tile layouts
v Show annotations Fo Left v T':'.C'":'C'x.
v Show image info Fio Left + top COrientation tools
Show scale Ctri+F10 » — Top v Standard toolbar
v Show orientation F11 ) v Status bar
v Show scout overlays Chrl4+FLL Tr?:|:| *right
Right
Show annotation indices Right + bottom
Shaw kick marks Bottom
Bottom + left
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Menu Item For details, see ...
Toolbars Section 3.1
Magic glass Section 5.5.5.3
Thumbnail panel Section 3.4
Layout manager Section 3.6.1
Information panel Section 3.6.2
Report panel Section 3.6.3
Show/Hide overlays Section 6.1.5
Show/Hide annotations Section 6.1.6
Show/Hide image info Section 6.1.1
Show/Hide scale rulers Section 6.1.3
Show/Hide orientation Section 6.1.2
Show/Hide scout overlays Section 6.1.6
Show/Hide annotation indices Section 6.2.1
Show/Hide tick marks Section 6.2.1

3.2.3 SETTINGS MENU

eRAD PACS’s Settings menu provides access to the customized settings window where you can
customize the viewer characteristics, select a cursor mode, calibrate the image and monitor, change the
grid and tile layouts, modify the localizer lines settings, and set series-specific settings.

Customize setkings ...

Cursar

Mulkiple monitar
Calibration

Grid lavouts
Tile

Link. property
Localizers
Series

Setup Key Bindings ...

Auko splic series
At sort series

Mirrar
Magic glass

eRAD PACS
Viewer Manual

Select

v Mormal el
Maanifier Chrl+1a
Report attachment
Cine link
ROT with WL
Cropping
» »  Magic &
Monitar Annokations p —>
> Image:
3 »  Tile across monitors
: v Mo tile 1lup
N 2 tiles harizontally 2 up horizontally
. Z tiles vertically 2up VEr.ﬁG"y
4 tles 3 up horizontally
& les landscape S
6 tiles portrait 4up
I tes Sup
Sup
12 tiles landscape 12up
< 12 tiles portrait Custom ...
— Split selected cell p —>
v Join selected cell y >

v Auko find localizers

Show localizer lines on selected image
Show hash marks on selected image

Shaw localizer lines on all images
Hide localizer lines on all images
Shaw hash marks on all images
Hide hash marks on all images

F1z
Fiz
Alt+F12
alk+F12
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Menu Item For details, see ...
Customize Settings Section 4.2
Cursor Section 5.4, 0, 6.1.5, and 8.3
Multiple monitor Section 4.2.3
Calibration Section 4.7.1
Grid layouts Section 5.3.1
Tile layouts Section 5.3.2
Link properties Section 5.4.3
Localizers Section 6.1
Series Section 5.4.1.1
Setup key bindings Section 4.5

3.2.4 TooLs MENU

eRAD PACS’s Tools menu provides access to various tools that control the screen layout and the manner
in which it renders the images. This includes the ability to reset the image characteristics, apply a zoom
factor and an interpolation algorithm, invert the grayscale slope, apply color to the LUT, reorient the
image, and customize the set of images in a series.

v Image size Flip harizontally Ctrl+H Actual size ChrH-Al+A
Irmage position Flip wertically — Cerl4+U . P
Image arientation Rotate right Ckrl+R 41 Chrled
— » ‘WindowfLevel Rotate left Chrl+L 21 Ctrl+z
Reset » . ; 1:1 Ctrl+1
Transfarm r »  Flip image infa L1z Al
Zoom infout  k » .4 alb+4
Interpolation » — Nearest pixel criantation 1:8 Alb+5
Inwert v Bilnear interpolation oo Factor v Fit bo window  Ctrl+F
Greyscale
I window | Level Full screen FS
Apply r »  Inverk
- | Greyscale
Series * >  Find all localizers
Find series localizer
Split all series
Split series
Sort all series
Sart series
Inverk series
Uk series
Join series Forwards
Joim series backwards
Menu ltem For details, see ...
Reset Section 5.5
Transform Section 5.5
Zoom Section 5.5
Interpolation Section 4.2.4 and 5.5
Invert Section 5.5
Greyscale Section 5.5
Apply Section 5.5
Series Section 4.2.3, 5.4.1 and 5.4.2
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3.2.5 CINE MENU

The eRAD PACS Cine menu provides controls for displaying stack views. The
menu includes controls for cycling through the images in the stack view, which
simulates playing a cine loop, controlling the looping mode, altering the playback
speed, and displaying the cine controls as a floating or docked toolbar. Mezt Frame On

Preceding frame Lp

Play cine
Stop cime

Menu ltem For details, see ... i
Play/Stop cine Section 5.5.1 / Cyelic muds
Next/Preceding frame Section 5.5.1 bzl moe
Cycle/Reverse mode Section 5.5.1 Faster speed
Faster/Slower speed Section 5.5.1 Slower speed
Link Section 3.9.1and 5.4.3 ]
Toolbar Section 3.1.9 Lis

Toolbar

3.2.6 COLLABORATION MENU

The eRAD PACS collaboration menu enables a user to create a collaborations
session, connect to an established collaboration session, and disconnect from a
collaboration session. Refer to section 9 for complete details on collaboration
sessions.

Connect ... ChrlHalk+C
Disconmect  Chrl+alk+D

3.2.7 HELP MENU

eRAD PACS’s Help menu provides access to information about the eRAD Contents
PACS viewer. It contains detailed information on the available features, a Mews
summary of the newest features added in the last upgrade installed on your
server, plus details about its version, which is helpful in the event you need to About eRAD PACS Viewer
contact customer support. For complete details on eRAD PACS Help, refer to section 12.

3.2.8 POST-PROCESSING MENU
The Post-processing menu is a conditional menu that exists if you have certain Mask Subtraction ¥

licensed plug-in modules installed on your workstation. Examples of post- VT Player »
processing plug-in modules include multiplanar reconstruction, basic 3D and image Stitching b
stitching. After the plug-in module downloads onto your workstation, the respective I ,
sub-menu is added to the Post-processing menu. If no post-processing plug-in Reconstruction »

module exists, then the Post-processing menu does not appear on your viewer's
title bar. For details on each of the sub-menus listed in the Post-processing menu, refer to the respective
section in chapter 5 or chapter 7.

3.2.9 TEMPLATING MENU

The Templating menu is a conditional menu that exists if you have the orthopedic templating plug-in
module installed on your workstation. For details on the Templating menu, refer to Section 7.3.

3.2.10 SPEECH RECOGNITION MENU

The Speech Recognition menu is a conditional menu that exists if you have the embedded speech
recognition plug-in module installed on your workstation. For details on this menu, refer to Section
8.2.4.1.

3.3 Image Viewing Area

The eRAD PACS image viewing workspace makes up the majority of the user interface, as shown in
Figure 3-1. This is the area that renders the full fidelity image data, along with applied annotations,
overlays, and other enhancements to the image data set. The main viewing area is the one area of the
eRAD PACS viewer that you cannot hide or close.
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The user can customize the image viewing workspace. The area can be subdivided into multiple areas
called image frames. On multiple-monitor workstations, it is possible to define one image frame that
spans across all the monitors. Each image frame can display the images in a number of tile modes. The
default tile mode is 1-up, also called stack mode, meaning only one image appears in the frame. A 4-up
tile mode displays two rows and two columns of images, displaying four successive images loaded into
the frame. By scrolling through the image frame, the user can display all the full-fidelity images loaded
into the image frame. Section 5.3 contains information on modifying the grid and tile modes.

To load an image into the main viewing workspace, you need to drop a thumbnail image into it. See
section 5.2.1 for details on loading images from the thumbnail panel and the layout manager.

3.4 Thumbnail Panel

The eRAD PACS viewer includes a panel in the main viewing workspace for displaying the thumbnail
images of each series. When displayed, the thumbnail panel is located on the left border of the main
viewing workspace, as shown in Figure 3-1.

A thumbnail image is a highly sub-sampled rendering of an image in the study, and can be used for quick
identification of the full-resolution image. The thumbnail panel consists of one or more columns of
thumbnail images, scrolling off the bottom of the panel if too many rows exist. Each image in the
thumbnail panel corresponds to a single series in the study. If multiple studies are loaded, a study
identification header, listing the patient name and study date, separates each study.

To display the thumbnail panel, place the cursor over the leftmost border of the main viewing workspace.
When positioned correctly, the cursor changes to a bi-directional arrow. Click the left mouse button and
drag the border to the right, revealing the thumbnail panel. Size it to your preference and release the
mouse button. You can also show and hide the thumbnail panel by clicking on View menu and selecting
Thumbnail Panel, or by entering Alt-T on the keyboard. Change the thumbnail image size with the
magnification tool, &, by applying it directly to the thumbnail image, or by setting the default thumbnail
size on the Customize Settings’ Layout page.

Each image in the thumbnail panel displays a blue progress bar along its bottom edge, showing the
status of the image as it downloads from the eRAD PACS server. If the image already resides on the
local workstation, the progress bar appears briefly as eRAD PACS reads the data from the hard disk.
When the progress bar disappears, the full image is available for displaying in the viewer. You can load a
thumbnail into the main viewing workspace before or after the progress bar completes. eRAD PACS
displays all the data that has downloaded from

Key image _ the server, and automatically updates the image
indicator _'”é"’_‘get viewed when the rest of it data arrives. Note that the
o ndicator download completion percentage appears in the
Series indicator .
Progress bar lower left corner of the image frame as part of the
/ default overlay.

On the upper left edge of the thumbnail image is a multiple-image series indicator. If three small lines
intersect the left edge of the thumbnail image, the series consists of multiple images. If no such indicator
exists, the image is a single image. You can scroll through multiple-image thumbnails the same way you
scroll through images in the main viewing workspace. Each of the individual thumbnail images in the
series has its own progress bar. As you scroll through the series, eRAD PACS displays the
corresponding progress bar automatically.

If the image represented by the thumbnail image is stored as a key image, the top left corner contains a
key image indicator. If no circle exists, there are no key images based on the image represented by the
thumbnail image. To display the key image, open the report panel.

The red dot in the top right corner indicates the image has not been displayed at full resolution in the main
viewing area. Once the image is rendered in the main area, the red dot disappears or becomes a red
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circle. A red circle applies only to a series of images, and means at least on image in the series remains
unviewed in the main viewing area. Once all images have been fully rendered, the red circle disappears.

The color of the frame surrounding each of the thumbnail images denotes some status. For example, all
the thumbnail images that are loaded into the selected image frame can be highlighted one color, while all
the thumbnail images that are not in the selected image frame could be another. You can also select a
color to indicate that the thumbnail images are not in any image frame, which can be used to point identify
which series you have not viewed. Section 4.2.9 contains additional information on thumbnail frame
colors.

For information on loading images from the thumbnail panel into the main viewing workspace, refer to
section 5.2.1.

The thumbnail panel enables users to identify and access available series without having to open the
layout manager. The images in the thumbnail panel have the same characteristics and functions as
those contained in the layout manager.

3.5 Status Bar

The status bar, located at the bottom of the eRAD PACS viewer, displays the current status of an action.
When the viewer is idle, the status bar displays Ready. When the viewer is downloading images from the
eRAD PACS server, the status bar displays a blue progress bar. The progress bar moves across the
status bar, indicating the percentage of the study information transmitted. When the progress bar
completes, the thumbnail images are available for viewing. Note that when using image compression, the
images may arrive at your station in waves of increasing fidelity. The individual progress bars in the
thumbnail images indicate the progress of the individual image decompression.

On the far right side of the status bar is a quantitative indication of the download completion. When this
value reports 0%, the transmission has not begun. In some cases, the eRAD PACS server may take
some time to collect the selected study from its storage location. Once the data is ready for download,
this field shows the progress.

3.6 Independent Popup Panels

A number of control panels exist in the eRAD PACS viewer. These include the layout manager, the
report panel, the object information panel, and the print control panel.

Each of the control panels appears as an independent popup window. You can display or hide them as
needed. Most of them contain a setting to keep the window on top of the other eRAD PACS windows,
including the main viewing workspace. If you want to keep the window displayed while you click on
buttons and menus outside the window, pull down the first menu in the popup window and select Keep on
Top. If a checkmark appears next to this item, the window will remain in the foreground. Clear the
checkmark to allow the window to move to the background when you select another window on your
workstation.

3.6.1 LAYOUT MANAGER

The eRAD PACS layout manager is a popup panel for previewing images loaded into the viewer, and
organizing them in the main viewing workspace. The layout manager provides controls to select the
monitors to use, the grid to apply to each monitor, the tile mode of each image frame, and the images to
load into each image frame. After defining a layout, the layout manager can store the configuration as a
hanging protocol template, which you can apply when loading a subsequent study, making it unnecessary
to define the configuration again.
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Layout Manager - WINIFRED, OPERAH 8/11 (WaveletR = 1.5 |

Layout Manager View Settings Tools
8] == R = e e e e e IDMEEEEIE
r————

The layout manager window has three sections. The top part
of the window contains the menus and toolbars. These are
the same toolbars available in the main viewer, as described
in section 3.1. The menus are similar to those in the main
viewer as described in section 3.2, although some
reorganization has been applied.

The center section of the layout manager contains an
emulated display. These emulated monitors look and behave
like the main viewer screens, but appear in the layout
manager for simplicity. There is one emulated monitor for
each real monitor. You have almost all the functionality
present in the main viewer as you do in each of the emulated
monitors, including window and level, scrolling and resizing.

WINIFRED, OPERAH
Jan 08, 2001 - MR

The bottom section of the Layout Manager contains all the images as stacked thumbnails. This section
has the same functionality as the thumbnail panel, as described in section 3.4.

When you load a study into the eRAD PACS viewer, the layout manager automatically appears unless
you explicitly instructed the viewer not to do so, or eRAD PACS automatically applied a hanging protocol.
To manually display the layout manager, select Layout Manager from the View menu, or press the F6
function key. You can close the layout manager by clicking the Close button in the top right corner of the
window, pressing the F6 function key, or, if the Keep on Top setting in the Layout Manager menu is
unchecked, clicking outside the layout manager window.

For information on loading the images from the layout manager, see section 5.2.2.

3.6.2 INFORMATION PANEL

The eRAD PACS information panel contains a dump of all the attributes in each of the images loaded in
the viewer. The information panel is primarily used for support and debug purposes, although the
information is available to users as well. There may be times when you need to investigate the image
object’s technical data. Perhaps you need to find the field used to store a particular data value you want
to display in the overlay information. You can also use the information panel to see how some numeric

data changes from one image to the next, without

g “ having to make changes to the overlay configuration.

Info Panel

AccessionNumber: Empty Value
AcquisitionDate: Jan 08, 2001
AcquisitionMatrix: Dy256116240
AcquisitionNumber: 1
AcquisitionTime: 17:41:53
ActualBitsUsed: 15

AngioFlag: N

To display the information panel, select an image
currently loaded into the main viewing workspace, and

BeatRejectionFlag: Empty Value

BestLevel: 1015/55611428614346141 76440581391 013756131 2442767
BestWindow: 203091111621857 \607 9177187 44817188168861624915534
BitsAllocated: 16

BitsStored: 16

BodyPartExamined: BRAIN

Columns: 256

ContentDate: Jan 08, 2001

ContentTime: 17:44:45

ContrastBolusAgent: Gd-DTPA

ContrastBolusStartTime: Empty Value

ContrastBolusYolume: 0

dBdt: 13.6

DeviceSerialNumber: 12054

EchoNumbers: 1

EchoTime: 18.0

EchoTrainLength: 0

FileMetalnformationVersion: DcmOtherByte OtherWord

FlipAngle: 90

FrameOfReferenceUID: 1.2.392.200036.9123.100.12.11.4.12054.2001010811.1324
HeartRate: 0

HighBit: 15

HighRRYalue: 0

ImageComments: Empty Yalue

ImagedNucleus: H1

ImaceOrientationPatient: 1104-3.2517813e-174-2.381546e-1810.99731448\-0.073238197 =l

press the F7 function key, or select Info Panel from the
View menu. The information panel is a text dump of
the object’s attribute list, sorted alphabetically. Private
attributes inserted by the device that created the object
that eRAD PACS does not interpret appear with a
DICOM tag rather than an attribute label. To locate a
particular field in the information panel, use the scroll
bar on the right to move through the data. To hide the
information panel, press the F7 function key again, or,
if the Keep on Top setting in the Info Panel menu is
unchecked, clicking outside the layout manager
window.
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3.6.3 REPORT PANEL

The eRAD PACS report panel displays reports associated with prior studies opened in the viewer, as well
as records reports for the new studies. The report panel includes the text of the main report, the text of
the addendums to the report, the original dictations, if available, and the key images.

To open the report panel, click the report button, d in the toolbox toolbar, press the F8 function key, or
select Report Panel from the View menu. By default, the report panel appears in the Full view mode.
You can display the smaller version by selecting to display the report panel in Compact mode.

S a— | [ T O The full view report panel contains the most complete report
] T information and access to the complete set of reporting
oo - B e w  .wmsll functions. In the full view report panel, the user can record

Désbaige:
Pieterved iry: Welley. Marcus & Dy
Pesson: Pudslogy Sides

and edit a voice dictation, type and edit report and addenda
text, review the patient demographic information, obtain
3 wscectl  information on who created the original reports and addenda,

[ ; ———8 update the study state, and perform some simple
* Unteet management functions such as submitting the report manually
s to the server, clearing all the changes and starting over. The
nnnnn full view report panel also provides access to the study’s key
images.

[FESPE——— L Flepert Dote:

The compact view report panel is a smaller version of the
report panel, consisting primarily of the most common tools
needed to dictate and submit a report. If using embedded speech recognition, the compact report panel
includes a text box showing a sampling of the recorded text. Reduce the full view report panel by clicking
on the Compact button on the full view report panel. By compacting the F
report panel, you can view and manipulate images while dictating the - -
report. For less obstruction, dock the compact view report panel as an >lof] ) =
eRAD PACS viewer toolbar. To dock the compact view report panel, drag ~ [vmesed =I' codcm | el |
it to the outside of the main viewing workspace and release it.

-] - — 2| =<lteloial) w1

3.6.4 PRINT PANEL

The eRAD PACS print panel is a staging area used to collect images and format sheets of film for
printing. The print panel provides tools for selecting and organizing the images, specifying the film sheet
layout, and selecting a Windows-based or DICOM compatible printer along with its respective print
parameters. The images in the print panel have most of the functional characteristics of images in the
thumbnail panel and main viewing workspace, allowing you to enhance the display characteristics, such
as change the window or level and adjust an annotation, prior to submitting the print job to the printer.

To Open the prmt panel' Se|ECt Print... from the Flle menu.  Windows " Dicom Diopimage:  Single & Series ¢ Study " Prompt

By default, no images are loaded, unless you have already ... [oneorre = S| o [P 1)

selected one of the series in the main viewing workspace. S R = e
The process is to load the selected images into the print : =

panel from either the thumbnail panel or the main viewing
workspace, adjust them as necessary, select the print
parameters, which differ depending on whether you are
printing to a DICOM or Window printer, and then submitting
the print job. The print panel remains displayed until you
submit the print job. Close the print panel without
submitting the print job by clicking on Cancel or the close
button on the top right corner of the window.

Refer to section 11 for detailed instructions on how to build
a film sheet and submit a print job.
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3.7 Plug-in Modules

eRAD PACS supports independently
|icensed plug-in mOdUIeS that Offer a Suite Of [~ Reload Multi Planar Reconstruction by eRAD{Imagemedical version 1.0.0.11
fUnCtionS not aVaiIable in the baseline VieWer. [” Reload Basic 3D Plugin by eRAD{imagemedical version 1.1.0.7

An example of a plug-in module is I Reload Ortho¥iew Stub Plugin by eRad/imageMedical version 1.0.2.1
multiplanar reconstruction. When you install
an eRAD PACS viewer on your workstation,
it queries the server for a list of licensed plug-
ins. If the viewer determines you are
licensed to use a plug-in, or if a newer
version of the plug-in exists on the server, the
eRAD PACS viewer prompts you to
download and install it. The prompt window Cancel

is shown to the left. The window displays the

available plug-ins, along with their respective version numbers. To install or update a plug-in, check the
box to the left of the plug-in module and click OK. Note that some plug-in modules consist of an extra
install process. If this is necessary, another prompt may appear asking if you want to install the additional
component. Click on OK to install the application.

[ Reload Stitch Image stitching tool by eRADAImageMedical version 1.0.0.20

[~ Reload Spellex Spelichecker Module by eRAD/ImageMedical - Spellex version 1.0.0.2

To see a list of available plug-ins, select Update plug-ins from the File menu. Once installed, the plug-in
automatically initializes and makes its functions available.

You can find a complete list of eRAD PACS viewer plug-ins in section 7. Refer to the relevant subsection
for specific details on how to use the features in the plug-in.

3.8 Display Modes

Normally, the eRAD PACS viewer shows the default display mode, consisting primarily of the main
viewing workspace. Additional display modes exist. These display modes offer an alternative view of the
data, usually for a specific, short-term purpose.

3.8.1 FULL SCREEN MODE

eRAD PACS offers a full screen display mode that eliminates all extraneous information from the monitor
and uses all the space for displaying the image. When active, the menus and toolbars disappear from the
screen, but all mouse controls remain available and you can apply them to the image.

Full screen display mode applies to an image frame. First load the image or series into an image frame,
and apply a tile mode if necessary. To active full screen mode, select the image frame and press F5. To
return to the normal display mode, press F5 again, or hit the Esc button.

3.8.2 CALIBRATION MODE

One of eRAD PACS viewer's zoom modes supports rendering the image using a real-world scale. To
support this zoom mode, both the image and the monitor must contain calibration information. If either is
not calibrated, the eRAD PACS viewer notifies you and invokes a wizard to collect the requisite
information. You can also run this wizard manually. The calibration wizard uses two display modes, each
different from the default display mode. The monitor calibration display mode consists of a set of rulers
you adjust to indicate the actual size of an object on the monitor. The image calibration display mode
displays the image in need of spacing information, and a tool for defining measured objects on the image,
which eRAD PACS uses to define the physical size of the pixels.

Section 4.7.1 contains detailed information on the monitor calibration and instructions for calibrating one

or more monitors. Section 5.5.9 contains additional information on image calibration and the image
calibration display mode.
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3.9 Mouse Operations

The mouse is a powerful tool in the eRAD PACS viewer. A large number of the most common functions
available from menus, toolbars and function keys are also available from the mouse. With a little practice
and some dexterity, you should be able to accomplish the majority of your task simply through the use of
a three-button mouse with a wheel.

eRAD PACS is able to support a large number of functions on the mouse because it supports multiple
cursor modes. Each cursor mode assigns specific functions to each of the mouse buttons. By changing
the cursor mode, the different eRAD PACS functions become active. The following section outlines each
of eRAD PACS'’s cursor modes.

3.9.1 CURSOR MODES

eRAD PACS viewer has a number of cursor modes available to control which functions get applied when
clicking one of the three supported mouse buttons. The cursor icon identifies the active cursor mode.
There are a few ways to activate a cursor mode.

» Select the cursor mode from the Cursor submenu in the Settings menu.

» Select the cursor button in the Toolbox toolbar.

» Press the hot key combination (available for a limited number of cursor modes).
» Click the middle mouse button to toggle through the cursor modes.

Some users select a cursor mode and want to use it until they explicitly select another cursor mode.
Others prefer the cursor mode automatically reset to the default mode after applying an action. eRAD
PACS lets the user specify whether the mode resets to the default or persists in the selected mode.
When clicking the mouse button, the cursor mode automatically resets to the default when you release
the button. If you hold down the ALT key while pressing the mouse button, the cursor mode remains
active after performing the action. This is useful when adding annotations or attaching multiple key
images to a report.

Hold down the Alt key to remain in the cursor mode for magnify, key image, link, ROl with WI/L, crop,
magic X. The annotation cursor mode persists automatically, although it retains the specific annotation
tool if you hold down the Alt key.

4.1.1.1 Normal Cursor
Use the Normal (arrow) Cursor to click and select menus, menu items, buttons, slider bars, images,
L}x| and to click and drag to relocate toolbars and resize the Image and Thumbnail Windows. This is
the default cursor mode.

4.1.1.2 Magnification Cursor
The magnification cursor mode is for zooming in and out on images. The magnification is based
on the position of the cursor, so position the cursor over the point of interest before clicking the
~—— mouse.

When magnifying an image, a small plus sign (+) is attached to the cursor and a dotted white line appears
in the image in the thumbnail panel, indicating the viewable magnified image in relation to the original
image. Click the left mouse button to apply a 2x magnification to the displayed image, centered on the
cursor location. Hold the Shift key down when clicking to double the magnification to 4x. The cursor
displays two plus signs to indicate the 4x zoom factor.

To decrease the image size incrementally, hold down the Ctrl key when clicking the mouse. The icon
includes a small minus sign (-) next to the cursor. Hold the Shift key with the Ctrl key to zoom out by a
factor of 4x.

Clicking the right mouse button draws a zoom region. When you release the mouse, an image in the
defined region is magnified to fit into the image frame.
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Reset the image size by reloading the image into the frame from the thumbnail panel, clicking on the
Reset Image Size button or menu item, or use the magnification mode to apply a reverse zoom.

4.1.1.3 Key Image Selection Cursor
The key image selection cursor lets you attach an image to a report. When activated, the cursor
J looks like a paper clip. To attach an image to a report, click on the image. When attached to the
report, a key image icon is displayed in the top left corner of the image to denote the image is
attached to the report exactly as rendered in the image frame. A paperclip icon appears in the top left
corner of the image to denote the image is attached to the report, but not as it appears in the image
frame. Click the key or paper clip icon on the image to remove it from the report.

4.1.1.4 Link Cursor

The link cursor is for linking one or more studies together so a single scroll command applies to all
I linked image frames. Double-click the link cursor button to automatically link together all series
—— from the same study, in the same image plane and within the same frame of reference as defined
by the imaging modality. To manually link image frames together, select the Link cursor mode, move the
cursor to the first image frame, press and hold down the left mouse button, drag the cursor to the frame
you want to link, and release the mouse button. To link a third frame to the first two, repeat by starting
with one of the two original frames, and releasing the mouse when the cursor is in the third image frame.
To remove a link, double-click on the link icon in the top-left corner of the image.

4.1.1.5 ROI With Window/Level Adjustment

A user can set the window width and center values for an entire image or study based on the
= dynamic range of a specified region of an image using the ROI with window/level adjustment

cursor mode. After selecting the ROI with W/L mode, position the cursor over the image, and click
and drag to define the region of interest. When you release the cursor, the pixels within the region are
used to define the window width and center. These values are applied to the entire image. The region
defining the area remains on the screen. Resize it and drag it around to change the window and level
settings. Click anywhere on the image outside the region of interest to remove it.

4.1.1.6 Crop Image Cursor Mode
Remove extraneous information from the viewable image in the frame with the crop image cursor
'E: mode. Click the image and drag the mouse to define the image region. When you release the
mouse, all image data outside the defined region disappears from view. Click on the region border
and drag it to resize the crop region. Select the Fit to Window mode to display the image as large as
possible in the image frame. Double-click anywhere in the image frame to remove the crop region.

4.1.1.7 Magic X Cursor Mode

— Locate a defined point in one image on all other images that share the same frame of reference
using the Magic X cursor mode. Select Magic X mode, and click on an image. All series currently
displayed in other frames scroll to the image closest to the selected point. If you click and hold the

mouse button, the Magic X marker is displayed in each image frame. If you drag the mouse while holding

down the button, the images update dynamically as the reference point moves.

4.1.1.8 Magic Glass Cursor Mode
Magic Glass cursor mode is actually a panning magnifying glass, zooming the image behind it.
After activating the magic glass window, click on the popup window and drag it to move it around.
The area under the image is magnified by a factor defined in your customize settings table. Only
image data is magnified. To clear the magnifying glass, left-click anywhere outside of the zoom area.

Resize the magic glass window positioning the mouse over the edge of the window until it changes to a
bi-directional arrow. Click the left mouse button and drag to resize the window. The window size can be
up to 20% of the size of your display resolution. Note that large Magic Glass windows may result in
ghosting as you drag it around. If you find this distracting, reduce the size of the magic glass window.
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4.1.1.9 Annotation Cursor Mode

4

general annotation mode is active.

3.9.2 MOUSE FUNCTIONS

eRAD PACS

Viewer Manual

The annotation cursor mode is the general cursor mode for all annotation tools.
annotation mode is needed to move and edit existing annotations. To apply a specific annotation,
select the desired annotation from the annotation toolbar, or spin the wheel on the mouse when

The general

The following table lists eRAD PACS viewer's mouse functions and actions based on the location of the
cursor when the action is requested.

Cursor Mouse Middle Right Left + Right
Mode Location Left Button Button Button Button
Pointer Main Viewing Click: Select image frame Click: Toggle Click: Features
Workspace cursor popup menu
Image Click: Select image/series Click: Toggle Click: Features | Drag: Dynamic
Drag: Scroll images (image fit-to- | cursor popup menu zoom
window), or Pan (resized image) Roll: Scroll Drag: W/L
Ctrl-Drag: Scroll images images image/series
Layout Click: Select image/study Click: Toggle Click: Features | Drag: Dynamic
Manager Dbl-click: load image/series cursor popup menu zoom
Drag: Load image/series Roll: Scroll Drag: W/L
images thumbnail
image(s)
Toolbars Click: Select Click: Toggle Click: Features
Dbl-click: Detach/attach toolbar cursor popup menu
Drag: drag toolbar
Elsewhere Click: Select Click: Popup
menu
Magnifying Image Click: Zoom up and center Click: Toggle Click: Features | Drag: Dynamic
Glass Shift-click: Zoom up 2x and cursor popup menu zoom
center Roll: Scroll Drag: Size
CTL-click: Zoom down images zoom area
Shift-CTL-click: Zoom down 2x
ALT-<cmd>: Stay in magnify
mode after click
Layout Click: Zoom up Click: Toggle Click: Features
Manager Shift-click: Zoom up 2x cursor popup menu
CTL-click: Zoom down Roll: Scroll
Shift-CTL-click: Zoom down 2x images
ALT-<cmd>: Stay in magnify
mode after click
Annotation Image Click: Apply annotation graphic Click: Toggle Click: Drag: Dynamic
Mode Drag: Reposition annotation cursor Annotation zoom
graphic/move graphic Roll: Scroll popup menu
endpoint/move annotation annotation tools Drag: W/L
label/text image/series
Key Image Image Click: Select image as key image | Click: Toggle Click: Features
Selector ALT-click: Stay in key image cursor popup menu
mode after click Roll: Scroll Drag: W/L
images image/series
Layout Click: Select image as key image | Click: Toggle Click: Features
Manager ALT-click: Stay in key image cursor popup menu
mode after click Roll: Scroll Drag: W/L
images image/series
Magic X Image Click: Display location of image in | Click: Toggle Click: Features | Drag: Dynamic
all displayed frames cursor popup menu zoom
Drag: Dynamically display Drag: W/L
location of images is all displayed image/series
frames
ALT-click: Stay in Magic X mode
after click
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Cursor Mouse Middle Right Left + Right
Mode Location Left Button Button Button Button
Link Image / Click-Drag-Release: Click on first | Click: Toggle Click: Features
Layout series, drag to series to link, and cursor popup menu
Manager then release Drag: W/L
ALT-click: Stay in Link mode image/series
after click
Cursor Toolbar | Dbl-click: Auto-link all series in
same plane
Magic Glass Image Drag: Move the magnification Drag: Dynamic
window zoom

3.10 Hot Keys and Macros

Hot Keys include various accelerator key combinations used to speed up the application of a function.
The eRAD PACS accelerator keys operate only within eRAD PACS viewer, and may be in conflict with
hot keys employed by other application installed on your PC. By default, the following hot keys are
included in the eRAD PACS viewer.

F2 Show study list (Ded. WS only) F10 Show image overlay info
F5 Full-screen mode Ctrl-F10  Show scale graphic

F6 Show layout manager F11 Show orientation

F7 Show image information dump Alt-F11 Show orientation cube

F8 Show report and key images F12 Show localizer line

F9 Show annotations Alt-F12 Show hash marks

Ctrl-F9 Show embedded overlay Alt-T Show thumbnail panel
Ctrl-1 Zoom1l:1 Alt-2 Zoom1l:2

Ctrl-2 Zoom2:1 Alt-4 Zoom1l:4

Ctrl-4 Zoom4:1 Alt-8 Zoom1:8

Ctrl-8 Zoom8:1 Ctrl-Alt-A  Actual size zoom

Ctrl-H Flip horizontally Ctrl-M Magnification cursor mode
Ctrl-U Flip vertically Ctrl-Alt-Up Open previous study
Ctrl-L Rotate left Ctrl-Alt-Dn  Open next study

Ctrl-R Rotate right Ctrl-Q Close viewer

Ctrl-F Zoom fit to window Ctrl-P Print (selected images)
Ctrl-N Normal cursor mode

Home Show first cine frame Up Show previous cine frame
End Show last cine frame Down Show next cine frame
Ctrl-F Fit image to window Ctrl-Alt-B Bookmark study

Alt-M Magic glass window Ctrl-Alt-R  Restore bookmarked study
Ctrl-Shift-1 Save image Ctrl-Alt-C  Collaborate

Ctrl-Shift-S Save series Ctrl-Alt-D  Disconnect collaboration

Ctrl-Shift-C Copy image to clipboard

Refer to section 4.5 for details on setting up and modifying preset keyboard macros and hot keys.

3.11 Running eRAD PACS Viewer

Each of the eRAD PACS viewers uses a different mechanism to start and terminate.

3.11.1 STARTING AND TERMINATING THE ACTIVE-X VIEWER

As the name indicates, the active-X viewer uses Windows Active-X controls to start. When you install the
software, a file type is registered in Microsoft Windows. The default application for that file type is the
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eRAD PACS viewer. When you select certain items on the eRAD PACS worklist, the browser downloads
a file of the registered type. As a result, Windows automatically launches the viewer.

To get to the worklist so you can load a study in the active-X viewer, you must log onto eRAD PACS.
Select the hyperlink that is the patient’'s name on the worklist, or click on the Open button, and the viewer
starts. If you run the viewer in Standby mode, as described in section 4.2.1, the viewer is always loaded
in memory and launches faster than it otherwise would.

To start the eRAD PACS active-X viewer without loading a study, go to the Windows Start button, and
select Programs. A list of available programs appears. Select eRAD PACS, and eRAD PACS again from
its submenu. If configured to run in Standby mode the viewer loads, but remains minimized in the system
tray.

To terminate a viewing session, close the viewer application by selecting Exit from the File menu or
clicking on the Close button in the top right corner of the application window. If running in configured for
Standby mode, the active-X viewer doesn't really terminate. It closes the open study and then returns to
Standby mode. To completely terminate the active-X viewer, find the eRAD PACS icon in the system
tray, right click on it, and select Exit.

3.11.2 STARTING AND TERMINATING THE STANDALONE VIEWER

The eRAD PACS standalone viewer is most often found on a CD or DVD. To launch the viewer, insert
the CD or DVD into the drive on your workstation. If you have Windows autorun enabled, the viewer
automatically loads. If this does not happen, go to the Windows Start menu, select Run, and enter
d:\pbuilder.exe, where “d:” is the drive label for your CD/DVD device.

When the standalone viewer initiates, the study panel appears. The studies available on the CD/DVD for
displaying in the standalone viewer appear in the study panel. It is not possible to load studies that do not
appear on the CD/DVD.

To terminate the standalone viewer, select Exit from the File menu, or click on the close button in the top
right corner of the application window.
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4  Configuration Settings and Options

The eRAD PACS viewer supports a customizable graphical user interface (GUI). The user has the ability
to define the screen layouts, toolbar arrangements, preset values, custom handing protocol templates,
network settings, overlays, and other settings that make the GUI better suited to specific uses. eRAD
PACS records much of a user’s specific profile on the server, and downloads it to the workstation when a
user logs in. This permits each user to customize their workspace without imposing their preferences on
other users.

The sections in this chapter provide details for customizing the eRAD PACS viewer settings. These
settings are available on all versions of the eRAD PACS viewer, except when noted otherwise.

4.2 Customize Settings Window

The customized settings window contains the means for settings and reviewing the viewer's default
behavior and appearance. Open the customize settings window by selecting Customize Settings from
the Settings menu. The customize settings window consists of a number of tabs, each with a set of
configurable settings, plus an OK, Cancel, and Reset All button. To record all the changes you make on
one of the pages in the customize settings window, click on the OK button. Use the Cancel button to
close the customize settings window without saving your changes. The Reset All button resets all the
viewer’s settings on that page to their original settings.

A tab at the top of the window identifies each page. Click on the corresponding tab to go to a specific
settings page. The available customize settings are grouped into the categories listed below. The
sections that follow give detailed information on each of the customize settings pages.

Settings General viewer feature settings

View Monitor controls and panel settings
Layout Image layout settings

Images Image zooming and compression settings
DICOM Fields Overlay and print header settings

Hash Marks Localizer and Magic X spacing settings
Prefetch Prefetch settings

Cache Viewer cache usage settings

Memory Memory management settings

Colors Custom color selections

Advanced Communication and miscellaneous settings
Spine Spine labeling tool settings

Dictation Report dictation settings

Speech Recognition  Speech recognition and voice command settings

4.2.1 GENERAL SETTINGS

The general settings page in the customize settings window g | st | s | S | er | St |
contains parameters that affect the way specific functions behave

in the eRAD PACS viewer. To display the general settings page, ¥ Ensblestondby mode B Escrmaicgon
select Customize Settings from the Settings menu, and click on the P UszHTTP oy sever 17 Enable dotated s g

H ¥ Show tooltips [~ External level allowed
Settlngs tab ¥ Show ant marker line [V Adjust for CEMAR

. i ™ Show annatation indices [V Mode change with middle button

In many cases, the general settings toggle the behavior of W S s e e ——
functions that different users prefer to be enabled or disabled, P Creat sgfies ¥ Cestecrsh dup
depending on the manner in which they use eRAD PACS. ¥ Stonfepatots
Specifically, the general settings are follows: _ Proposedsaes | Mg zom ecter [ 200 =]

0Ok Cancel Reset Al
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Setting Default Description

Enable standby Enabled Standby mode instructs the viewer to load when Windows starts, and remain in

mode memory. This permits the viewer to launch quicker when opening a study. When
disabled, Windows must read the viewer from disk and load it before the viewer can
start loading data.

Use HTTP proxy Enabled If a proxy server exists between the workstation and the server, certain
communications actions are needed. This setting should be enabled at all times.

Show tool tips Enabled Tool tips are popup text strings that help identify the function of a tool. When
enabled, tool tips appear one second after you place the cursor over a button, field
or gauge in the viewer. When disabled, no tool tips appear.

Show ant line Enabled The ant line marker is the moving, dotted white line that marks the view area in a

marker thumbnail image. When enabled, the ant line marker denotes the location and size
of the image area displayed in the window when a zoom factor is being applied to
the image. If disabled, the markers appear as a solid line the thumbnail image.

Show annotation Enabled Image annotations can include an index for reference purposes. When enabled, an

indices automatically incremented index is included with every annotation applied to an
image. When disabled, the index is not displayed. Override this setting on an
individual basis by right clicking on a specific annotation and select Show Index to
toggle the setting.

Show ruler tick Disabled | Linear measurement annotations support tick marks to assist in calculating

marks distances. When tick marks are enabled, the marks appear on linear measurement
annotations. Override this setting on an individual basis by right clicking on the
specific annotation and select Show tick marks to toggle the setting.

Create log files Disabled | Record user actions in an activity log file.

Show report note | Enabled Pop up report note if present and Impression and Observation are empty.

Center zoom Enabled The center zoom region setting defines the focal point location when establishing a

region zoom region. When enabled, the location of the cursor when you first click is set as
the center of the defined region. When disabled, the location of the cursor when you
first click is set as the corner of the defined region.

Enable dictated Enabled When multiple studies are loaded and the report panel is opened, display a

study listing selection list so the user can choose which report to edit.

External level Disabled | The external level allowed setting provides you with the ability to set your window

allowed center value outside the defined region.

Adjust for CEMAX | Enabled The adjust for CEMAX setting resolves a problem rendering images that were
processed by CEMAX products.

Mode change Enabled The middle mouse button on a three-button mouse changes the cursor mode when

with middle button clicked. Some mice are overly sensitive, and an attempt to scroll the mouse wheel
inadvertently clicks the button. Disable the mouse click function by disabling the
mode change with middle button setting.

Continuous image | Disabled | Scrolling through images in an image frame can progress smoothly by rendering

scrolling every image, or quickly by skipping through the images at a rate based on the
speed the user scrolls. When continuous image scrolling is enabled, the viewer
displays every image in the stack. When disabled, the viewer may skip images to
keep up with the scroll speed.

Create crash Enabled | When the viewer crashes, dump the details to a crash log file.

dump

Proposed states -- The Proposed states button opens the window used to set the states to propose
when closing a study. See section 4.2.1.1 for more information.

Magic glass zoom | 2:1 The magic glass zoom factor defines the magnification applied to the data inside the

factor

magic glass window. The default is a 2x magnification.

4.2.1.1 Proposed States

When closing a study, eRAD PACS attempts to set the study
state to its new state based on the actions you performed
while viewing the images.
study that was in the Unviewed state, and you dictated a
report, eRAD PACS would suggest you set the state to

Dictated when you close the viewer. To define the defaults,

open the proposed states window, and select the resulting

I
Mochange  Viewed Read Dictated  Preliminary Final
For example, if you opened a Open stuy ® ® © w ® @
Add image - - [Cl - - -
Dictate rspoit - - - [ - -
Type rsport - - - - (o -
Cancel

state based on the defined action listed in the window. If you
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do not explicitly set the state of the study before you close the viewer, the prompt eRAD PACS displays
suggests the defined state.

4.2.2 VIEW SETTINGS

The view settings page contains monitor configuration parameters,
plus controls for setting viewing characteristics of the many panels ...
available in eRAD PACS. To display the view settings page, select
Customize Settings from the Settings menu, and click on the View

tab.

The majority of the settings on the view page determine how eRAD

PACS uses the monitors.

In a multiple monitor workstation, the
eRAD PACS viewer can appear on one or more of the monitors.
By identifying the primary monitor and which others to enable, the
user can run eRAD PACS while leaving other applications, such as
the procedure order information or the patient history, displayed on

Memoy | Colors | Advanced | Spine | Dictation | Speech Recognion |
Sefings Yiew | Lapout | Images | Dicom fields | Hashmarks | Prefetch | Cache

I¥ Show thumbnal panel

=] = ™ Layout manager on toy
Murnber of monitors: | 1w | 1= & £ D
I——' e [¥ Info panel on top

™ Repoit panel on top
Moritar #1 v faume

¥ Piint panel on top
[V Collaboration panel on top
I~ | Disable

I | Frimary moritar

~FRepatt parel
™ Link & Full
e 7 Audio
¥ Toobox ¥ Template
™ Orientation
¥ Standard
¥ Status bar

€ Compact
¥ Annotation

¥ Templates

¥ window/Level
[¥ Presentation
[¥ Annotation
I~ Grid lapouts
¥ Tile layouts

~Layout manager
¥ Templates
I¥ Grid laouts
¥ Tile layouts

- Orthogonal imags overla ~Button s

" Buttom left
the remaining monitors. s B % ¢ g || P I F
[ ok | cael | Fesctan |
Section | Setting Default Description
Monitors | Number of monitors | 1x1 The number of eRAD PACS windows to display on the current
monitor. Useful to split a single 2560x1024 Windows monitor into
two 1280x1024 monitors. Only active on single-monitor
workstations.

Monitor # - Select the monitor to configure. Numeric index refers to the
Windows monitor number. See Windows Display properties.

Auto/BW/Color Auto Set the monitor type to greyscale, color, or let eRAD PACS figure it
out.

Primary Monitor Monitor #1 | The selected monitor is the primary monitor, and will display the
popup windows, display the thumbnail panel, and handle other
functions. Primary Monitor can be selected for only one monitor.

Disable Disabled Do not display eRAD PACS viewer on selected monitor.

Templates Enabled Show/Hide the templates toolbar on selected monitor.

Window/Level Enabled Show/Hide the window/level toolbar on the selected monitor.

Presentation Enabled Show/Hide the presentation toolbar on the selected monitor.

Annotation Enabled Show/Hide the annotation toolbar on the selected monitor.

Grid Layouts Disabled Show/Hide the grid layouts toolbar on the selected monitor.

Tile Layouts Disabled Show/Hide the tile layouts toolbar on the selected monitor.

Link Disabled Show/Hide the link toolbar on the selected monitor.

Cine Disabled Show/Hide the cine toolbar on the selected monitor.

Toolbox Enabled Show/Hide the toolbox toolbar on the selected monitor.

Orientation Enabled Show/Hide the orientation toolbar on the selected monitor.

Standard Disabled Show/Hide the standard toolbar on the selected monitor.

Status bar Enabled Show/Hide the status bar on the selected monitor.

General | Show Thumbnail Disabled Show/Hide the thumbnail panel on the primary monitor.

Panel

Layout Manager on Enabled Keep the layout manager displayed on top of all other windows.

top

Info Panel on top Enabled Keep the information panel displayed on top of all other windows.

Report Panel on top | Enabled Keep the report panel displayed on top of all other windows.

Print Panel on top Enabled Keep the print panel displayed on top of all other windows.

Collaboration Panel | Enabled Keep the collaboration panel displayed on top of all other windows.

on top

Report Full Selected Default to the full report panel when opening the report panel.
Panel Compact Unselected | Default to the compact report panel when opening the report panel.

Audio Enabled Show/Hide the audio toolbar on the report panel.

Template Enabled Show/Hide the canned report templates toolbar on the report panel.

Annotation Disabled Show/Hide the annotation toolbar on the report panel.
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Section | Setting Default Description
Layout Templates Enabled Show/Hide canned report templates toolbar on the layout manager.
Manager | Grid Layouts Enabled Show/Hide the grid layouts toolbar on the layout manager.
Tile Layouts Enabled Show/Hide the tile layouts toolbar on the layout manager.
Image Size 25% Size of orthogonal image displayed as an overlay in image frame
overlay Bottom Left/Right Right Default location of orthogonal image overlay
Button Auto/Big/Small Auto Button size used on the selected monitor. Auto tells the viewer to
size automatically apply large buttons when the monitor size is greater
than the value defined in MPx.
MPx 25 The point at which Auto button size uses the Big button size,
specified as mega pixels.

4.2.3 LAYOUT SETTINGS

The layout settings page contains settings for presenting
information in the eRAD PACS viewer. The page provides

.. . . onitar setting
parameters for properly organizing series and image data, default i

sizes for thumbnail and report images, selecting default grid
layouts, and identifying default hanging protocol templates. To
display the layout settings page, select Customize Settings from
the Settings menu, and click on the Layout tab.

The settings on the layout page apply to specific image types.
eRAD PACS identifies an image type by the modality values
stored in the series object. To assign settings to a particular
image type, you must first select the modality type from the pull-
down menu on the layout page. A general image type, called
Default, appears at the beginning of the pull-down menu. When
this value appears in the pull-down menu, the setting applies to all
image types unless overridden with a specific setting. There are

Memoy | Colos | Advanced | Spine | Dictation | $peechRecognion |

Settings | View

I~ Automatic settings
I7 Find localizers
7 Split series
I7 Sort series

Series splitlength: (0

r~ Image layout

Layout | Images | Dicom fieds | Hashmarks | Prefetch | Cache

Settings for MFI =
™| e default setting

€ Tile acioss monitars
jup " 2up
ClaupHl  Cl3upy.  Cdup
& Eup € Sup = 2up

) Custar 2 rows 5 columns

© 2upi

- Thumbnail si
¥ Use default size

Size: B4j pinels

~ Templa

¥ Use default template

- Riepart figure size
¥ Use default size

Size: 255:j|| pisels

I £

I¥ | Show layout manader

~FReport panel

¥ Lze default satting

I~ Show BIRADS

¥ ze hanging protocol assistant

o1

Concel | Reseten |

checkboxes on this page labeled Use Default. When checked, eRAD PACS uses the default setting for
the selected image type. In other cases, a gray check appears in the checkbox, indicating the selection is
actually defined by the default setting.

The table below provides detailed information on each of the settings on the layout page. There are two
settings that apply to the entire page, and therefore are not assigned to any single section. The Settings
For: menu contains all of the supported modality types that the settings on this page can apply to. The
Use hanging protocol assistant checkbox enables and disables a number of the sections on this page. If
the hanging protocol assistant is enabled, the hanging protocol template defines many of the settings.
When disabled, the user settings take precedence.

Section

Setting

Default

Description

Settings for:

Select the modality the settings on this page apply to. Select the
modality type Default to set the default settings for all the
undefined parameters.

Use hanging protocol
assistant

Enabled

When enabled, the hanging protocol assistance attempts to select
the best-defined hanging protocol template based on previous
usage. When disabled, the Template settings take precedence.

Monitor
setting

Multiple monitor

Enabled

Permit the eRAD PACS viewer to appear on all enabled monitors
for the selected modality type. This setting is effective only when
multiple viewer monitors are configured enabled, or the number of
monitors configured on the view page is greater than 1.

Automatic
settings

Find localizers

Enabled

When enabled, separate localizer images grouped in series with
non-localizer images into their own series. When disabled,
localizer images are grouped as specified by the object data.
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Section Setting Default Description

Split series Disabled | Some series contain images in different planes, or using different
acquisition parameters. eRAD PACS can sometimes identify
these series. When Split series is enabled, the images are
grouped together into individual series and made available to the
user. When disabled, the series are grouped as specified by the
object data.

Sort series Disabled | When enabled, always sort the images by image position, or slice
number when position information is unavailable. When disabled,
the series is ordered as it arrived at the server.

Series split length 0 For series with fewer images than specified in the Series split
length setting, separate all images into their own series. Useful for
separating CR series into single images.

Thumbnail | Use default size Enabled | Use the default thumbnail size.

size Size -- Override the default thumbnail size for the selected modality. The
value is defined in pixels-squared

Report Use default size Enabled | Use the default image size.

figure size ["gj7¢ - Override the default figure size for the selected modality. The
value is defined in pixels-squared.

Report Use default setting Enabled | Use the default BIRAD setting

panel Show BIRADS -- Display BIRADs list on the report panel for the selected modality

Image Use default setting Enabled | Use the default image layout setting.

Layout Tile across monitors | -- When selected, the selected tile mode is applied across all
enabled monitors.

N-up -- The default grid layout for the selected modality type.

Custom -- Define a custom grid layout for the selected modality type.

Template | Use default template | Enabled | Use the default hanging protocol template setting.

Template menu -- Select the hanging protocol template to apply to studies of the
selected modality type.

Show layout Enabled | When enabled, display the layout manager after applying a

manager hanging protocol template. When disabled and a template was
automatically applied, do not show the layout manager.

4.2.4 IMAGE SETTINGS

The customize setting window's image settings page contains
image communication and interpretation information.
defines defaults for compression modes, interpolation algorithms, N =

and default window and level settings.

settings page, select Customize Settings from the Settings menu,

and click on the Image tab.

Memory | Colos | Advanced | Spine | Dictation | Speech Recogntion |
Settings | View | Layout Imsges | Dicomfields | Hashmarks | Prefetoh | Cache |

The settings on the image page apply to specific image types,
identified by the modality parameters stored in the series object.
To assign settings to a particular image type, you must first select
the modality type from the pull-down menu on the image page. A
general image type, called Default, appears at the beginning of the
pull-down menu. When this value is selected, the settings apply to
all image types except those overridden with a specific setting.

The page e ~Weneet qualty
EalEE e e esce R A L e ey e
€ Uncompressed & Lossless
To display the image £ e ® Silemmn
€ Wavelet © 10:1 compression
& Ao £ 20:1 compression
401 compression
Use W/Lrange —| - Auto W/L setting 801 compression
I™ Use defaut ovemide
Min a £ Mo ovemide ~Auto W/L range
€ Ovemde by studies
Max| 409 & Ovaride by sutes I Use defaut range
€ Ovenide by imagss N
S € Ovenide al B %
Zoom mods
I Use default interpolation I Use defaut z00m mode
© Nearestpiel & Biinear & Fitowindow © 1.1 C Actual size

OK | Canced | Resat |

There are checkboxes on this page labeled Use Default. When checked, eRAD PACS uses the default

setting for the selected image type.

The table below provides detailed information on each of the settings on the image page. There is one
setting that applies to the entire page, and therefore is not assigned to any single section. The Settings
For: menu contains all of the supported modality types that the settings on this page can apply to.

Section Setting Default Description

Settings for: -

The modality settings on this page apply to. Select Default to set
the default settings for all the undefined parameters.

Page 37




eRAD'

Your workflow solution

eRAD PACS
Viewer Manual

Section Setting Default Description
Use W/L Range Min 0 When overriding the defined window/level setting for an image, this
is the lower window width setting.

Max 4096 When overriding the defined window/level setting for an image, this
is the upper window width setting.

Automatic Enabled | When enabled, use the actual pixel range as the window width and
automatically calculate the level. When disabled, use the values
defined in Min and Max. This setting applies only when no default
window width and center value exists in the image object.

Interpolation Use default Enabled | Use the default interpolation algorithm.

Nearest pixel Use pixel replication to create pixels.

Bilinear Default Use a bilinear interpolation algorithm to create pixels.
Compression Use default Enabled | Use the default compression algorithm.

Uncompressed Do not use any compression on the image data.

Wavelet Compress the image data using a progressive wavelet algorithm.

Auto Default Have eRAD PACS select the best compression setting based on
network configuration and utilization.

Auto WIL Setting | Use default Enabled | Use the default auto W/L override setting.

No override Default Do not override the WI/L setting defined in the image object.

Override by When the entire study defines a full window width, replace it in

study each image with a calculated histogram equalization value.

Override by When the entire series defines a full window width, replace it in

series each image with a calculated histogram equalization value.

Override by When the image is defined with full window width, replace it with a

image calculated histogram equalization value.

Override all Replace the WI/L values for each image in the study with it's auto
range value, regardless of the default values.

Wavelet Quality Use default Enabled | Use the default wavelet quality setting.

Lossless Default When using wavelet compression, use bit conserving quality factor.

N:1 Lossy When using wavelet compression, terminate the decompression
when the selected ratio is achieved.

Auto W/L Range | Use default Enabled | Use the default automatic window/level range.

Distribution 95% To eliminate the noise that may exist at the extreme ends of the
distribution curve, reduce the data set to the defined distribution
range.

Zoom mode Use default Enabled | Use default zoom mode.

Fit to window Default Fit the image to the image frame. Use the interpolation algorithm
selected for this modality type to create additional pixels.

1:1 Display only original pixel data, with no zoom factor applied.

Actual size Display the image in the actual image size. This requires the
monitors be calibrated for size before opening a study, and the
image objects include pixel size information.

4.2.4.1 Ignore Default Window/Level Setting

Some modalities explicitly define a window width that reflects the full range of the pixel data, or a center
value outside the window range, even if these settings result in poor image quality. By default, eRAD
PACS applies predefined window width and center values, regardless of the results. To avoid applying
bad window and level values, use the Auto W/L Setting tool to ignore the predefined values and use its
own histogram analysis to set the initial window and level.

On the image settings page, go to the Auto W/L Setting area, select one of the override settings. No
Override instructs eRAD PACS to use the window and level setting predefined in the image object.
Override by Study/Series/Image means use the internal histogram analysis algorithm when the entire
study, series or image defaults to a full window width. (The optimal setting is Override by Series).

4.2.4.2 Correcting Invalid Window and Level Settings

Some imaging modalities and PACS systems change the original image data, causing rendering
problems in a third party system. If this occurs when using eRAD PACS, you can force a correction that
adjusts the window and level settings. From the image settings page, go to the Use W/L Range field, and
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If you need to use the

defined range, select Automatic, in which case eRAD PACS uses whatever the image object has defined

for itself.

4.2.5 PREFETCH SETTINGS

The prefetch settings page in the customize settings window
configures the server setup for downloading and prefetching
images. The page contains the server address, the protocol used
to communicate with the server, prefetch settings and compression
settings. To display the prefetch settings page, select Customize
Settings from the Settings menu, and click on the Prefetch tab.

The Compression section settings apply to specific image types,
identified by the modality parameters stored in the series object.
To assign compression settings to a particular image type, select
the modality type from the pull-down menu in the Compression
section. A general image type, called Default, appears at the
beginning of the pull-down menu.
settings apply to all image types except those overridden with a

Memoy | Colos | Advanced | Spine | Dictation | Speech Recognition |
Seftings | View | Layout | Images | Dicomfisids | Hashmarks Prefetoh | Cache |

Server: [hto x|/ |
Cycle time: 5j min Intensity: Min | Max
Enable prefetch: [¥  Prefetch in standby mode only I~ Check server
- Study data dowrload — - Imag
Settings for Settings for
o R a—
o I Someasopened | Vavelet qualty
I Use defaul qualty
Compression Compression % Lossless
™ Use defaut ™ Use defautt 51 compression
Cou 0 € 10:1 compression
" Compressed £ lpeg 201 compression
& Ao © Wavelet " 40:1 compression
& Ao " 80:1 compression
When Default is selected, the ==

specific setting. There are checkboxes on this page labeled Use Default. When checked, eRAD PACS
uses the default setting for the selected image type.

The table below provides detailed information on each of the settings on the prefetch page.

Section Setting Default Description
General Server http Use a secure (HTTPS) or open (HTTP) connection to the server.
(protocol)
Server NULL The server address. This value can be a hostname, such as
(address) pacs.hospital.com, or an IP address, such as 10.0.0.1.
Cycle time 30 The time between queries for new studies. The more frequent the
minutes | query cycle, the more traffic that results on the network.
Intensity Max The amount of available bandwidth to use while prefetching.
Enable Disabled | Turn prefetching on and off. When checked, the workstation
prefetch queries the server once every cycle for new studies as defined by
the prefetch worklist filter. When unchecked, no checking occurs.
Prefetch in Enabled | When prefetching is enabled, the query and subsequent downloads
standby mode can take CPU cycles away from other eRAD PACS activities. On
only slower machines, this can impact the GUI performance. When
Prefetch in standby mode only is checked, the query executes when
the viewer is inactive and in standby mode. Clear this checkbox to
continue to query and download studies when the viewer is open.
Check server -- This button checks to see if the configured server is available. Use
it to verify your configuration of the server.
Study Data Settings for: - The modality the settings in this section apply to. Select Default to
Download/Image set the default settings for all the undefined parameters.
Same as Enabled | When checked, the viewer ignores the compression settings on this
Image settings page and defaults to those on the Image settings page. To activate
the settings on this page, clear the checkmark.
Compression Use default Disabled | Use the default compression algorithm.
Uncompressed Do not use any compression on the study data.
Compressed Compress the study data. This uses lossless wavelet.
Jpeg Compress the image data using JPEG.
Wavelet Compress the image data using progressive wavelet algorithm.
Auto Default Have eRAD PACS select the best compression setting based on
network configuration and utilization.
Wavelet Quality | Use default Enabled | Use the default wavelet quality setting.
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Section Setting Default Description
Lossless Default When using wavelet compression for the image data, use a bit
conserving quality factor.
N:1 Lossy When using wavelet compression for the image data, terminate the
decompression when the selected ratio is achieved.

4.25.1 Prefetching

The prefetch settings in the eRAD PACS viewer turn the function on and off (Enable prefetch), and
control the frequency of the prefetch operation (Cycle time), but they do not specify which studies to
include. A worklist filter controls the study list. Section 4.6.1 contains information on setting up prefetch
filters.

To turn on prefetching, enable the prefetch setting in the prefetch settings page, and configure the eRAD
PACS viewer to run in standby mode. When the viewer is running in standby mode, the eRAD PACS
icon appears in the Windows system tray. Refer to section 4.2.1 for information on enabling standby
mode.

4.2.6 CACHE SETTINGS
The cache settings page defines the parameters the eRAD PACS | venoy | Coos | dvancss | Spine | Dicaton || Sposch Recoonion |

viewer's cache uses to manage the study and image data. The o o || | Senis [l [ e
page contains the location of the disk cache, its size and some
control parameters. To display the cache settings page, select Cach
Customize Settings from the Settings menu, and click on the Cache Orectory ame: CAProgam Fies Practioeuder PCacne
tab. Directory size ,—Zﬂﬂﬂj MBytes

. . Sync Cache Empty cache
The workstations’ data storage cache uses a portion of the % Pugetes ot coreatr |3 =]
available disk space. When you open or prefetch a study the first
time, eRAD PACS transfer the data from across the network and
stores the data in the cache. For subsequent opens, eRAD PACS
uses the data in the cache, eliminating the network transfer.
Unless you have a complete understanding of the ramifications of L
changing the size of the disk cache, ask your administrator for
assistance.

eRAD PACS manages the cache itself, so user maintenance is required. The data on the cache settings
page allow you to change the default cache settings, and to reclaim the cache space by clearing it. If you
clear the cache, the data downloads across the network from the server the next time you open the study.
Note that when upgrading the viewer to a new version, the cache may be cleared automatically.

Section | Setting Default Description
Cache Directory C:\Program Files\ The directory eRAD PACS uses for the disk cache. If the
name PracticeBuilder\PBCache\ | default directory does not contain enough disk space, change

the setting to a disk drive that does. Create the directory
before entering it here.

Directory 2GB The size of eRAD PACS'’s disk cache. It should be large
size enough to store all the images you want to be available locally
at any one time. If too small, redundant image downloads
result. If too large, other applications on the workstation may
not have the disk space they need.

Sync cache | -- Rebuild the cache directory.

Empty - This function empties the cache. Use it to recoup disk space
cache taken up by eRAD PACS data.

Purge files | Enabled If you want to purge the data from the local disk cache on a
from cache regular basis, enable this function by putting a check in the
after N box. When enabled, enter the number of days between
days purges.
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4.2.7 DICOM SETTINGS
The DICOM fields settings page contains tools for defining the SMem,l!, i | = | oo | g | i“?;??igﬁiéfl
overlays that appear on the images in the viewer and on printed = T T TR TR
film. To display the DICOM fields settings page, select Customize R 5 fe= = =

=

Settings from the Settings menu, and click on the DICOM Fields tab. "Umdﬂaumﬂmh‘sd'wﬁw Tog:

ok e Al g | [l =
The settings on the DICOM fields page apply to specific image | o] e
types, identified by the modality parameters stored in the series To | [ s
object. To assign settings to a particular image type, select the Fenve | o _
modality type from the pull-down menu on the DICOM fields page. ot
A general image type, called Default, appears at the beginning of ‘;Ekgsd“ |
the pull-down menu. When this value is selected, the settings apply v e a
to all image types except those overridden with a specific setting.
When checked, the box Use the default list for this display location e
instructs eRAD PACS to use the default setting for the selected
image type.

The table below provides detailed information on each of the settings on the image page.

Setting Description

Settings for: Select the modality the settings on this page apply to. Select the modality type Default to set
the default settings for all the undefined parameters.

Use the default Instructs eRAD PACS to use either the default setting for the specified Display Location, or to

list for this display | customize the Display Location for the selected modality type. When checked, the default

location settings are used. When cleared, the control panel is activated and you can customize the
attributes. The default is checked.

[Control panel] Work area for organizing the selected attributes to display in the area specified in Display

Location. Clear the check in the Use the default list... box to activate this area.

Display Location: | The areas of the image and film that you can place demographic and study information. The
available options include top-left, top-right, bottom-left and bottom-right corners of an image,
and the header on a printed sheet of film. Select the appropriate location from the menu before
making changes to the control panel.

Character Size: The font size of the overlay data. The font type is not configurable.

Tag: List of available attributes tags from the DICOM object. This list is created from the attributes
defined in the object loaded in the viewer. If the attribute does not exist in this list, it is not
defined in the DICOM object.

Info: List of calculated values created by eRAD PACS that can be used in overlays.
Add Tag Click this button to add an attribute from the Tag list.

Add Info Click this button to add a value from the Info list.

Add Text Click this button to add a text string.

Break Click this button to insert a carriage return (new-line) character.

Remove Click this button to remove the item selected in the control panel.

Up/Down arrow Move the selected item in the control panel up or down the list.

Defining overlays for images and film consists of selecting the area of the image or film on which you
want to display some data, selecting the information you want to display, and then formatting the
information. eRAD PACS comes with a default overlay defined for all modality types. You can modify the
general overlay specification, and also customize each overlay for specific modality types. The rules for
doing either are the same.

Start by selecting the modality type from the Settings for: menu, or chose the default if you want to
change the common overlay definition. Then, select the location of the overlay from the Display Location:
menu. The control panel updates to show the current settings for that location. If the control panel is
inactive, remove the check from the Use the default list for this display location box. The control panel
can contain literal stings, such as labels, patient demographics, study information, calculated values, and
new-line characters. Use the buttons to the right of the control panel to add and remove these fields.
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When you want to insert an attribute, find it in the Tag or Info list, and click on the respective Add button.
To insert a literal string, click on the Add Text button. A popup window appears. Enter the text, and click
OK. The string appears in the control panel in quotation marks. Move the fields around the control panel
by selecting the attribute and clicking on the up and down arrows to the right of the control panel. To
insert a carriage return between two attributes, insert a new-line character by clicking on the Break button
and moving it to the appropriate location. Remove any attribute in the control panel by selecting it and
clicking on the Remove button.

The Info list contains calculated values, generated by eRAD PACS and based on the loaded study. The
list of available values in the Info list is as follows:

Completion The percentage of the image that has already downloaded to the
viewer.
Compression The compression ratio applied to the image.

Current Annotation  If an annotation is currently selected, the value of that annotation
(i.e., the length, area, text string, etc.) appears in the overlay.

Image Index The position of the image in the series. This is different from the
Instance Number in the Tag list. The Instance Number is a value
defined by the modality, and is not guaranteed to be sequential.
The Image Index uses the position in the series, and therefore is
always sequential.

Level Current window center setting.

Packet Size Size of the network packets in the download transmission.
Series Size Total number of images in the series.

Window Current window width setting.

Zoom The zoom factor currently applied to the image.

The example of the overlay settings shown here includes

Settings for: Dizplay Lacation:

the control panel for the top right and bottom right image ~ [o 2 oA AEOMEN Poe
areas, and the resulting image. In the top-right, a carriage 1 usstue defstist for this dispay lscation
return separates each of the three fields, and there are no  [Suabssion RN
literal strings displayed. As a result, in the event the value |Subesrpion —
is empty, the field on the image will be blank. Sometimes |vi —|
it is better to include a label so when no value exists, it is _— —
H etlings ror IFplay Locahon:
more obvious to the user. & r o

[ Use the default list for this display location

In the bottom-right, a literal string exists to separate the

. . . . . | Ind
two fields. With no carriage return included, all three fields |~ ™ Al s

appear on a single line when displayed on the image. it

4.2.8 HASH MARK SETTINGS

The hash mark settings page defines the parameters the eRAD — Lfnrmlwﬁvmsll = “‘:?i:"maLsSf?SaFfj“fg@Q‘Z:EI
PACS viewer uses to calculate spacing limits for hash marks and

other positioning features. You can define the distance that
defines intersecting image planes and when the Magic X
positioning tool is out of range. This setting page also sets the e
defaults for which kind of hash marks to display. To display the ( Vi angle between mageslncs: | 0] degrees
harm mark settings page, select Customize Settings from the
Settings menu, and click on the Hash Marks tab.

Hash mark spacing
( Minimum ditance between hash matks: | D =] mm ‘

Magic X limits

[# Dimmed Magic X out of 10 mm
eRAD PACS makes a distinction between hash marks and % Dnse Hage Xouof T2
localizer lines. A localizer line is graphic that shows the
intersection of one image on another. This setting applies to the
selected image and results in a single line on the intersecting
images. Hash marks are the collection of multiple localizer lines. S| e =
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This setting applies to all the series of images in the selected frame. The result is one or more lines draw
in the intersecting images, with the displayed image (in the stack frame) displayed using a bold line.

The following table describes the fields that appear on the hash mark settings page.

Section Setting Default | Description
Hash Mark | Minimum distance 0mm Too many hash marks in a small area obscure the radiograph
Spacing between hash marks behind them. This setting defines the minimum spacing permitted
between hash marks.
Localization | Minimum angle 90° Some images are not completely orthogonal to others. This setting
Criteria between image defines the angle of incidence between two intersecting planes that
planes qualifies for displaying a localizer line denoting the intersection. |If
the two planes intersect at an angle greater than that defined, the
localizer line appears on the image.
Magic X Dimmed Magic X out | 10 mm If the current position of the Magic X tool is more than the specified
Limits of N mm. distance from the last image in a series, the graphic dims to a light
gray. The graphic remains gray until the current position is within
the defined distance, or it reaches the Disable distance.
Disable Magic X out | 100 mm | If the current position of the Magic X tool is more than the specified
of N mm. distance from the last image in a series, the graphic disappears.

4.2.9 MEMORY SETTINGS

Memory management settings control EP’'s memory allocation and
usage. These settings directly impact the performance of the
viewer and its interaction with other applications executing on the
workstation at the same time. Do not modify these settings without
some understanding of Microsoft Windows’ memory management
system. To display the memory settings page, select Customize
Settings from the Settings menu, and click on the Memory tab.

Setting Description
Override default Check this box to define a memory allocation limit
mapping limit different from the default 16MBs.

Try to map no more
than N MBytes

The value of N specifies the amount of memory EP
will allocate. Additional memory will be allocated
only as needed.

4.2.10 COLOR SETTINGS

The color settings page contains tools for customizing the colors of
the different parts of the viewer. To display the color settings page,
select Customize Settings from the Settings menu, and click on the
Colors tab.

You can customize many of the colors used in the eRAD PACS
viewer. The list below defines each of the areas. When you select
an area, the current color setting appears to the right of the area list.
The color panel that pops up contains a list of predefined colors,
and an option for defining custom colors.

Annotations
Background
Calibration rulers
Current image

Image annotations
Viewer background
Calibration ruler annotations

image in the selected frame

Settings | View | Layout | Images | Dicomfields | Hashmarks | Prefetch | Cache |
Memory | Colors | Advanced | Spine | Dictation | Speech Recogniion |

Memory Manangemert

¥ Overide defautt mapping limé

Tryto map no more than 16 :ll MBytes

Cancel Reset Al

Settings | View | Layout | Images | Dicomfields | Hashmarks | Prefetch | Cache |
Memoy ~ Colors | Advanced | Spine | Dictation | Speech Recognition |

Background

0K Cancel Reset Al

Frame color of thumbnail image that corresponds to the displayed

Used when only part of the localizer line intersects the image

Grid splitter Image grid border
Hash line shadow
Hash lines Localizer lines and hash marks
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Image background
Information overlay text
Information panel background
Information panel text
Marker line

Marker setting is disabled
Report panel background
Report panel text
Orientation information
Overlay #1-16
Scale markers
Selected annotations
Selected image
Series #1-4

eRAD PACS

Viewer Manual

Background color of the report panel
Color of the text in the report panel
Color of the orientation (left-right) markers overlaid on the image
The 1% through 16" embedded overlay

Rulers indicating image size

The active annotation, when creating or editing
Grid border color of the selected image frame
Color of the thumbnail border for 1% through 4™ series. Colors

repeat starting with the 5" series.

Viewed marker
Visible image
selected image frame

The table below provides detailed information on each of the settings on the colors page.

Color of the image frame that does not contain image data
Color of the overlay text displayed on an image
Background color of the information (info) panel
Color of the text in the information (info) panel

View area border displayed on thumbnail images, when Ant Line

Image viewed indicator on thumbnail image border
Color of the thumbnail image border for a series loaded in the

Section Setting Description

Color Settings Area list A list of areas that can be customized.
Change This button pops up a window from which you can set the color.
Reset selected color Resets the selected area to the default value.

4.2.11 ADVANCED SETTINGS

The advanced settings page defines miscellaneous eRAD PACS
viewer parameters. To display the advanced settings page, select
Customize Settings from the Settings menu, and click on the
Advanced tab.

The data packet size settings define the network packet size best
suited for fast data transfers. The study data download section
controls the compression used on the control data downloaded to
the workstation each time you open a study. The progress of the
control data download is denoted by a blue progress bar displayed
in the Status bar along the bottom of the main viewing area. The
following table explains these settings and the others on this page.

Memory | Colors

Data packet

Settings | View | Layout | images | Dicomfields | Hashmaris | Prefetch | Cache |
Advanced | Spine | Dictation | Speech Recognition |

* Ao 64K

4K 128K
8K 256K
16K 512K
32K 024K

i |

Study data dowrload
I~ Use default compression
" Uncompressed
© Compressed
& Autto

I™ Connect to collaboration peer dirsctly.

Annotation fort size: 8 j

Keep the last 25 oo prntlog fles

Keep the last 20

= text annotations:

D30 usage
¥ Disable Startup Waming

[¥ Disable D3D Rendering

Adiust thread priorities

| cancel | Resetm |

Section Settings Default | Description

Settings for: -- Select the modality the settings on this page apply to. Select the
modality type Default to set the default settings for all the undefined
parameters.

Annotation font | 8 point Font size for the text used for annotations.

size

Keep last N 25 Keep the specified number of print logs on the workstation. Print

DICOM print logs show the results of a DICOM print request, and may be useful

logs in the event a problem occurred.

Keep last N text | 20
annotations list.

Keep the specified number of text annotations in the annotation text

Connect to Disabled
collaboration

peer directly to connect directly.

When a proxy server is involved in the routing between two
collaborating workstations, eRAD PACS needs to know to attempt
When a check appears in the box, the
workstation attempts to connect to the other workstation directly.

Adjust thread -
priorities

Adjust the viewer process’s thread priorities. See section 4.2.11.2.
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Section Settings Default | Description
Data packet Auto Auto eRAD PACS selects the best packet size to use when transferring
size data from/to the server based on network configuration and
utilization.
Size Override the automatic packet size setting and force packets to the

specified size. Smaller packets are best used in slow, busy
networks. Larger packets are best used in fast, quiet networks.

Study data Use default Enabled | Use the default compression algorithm to download the control data,
download thumbnails, etc.
Uncompressed Do not use any compression on the control data.
Compressed Compress the control data. This uses lossless wavelet.
Auto Default eRAD PACS selects the best compression setting based on
network configuration and utilization.
D3D Usage Disable startup | Disabled | Disable the warning notifying you that Direct 3D is not available on
warning your workstation.
Disable D3D Disabled | Disable support for Direct3D. Some display controllers report they
rendering support Direct3D, but actually do not, resulting in invalid images.

4.2.11.1 Automatic Communication Optimization

eRAD PACS attempts to optimize the communications between the server and the viewer according to
the available bandwidth, the network speed, location of the workstation, etc. You have the ability to
override the optimization, but it is not recommended. To have eRAD PACS automatically perform this
optimization, set the Data Packet Size to Auto and the Study Download Data to Auto.

When set to optimize the communications, eRAD PACS packages the initial study information it sends to
the viewer when loading the study based on the network performance. For example, if the Server detects
that the workstation is located on the same local area network (as defined in the LAN-accessible IP
Addresses section of the System Options on the Server page), the study information is transferred
uncompressed in large data blocks, which improves the delivery time over a fast LAN. If the connection
between the server and viewer is across a slow wide area network, eRAD PACS opts for compressed
data and smaller packet sizes.

4.2.11.2 Thread Priorities

The eRAD PACS viewer consists of multiple threads, or processes, that perform specific functions. The
system assigns a priority to each of these threads that the operating system uses to know which one to
execute before the other. Since every platform is affected by numerous issues such as other running
programs, amount of RAM, free disk space, and network performance and reliability, it may be necessary
for a user to override the default priorities and customize them for the specific environment.

eRAD PACS’s default thread priorities are set to work
best across all supported platforms. This generally
means the default settings are not optimal for any
specific platform. Tweaking the thread priorities may
improve your viewer’s performance. e GBS

Load opered images Dee. opened images

Load visible images

Load images

The thread priority setup tool is available from the
customize settings’ advanced page. Click on the | feschimee Decampess inages
Adjust Thread Priorities button to display the
configuration window. The window contains two color- | tegn

coded bars and a number of actions, as shown in the | ®% @t ©durars G tens O foocrond © Hares @ Trecrics
image to the right. The left bar controls the rendering o | cwed | [Fmm]

and loading functions. The right bar controls the

decompression process. The colors in the bars indicate the priority. Blue indicates the lowest thread
priority, red the highest. The actions are listed in the table below.

Page 45




eRAD'

Your workflow solution

eRAD PACS
Viewer Manual

Action Description

Load visible images Loading images that are visible in the viewer, such as on the top of a
stack in an image frame.

Load opened images Loading all images in the selected frame, including those that are not
currently visible on the user interface.

Load images Loading all other images in a study.

Prefetch images Prefetching studies from the EP server to the workstation.

Decompress visible images Decompress images that are visible in the viewer.

Decompress open images Decompress images in the selected frame.

Decompress images Decompress all other images in a study.

To adjust the priority, left-click on the circular knob and drag it along the color-coded bar until the action is
within the priority level you want. Since the priority levels cannot cross each other’s border, it may be
necessary to move multiple knobs to get the action within the correct priority range. Start by moving the
lower-priority knobs first. When you've set the priority level for all of the actions, click on OK to save
them. To reset the priority levels to the manufacturer’s default, click on Reset.

4.2.12 SPINE TOOL SETTINGS
The spine tool settings page defines default settings for the spine

Settings | View | Layout | Images | Dicomfields | Hashmarks | Prefeich | Cache |

Memory | Colos | Advanced

Spine | Dictation | Speech Recogrition

labeling annotation tool. The configuration defined on this page iS s
reflected in the spine labeling window when you activate the | &
annotation tool. To display the advanced settings page, select = &
Customize Settings from the Settings menu, and click on the Spine | e« = tﬂ\ -
tab. I Include L6 =

I Reverse direction

™ Show lines
The spine labeling function is an annotation tool used to quickly e wid: [0 s
label the components of a spine. When activated, the user clicks <= &£  Concalvetebrze " Socal vrebrae
on an image, and the next spine label appears. Subsequent clicks | wm= [ :Eb'::m :;‘i::‘"
add the next label. To progress smoothly through the spine without == F =
requiring user interaction, defaults are needed. This page provides
the default settings used by the spine-labeling annotation tool. [ ok | cocd | Fesenn
Section | Settings Default | Description
Initial Vertebra Enabled | This is the starting point for the vertebral labels. Select
Settings the starting vertebra. If the Vertebra radio button is

selected, the tool defaults to labeling vertebral disks.

Disk Interspace Disabled | This is the starting point for the disk interspace labels.
Select the starting disk interspace. If the Disk Interspace
radio button is selected, the tool defaults to labeling disk
interspaces.

Include L6 Disabled | If checked, include L6 in the list of lumbar disks. If clear,
L6 is not included in the default list of lumbar disks.

Reverse Direction Disabled | If clear, labeling progresses in the direction from cervical
to sacral disks. If checked, labeling progresses in the
reverse direction.

Show lines Disabled | If clear, labels appear with no lines connecting the label to
the focal point. If checked, lines connecting the label to
the focal point appear.

Label Cervical C Default prefix for new cervical disk labels
Texts Thoracic T Default prefix for new thoracic disk labels
Lumbar L Default prefix for new lumbar disk labels
Sacral S Default prefix for new sacral disk labels
Size Height/Width -- The height and width of the vertebra and interspaces,
used when locating the intersecting points on orthogonal
images. The value corresponds to the selected radio
button.
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Section | Settings Default Description

Cervical, Thoracic, Lumbar, -
Sacral vertebra, C-C Interspace,
and Other Interspace

width setting.

The object that corresponds to the reported height and

4.2.13 DICTATION SETTINGS
The dictation settings control the tools available for recording

Settings | View | Layout | Images | Dicomfields | Hashmarks | Prefetch | Cache |

Memory | Colors | Advanced | Spine

Dictation | Speech Recogniion |

dictated reports, including Philips SpeechMike and general B
microphone controls, foot pedal settings and control of the rewind H S e Conto mode
and fast-forward tools. For backward compatibility, the default e o e el
settings conform to previous behavior. To display the dictation AT ien s
settings page, select Customize Settings from the Settings menu, [ Fost peda
and click on the Dictation tab. 1 I
@ Pusho-play
These settings are part of the user profile, so they follow the user to [ Rewind / Fost forward
each workstation. This could be a problem for the selected foot :;E:S'::;dl';“ o
pedal device. If a device is selected on one workstation and does
not exist on another, the foot pedal setting may need to be changed
each time the user switches workstations. ok | Cod | Reai
Section Settings Default Description
SpeechMike | SpeechMike Enabled The SpeechMike support setting instructs the viewer to apply the
support Philips SpeechMike controls to the microphone device. When
enabled, the control file is loaded and the buttons on the
SpeechMike function. When disabled, the controls on the
SpeechMike are disabled.
SpeechMike button | Enabled SpeechMike button click controls the audible click when pressing a
click button on the SpeechMike. When enabled, a click sound is heard
for each button click. The click sound is controlled by Windows,
and can be changed from the Sounds entries in the Windows
control panel.
SpeechMike pause | Enabled SpeechMike pause click controls the audible feedback while the
tick SpeechMike is in pause mode. When enabled, a click sounds
every two seconds when the SpeechMike is in pause mode. The
click sound is controlled by Windows, and can be changed from the
Sounds entries in the Windows control panel.
Keep Speech-Mike | Enabled The Keep SpeechMike active setting keeps the SpeechMike
active activated when you pause your recording.
Control mode — Default Speechmike’s record button toggles the state, On or Off. Toggling
State based the state requires the SpeechMike be activated by pushing to top
middle button. When active, the red light is on and steady.
Control mode - Speechmike’s record button is On only when the button is pressed.
Persistent
Foot pedals | Type None List of installed foot pedal devices. Select the applicable one.
Playback mode — Default Each push of the foot pedal changes the state, from play to stop
Play/Stop playing.
Playback mode — Recording plays only if the foot pedal is pressed.
Push-to-play
Rewind/Fast | Steps Default Each push of the rewind/FFW pedal advanced the set number of
forward seconds in the records. Holding down the pedal for the Hold Down
period rewinds or fast forwards to the beginning/end of the stream.
Continuous Rewind/FFW continues as long as the pedal is pushed.

4.2.14 SPEECH RECOGNITION SETTINGS

The speech recognition settings control both the embedded speech engine plus all supported third-party
speech recognition systems. To display the speech recognition settings page, select Customize Settings
from the Settings menu, and click on the Speech Recognition tab.
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The embedded speech recognition engine requires the SDK
Client version of Dragon Naturally Speaking installed on each
workstation plus the eRAD PACS Embedded Speech
Recognition license. If both are installed on the workstation
when the user logs into the server, the Dragon Naturally
Speaking option and all associated configuration parameters are
enabled. With the embedded speech engine, EP converts voice
stream to text on the workstation. Additional voice commands
for controlling the EP viewer also exist. These can be
downloaded from this settings window, but they need to be
installed from the Dragon command browser. Details on this and
other features of the embedded speech recognition tool can be
found in section 8.2.4.1.

eRAD PACS supports third party speech recognition packages
by initiating the speech system’s client using information about

Memey | Colos | Advanced | Spine | Dictation

[ Jrd Party Speech Recoanition

Aosount ID aliEie
C:A\DictaphonetStudy sml
Password
i~ Dragon NaturallySpesking
Used Speech Recogrition System
' None Dowrioad Yoics Commands

" Dictaphane Powerscribe
" Dragan NaturalySpeaking

™ Auto Record WAV when dictating

™ Show Full isport panel alter dictating

eRAD PACS

Viewer Manual

Settings | Wiew | Lapout | Images | Dicom fields | Hash marks | Prefetch | Cache |

Speech Recognition

- Dictaphone Powerscribe:

Listen for Commands

@ while dictating
© Always

ok | Cawel | Resctal |

the loaded study. If the client application and the associated eRAD PACS third-party speech recognition
license are installed on the workstation, the option and all associated configuration parameters are

enabled in the settings window.
conversion.

In the case of third party solutions, EP does none of the voice to text
How and where that operation takes place is defined by the third party application.

For

information on which third party speech recognition systems EP supports, refer to section 8.2.4.2.

Section Settings Default Description
3 Party Account ID <EP user ID> Account ID sent to the speech recognition engine or
Speech third-party system.
Recognition | Password Password sent to the speech recognition engine or
third-party system.
Use Speech Recognition Default When starting a dictation, record voice stream as a
System - None WAV file, and do not convert any of it to text.
Use Speech Recognition When starting a dictation, activate Dictaphone’s
System — Dictaphone Powerscribe client application.
Powerscribe
Use Speech Recognition When starting a dictation, activate the embedded
System — Dragon Naturally Dragon speech recognition engine.
Speaking
Auto Record WAV when Disabled When using Dragon, also record the voice stream as
dictating save it as a WAV file on the server.
Show Full report panel Disabled After disabling the SpeechMike, the full report panel
after dictating opens automatically. This works best when the
SpeechMike is configured in State-based control
mode.
Dictaphone | XML File C:\Dictaphone\ | Default file written to disk when Powerscribe is
Powerscribe study.xml selected as the speech recognition system.
Dragon Download Voice -- Download the EP Viewer voice commands to the
Naturally Commands local disk for importing into Dragon’s Command
Speaking Browser.
Listen for Command — Default Speech recognition engine accepts input only when
While dictating the Record button is pushed.
Listen for Command — Speech recognition engine is always listening and
Always responding to commands.

4.3 User Profiles

eRAD PACS supports customizable user profiles. A user profile contains the configuration data, viewer
settings, hanging protocols, preset values and other information that make the user environment unique
for each individual.
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The system stores the profiles on the eRAD PACS server(s), and downloads them to the workstation
when the user logs on. As a result, changes a user makes to his or her profile while logged in at one
workstation automatically propagates to the next workstation when the user changes location.

4.3.1 CREATING USER PROFILES

eRAD PACS automatically creates a user profile when the administrator creates the user account. A
system default user profiles exists. After the user logs on and makes changes to the default profile, the
changes are stored back on the server. It is possible to use a user profile from an existing account as the
default when creating a new user account. This provides a method for setting up a set of default user
profiles, such as one for technologists, one for radiologists, and another for orthopedists, and using this
as the baseline profile when creating a new user account. For detailed information on creating user
accounts, refer to the eRAD PACS Operator’'s Manual.

4.3.2 APPLYING USER PROFILES

When a user logs into eRAD PACS, the user profile for that account automatically downloads to the
workstation and remains there until the next user logs in. The user does not need to take any explicit
action to apply their user profile.

eRAD PACS does not support the application of another user’s profile to your account. If you want to add
another user’s setting to your profile, such as a hanging protocol template or series of preset window
width and center values for a particular modality, you must set it up manually under your own account, or
remove your entire account and recreate it using the other user’s profile as the default.

4.4 Presets

eRAD PACS supports preset settings for window width and center, and hanging protocol templates.
Preset settings allow you to group together one or more settings to a specific function, and then apply
those settings all at once by selecting the tag from a list. In the case of preset window and level, you can
create modality specific window/level pairs, and apply them to a selected image by selecting them from
the list. In the case of hanging protocols, you can save the layout used to display a particular study, and
then apply it to another study by selecting the tag from the list. If the hanging protocol assistant is active,
it may apply the hanging protocol template automatically. In all cases, presets speed up image
organization and presentation.

4.4.1 WiNDOW WIDTH AND CENTER

The preset list of window and level values provide a list of all saved window/level settings for a specific
modality type. The preset window/level list appears in the window/level toolbar. The list of preset values
is in the pull-down menu. A few default values exist in the preset window/level list.

e Initial corresponds to the default window width and center values applied when the image is first
displayed. These values come from, first, the window width and center values explicitly defined in
the image object, and, if none are explicitly defined, the actual or auto range, depending on the
settings in Customize Settings.

e Actual Range corresponds to a full window width, centered in the middle of the maximum range,
as defined by the encoded image information.

e Auto Range corresponds to the result of a histogram equalization analysis performed on the data.
In most cases, this results in a smaller distribution than the actual range due to the interpretation
of the pixel data values.

To create a preset window/level entry, load an image into the image frame, and adjust the window width
and center to the desired values. On the window/level toolbar, click the Save button, located next to
presets list. An information box appears prompting you to enter a label for the settings. By default, the
label appears as the window width and center separated by a slash. If you want to use something other
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than the default label, clear it and enter a new name. Complete the process by clicking on Add. The
label appears in the presets list.

To change the settings for an image, set the window width and center in the selected image, and enter
the name in the text field in the window/level toolbar. Click the Save button. A notice appears prompting
you to confirm overwriting the original settings. Click Yes to complete the change.

Instruction Summary — Creating and Changing Preset Window/Level Settings
» Load image in an image frame and set the window width and center.
» Enter the preset window/level setting label in the text field on the window/level toolbar.
» Click Save.
» If the label already exists, confirm the change by clicking Yes on the popup confirmation notice.

To remove a preset window/level setting, select it from the preset list. The button next to the list changes
to a Delete button. Click on the Delete button. A notice appears prompting you to confirm the delete
request. Click on Yes to remove the preset setting.

The Initial, Actual Range and Auto Range settings cannot be deleted or modified.

4.4.2 HANGING PROTOCOL TEMPLATES

Hanging protocols refer to the way eRAD PACS displays the images on the screen. It consists of the grid
layout, which series are loaded into which frames, the tile mode of each frame, the image in the series
that appears on top of the image frame, the location of the current and prior series, series links, and
frame characteristics such as window/level (if saved as presets), zoom factor, and panning position. It
can take some time to set up a hanging protocol for a study. Having to do so for each study can impact
user productivity. By saving the hanging protocol as a template and then applying that template when you
open a new study, you save time. eRAD PACS allows you to save your hanging protocols as preset
templates.

Hanging protocol templates are available from the template toolbar. The template toolbar exists in either
the main viewing area or on the layout manager. Once you define your layout and load the images into

the image frames, save the layout by selecting the save button, E on the template toolbar. A popup
window appears prompting you for a label. This label will appear in the template list identifying this layout.
Enter a descriptive label for the configuration you just defined, such as Default CT, or AP/Lat Chest with
Priors. Click on OK to save the settings.

Instruction Summary — Creating a Hanging Protocol Template

Load images into image frames, scroll to first image, apply window and level, zoom and position.
Enter the hanging protocol template label in the text field on the template toolbar.

Click Save.

If the label already exists, confirm the change to the existing template by clicking Yes on the
popup confirmation notice.

YV VY

Hanging protocols defines the template based on the key-clicks used to organize the image series. For
example, on a CT study, if you put the first series (usually the localizer) into the first grid location, put the
second series into the second and third grids, with the second grid in stack mode and the third grid in a
2x2 tile mode, and a prior CT series in the fourth grid, the hanging protocol template consists of four
images frames, with the first series in the first grid, the second series displayed twice as stated, and the
prior in the last grid. When you apply the template to a study, the first and second series are displayed in
three frames. If a prior exists, it will be in the fourth frame. If a third series exists, it is not loaded when
applying the template to a new study. If no prior exists in the new study, the frame is blank.

4.4.2.1 Hanging Protocol Sets

Hanging protocol sets are an ordered collection of hanging protocol templates. You can apply each one
using a single mouse or button click. To create a hanging protocol set, create and save the individual
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hanging protocol templates. Press the Create a New Hanging Protocol Set button ‘% beside the hanging
protocol selection box in the Template toolbox. The hanging protocol set configuration window appears.
Enter the name of the layout set in the Layout Set name field. Add at least 2 templates to the layout set to

form the sequence. Press the Save button E

Instruction Summary — Creating a Hanging Protocol Sets
» Create and save the individual hanging protocol templates to include in the set.

Press Create a New Hanging Protocol Set button ‘@
Enter the name of the layout set in the Layout Set name field.
Add at least 2 templates to the layout set to form the sequence.

Press the Save button E

YV VVV

Apply a defined hanging protocol template by selecting one from the pull-down list on the template
toolbar. Refer to section 5.2.3 for additional details on applying a hanging protocol template or set.

4.4.2.2 Default Hanging Protocol Template

If you use one hanging protocol template more often than any other, you can define it as the default for
studies acquired from a particular type of modality. By doing so, the hanging protocol assistant
automatically applies the default template when you load a new study of the specified type. If you decide
to use another template, simply select it from the template list in the Layout Manager.

To define a default template, first create and save the hanging protocol template as previously explained.
To make a template the default, open the Customize Settings window (from the Settings menu) and go to
the Layout page. In the Settings For list, select the modality type you want the default template to apply
to, or Default to specify one template as an overall default. In the Template section of the same window,
select the template from the pull-down list. If the Template area is disabled, it is because the hanging
protocol assistance is active. To deactivate the hanging protocol assistant, clear the checkbox. After
setting the default template to use, re-enable the hanging protocol assistant to instruct eRAD PACS to
apply the specified template as the default when it cannot determine which template to apply
automatically.

Instruction Summary — Assigning a Default Hanging Protocol

Create and save the template you want to use as the default.

Go to the Layout page in the Customize Settings window.

Select the modality the default will apply to, or choose Default to set the viewer default template.
Disable the hanging protocol assistance.

Select the template from the pull-down list.

Re-enable the hanging protocol assistant to make the default apply only when no specific
template exists.

VVVYVYVYVYVY

eRAD PACS records the window and level settings in the hanging protocol template if the window width
and center values exist as preset window/level setting. Before saving the template, define and save the
window and level settings as a preset W/L value. Apply the W/L settings to the images in a frame. Then
save the template as previously defined. The next time you apply the template, eRAD PACS looks to see
if the recorded WI/L setting in the template matches a preset W/L setting for the modality type. If defined,
eRAD PACS applies it to the image. Since eRAD PACS stores a separate list of preset W/L values for
each modality type, it is likely that you will not have the same named W/L preset for more than one
modality. As a result, eRAD PACS usually applies preset W/L values to studies from the same type of
modality that you used to create the template.

4.4.2.3 Hanging Protocol Assistant

The hanging protocol assistant is an automated pattern-matching algorithm that matches existing hanging
protocol templates to the characteristics of the study. When opening a study, the hanging protocol
assistant searches through the defined templates to find the one that best matches the study. If it finds a
good match, it automatically applies it to the study and everything appears in the eRAD PACS viewer
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ready to view. If no good match is found, the hanging protocol assistant uses the configured default
settings for the study’s modality type. If no match is found and no default configuration exists, the
assistant displays the layout manager so you can manually organize the study.

Turn the hanging protocol assistant on and off using the Use hanging protocol assistant checkbox on
Customize Settings’ Layout page. When enabled, the hanging protocol assistant inspects the
characteristics of the existing study, and selects the template you used in the past for a study with similar
characteristics. The assistant looks at the following study characteristics:

e study description e number of series in study
e body part o localizer image(s)

e modality e number of monitors

[ ] [ ]

number of studies monitor orientation

The hanging protocol assistant learns from observing your behavior as you use eRAD PACS. As in any
learning experience, the assistant initially knows very little about your reading behavior. By defining and
saving templates for different layouts, and applying them to your study accurately, the hanging protocol
assistant should be able to correctly select the best template after a short period of time. The hanging
protocol assistant learns by analyzing the study’s characteristics and which template you applied, and
adds it to its rules base.

4.5 Keyboard Bindings

Keyboard bindings associate an eRAD PACS viewer function with an assigned key stroke or mouse click.
Currently, users can customize a number of the function keys, assigning them to preferred tools and
settings.

A newly installed viewer comes with a number of predefined key bindings, as defined in section 3.10.
These binding can be changed or deleted using the key binging configuration tool.

Set user-defined keyboard macros or hot keys under Settings/Setup Key Bindings. Function keys F1
through F12 can are programmable, in combination with Ctrl, Shift, and Alt keys to increase the number
of available hot keys. Each key can be listed multiple times to cover different key combinations.

The operations available for assignment to function keys are as follows:

Flip Overlay Flip the overlay text horizontally.

Next Layout Apply the next hanging protocol template in the selected hanging
protocol set.

Set Layout Apply the selected hanging protocol. If selected, a drop down box lists
the available hanging protocols or hanging protocol sets.

Set Light Apply the selected window/level settings. If selected, a drop down box

lists preset window/level settings.

Step Scale Rulers Down Move the scale rulers clockwise around the frame each time the
assigned key is pressed.

Step Scale Rulers Up Move the scale rulers counterclockwise around the frame each time
the assigned key is pressed.

Toggle Hashmarks Toggle the hash marks on or off each time the assigned key is
pressed.

Toggle Localizer Lines  Toggle the localizer lines on or off each time the assigned key(s) is
pressed.

Toggle Off Toggle off the selected function. After selecting Toggle Off from the

drop down box, a Set button appears. Press the Set button to display a
list of available functions that can be toggled. Select the desired
function and press OK. The list of functions for that key is displayed to
the right of the Set button.

Page 52



eRAD'

Your workflow solution

Toggle On
Toggle Switch

View Info Panel
View Layout Manager
View Report Panel
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Toggle on the selected function. After selecting Toggle On from the
drop down box, a Set button appears. Press the Set button to display a
list of available functions that can be toggled. Select the desired
function and press OK. The list of functions for that key is displayed to
the right of the Set button.

Create a toggle switch. After selecting Toggle Switch from the drop
down box, a Set button appears. Press the Set button to display a list
of functions that can be toggled using the switch. Select the desired
functions and press OK. A list of operations for that key is displayed to
the right of the Set button.

Display the info panel when the key is pressed.

Display the layout manager when the key is pressed.

Display the report panel when the key(s) is pressed.

Add Function Key
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To program a keyboard hot key, perform these steps:

1. Select Setup Key Bindings from the Settings menu to display the key binding configuration panel.

2. To use an existing function key, check the combination of Ctrl, Shift, and Alt keys that will control
the operation. Leave all boxes unchecked to use the function key alone to control the operation.

3. To add a new function key combination not currently listed, press the Add Binding button. Use the
operations pull down list to select an operation. Then, click the function key button. When
prompted, press the function key (on the keyboard) you want to add. A new instance of that

button appears on the list.

4. Select the operation from the pull down list.
5. If present, press the Set button. Check the function(s) to be applied, and press OK. These
functions are displayed to the right of the Set button.

Reset the key bindings using the Load Factory Default Settings button.
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4.6 Prestaging

All the eRAD PACS workstations support prestaging technology via the viewer prefetch function. The
viewer prefetch function consists of a prefetch worklist filter defined by each user, and a query initiated by
the viewer. When the query request yields information on new studies that match the prefetch filter,
eRAD PACS viewer retrieves the studies to the workstation and prestages them for viewing.

In addition to the prefetching function, a registered viewer supports auto-routing. The auto-routing
function permits the workstation to have a prefetch filter, in addition to the user’'s prefetch filter. Auto
routing transmits the studies that satisfy the workstation’s prefetch filter when they arrive on the eRAD
PACS server.

4.6.1 PREFETCHING

When the user enables prefetching from the prefetch page in the Customize Settings window, eRAD
PACS uses the worklist’s filter definition labeled Prefetch to select the studies to send to the workstation.
Define a filter that includes all the studies you want to prestage on the workstation, such as all high
priority (STAT) studies, or all unviewed studies that take place during your reading hours, and save it as
the prefetch filter. When the eRAD PACS viewer queries the server for new studies, it applies the user’'s
prefetch filter and downloads the studies that exist on the list but not in the viewer's cache.

The prefetch settings page provides the only means for enabling and disabling prefetching. An
administrator can disable prefetching by logging in from the prefetching workstation as the user who
enabled it, and clearing the checkbox.

When enabled, prefetching occurs when the eRAD PACS viewer is loaded with a study and when it is
running in standby mode. Depending on the resources and performance of your workstation, you may
experience interference due to the background prefetch processing when using the viewer. |If this
happens, select Prefetch in Standby Mode Only in the Customize Settings’ prefetch page. When
selected, prefetching will cease when you open a study in the viewer and automatically restart when the
viewer returns to standby mode.

Since prefetching continues to function after the user logs off of the workstation, excess data traffic can
result when too many workstations have prefetching enabled. Reduce the network traffic by increasing
the prefetch cycle time.

4.6.2 AUTO-ROUTING

A registered eRAD PACS viewer can have its own prefetching worklist, independent of a specific user.
eRAD PACS calls this form of prefetching auto-routing. The registered viewer controls auto-routing
through an auto forward filter configured on the eRAD PACS server.

Start by defining a filter for all the studies you intend to auto-route to the workstation. Assign a label and
save the filter. On the Other Lists page, select the Auto Forward function for the new filter. In the popup
window, select the specific eRAD PACS viewer device you want to route the matching studies to. Note
that the registered viewer must exist in the device table on the Devices web page. Click Apply to save
the settings. When the workstation boots and the viewer enters standby mode, it periodically polls the
eRAD PACS server. The default poll period is once every 30 seconds. When new studies matching the
filter appear on the EP server, they are immediately downloaded to the workstation.

When a user logs into a registered viewer, auto-routing adds the user’s personal prefetch worklist filter to

the query requests. When the user logs off of the workstation, prestaging returns to the workstation’s
auto-routing configuration.
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4.7 System management

Under normal circumstances, the eRAD PACS viewer handles all the routine maintenance and system
management functions. Nevertheless, a number of tools exist for manually verifying or overriding the
viewer’s regular procedures.

4.7.1 MONITOR CALIBRATION

Some digital modalities such as CT and MRI convey actual pixel size and spacing information. The
Practice-Builder 1-2-3 viewer uses this data to automatically render images using the correct aspect
ratios, calculate distances and area measurements, and display objects at their actual size. Some
devices, such as frame grabbers, including ultrasound, and film scanners, do not. For the modalities that
do not provide this information, eRAD PACS provides a calibration tool that the user can use to help the
viewer generate it. For detailed information on image calibration, refer to section 5.5.8.

Once the pixel size and spacing information is available, eRAD PACS still needs to have information
about the monitor in order to render images properly. For this reason, the user has the ability to calibrate
the monitor. While image calibration is needed for each study, monitor calibration is only needed once for
each monitor. However, for safety reasons, eRAD PACS prompts the user to confirm the monitor
calibration for each study. Since eRAD PACS records the previous monitor calibration settings, if the
monitor or display resolution has not changed, the user simply needs to confirm the setting.

Moitor tbtion El
To calibrate a monitor, select the Calibration item on the Settings omn
menu, and select Monitor. A notice appears explaining how to use (o Somm i00mm
the monitor calibration tool. If you do not want this notice to appear
each time, click on the checkbox that indicates you do not want to
display it again. Then click on Next. Using a ruler held up to the Vou s ot th vt by v
monitor glass, drag the horizontal and vertical rulers on the screen sam
using the mouse until they reflect the actual size. When finished,
click on OK.

Repeat this process for each monitor, using the Settings menu at the L
top of each monitor to open the monitor calibration window for each respective monitor. Once you have
calibrated all of the monitors, you will not have to do it again until you either update the eRAD PACS
viewer, or modify the hardware or display settings.

4.7.2 EMPTYING CACHE

The eRAD PACS viewer cache can hold a lot of data, and therefore it may consume substantial amounts
of disk space. If you share your PC with other applications, you may find it necessary to reclaim the disk
space allocated to the viewer cache. Additionally, for security reasons, you may want to erase image files
from your system after you have finished using them. Typically, eRAD PACS manages its cache by
clearing unnecessary files on an as-needed basis. Therefore, no intervention is needed. Nevertheless,
eRAD PACS provides manual and scheduled cache clearing functions to remove lingering data files from
the disk.

To manually remove the data from the eRAD PACS cache, select the Empty Cache function from the File
menu or from the Customize Settings’ cache page.

Instruction Summary — Purging Cache
» From the File menu, select Empty Cache
OR
» From the Settings menu, select Customize Settings
» Select the Cache tab
» Click on the Empty Cache button
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To schedule a recurring purge of the cache, go to the Customize Settings’ cache page. Click on the
Purge Files from Cache after N days checkbox and set the number of days field. As long as eRAD PACS
is running in standby mode, it will automatically empty the cache every Nth day.

Instruction Summary — Schedule a Recurring Purge of the Cache
From the Settings menu, select Customize Settings

Select the Cache tab

Click to put a check in the box labeled Purge Files From the Cache
Enter the number of days after which a purge will take place

Click on the Settings tab

Click to put a check in the box labeled Standby Mode

VVYVVYY

4.7.3 RUNNING OTHER PROGRAMS

The eRAD PACS active-X and standalone viewers are both designed to function alongside other
Windows applications. Provided the other applications are designed to do the same, any user should be
able to run any application while the viewer is running, whether it is in standby mode or active with a
study loaded.

4.7.4 LICENSING

The use of the eRAD PACS viewers require a valid license. All eRAD PACS licenses are customized for
and installed on the server. When the user logs into eRAD PACS, the server checks that the license is
installed and permits the operation requested. Administrators can review the licensed components in the
User License Information section of the Server web page.

The eRAD PACS active-X viewer requires the standard viewer license. The standalone viewer's license
is embedded in the viewer installed on the media.

Plug-in licenses are managed separate from the basic and workstation licenses. A user is licensed to use
the specified plug-in module if the server the user is logged into has the plug-in license installed. Since
the plug-in license is server-based, it is possible for a user to have access to the plug-in module when
logged into one server, and not have access to it when logged into another.

4.7.5 PERMISSIONS — OPEN RIGHTS, REPORT RIGHTS

Use of the eRAD PACS active-X viewer is a privileged operation. To invoke the viewer, the administrator
must have assigned Open rights to your account. If you receive a notification when attempting to open a
study in the viewer informing you that you are unable to access the viewer application, contact your
system administrator and request Open privileges..

The viewer has the ability to edit reports. Note that editing a report includes changing the state, adding a
key image, saving a processed series back to the server, dictating a report, approving a report or making
notes on the report page. Report edits require Report rights. If you are unable to save changes made to
the study from the eRAD PACS viewer, contact your system administrator and request Report privileges.

4.7.6 NETWORK TRANSFER OPTIMIZATION

The best setting for optimized data downloads across a local area network is to use no compression and
large data packets in the network transfers. Conversely, the best setting for optimized downloads across
a wide area network is compressed data and small packet sizes. eRAD PACS automatically sets these
settings based on its configuration and on measured feedback it obtains during each download operation.
Nevertheless, it is possible to override these and force a specific compression application or network
packet size.

eRAD PACS supports settings to define what address ranges constitute the local area network. They are
defined in the LAN domain field on the server's Server web page. Any IP address not on this list is
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deemed accessible via a wide area network. eRAD PACS uses these settings to automatically adjust the
compression setting and the initial network packet sizes for data transfers between its server and viewer.

The user can override these automatic settings from the customize settings window in the eRAD PACS
viewer. The Advanced page controls the compression setting for download of the study summary
information, and the packet size for all transfers. The Prefetch and Image pages control the compression
setting for the download of the image data. When set to Auto, these settings are dynamically set based
on the eRAD PACS LAN domain setting, plus the measured feedback eRAD PACS obtains during each
download operation. In almost all situations, Auto yields the best overall download performance.
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5 Displaying Images
The primary function of the eRAD PACS viewer is to display full-fidelity images for primary interpretation.

This section contains information on how to open and manage the viewing area, load a study, organize
the images once they load, manipulate the data, and save your changes before closing.

5.1 Opening a Study

How you load a study into the eRAD PACS viewer depends on which viewer you use and where you
start. In all cases, the first step is to display a list of available studies. The tools available for displaying
the study list differ slightly among the different viewers. The sections that follow describe how to select
one or more studies to load into the eRAD PACS viewer, how to navigate to other studies once you have
one open, and what the different viewing modes mean.

5.1.1 OPENING A STUDY FROM THE STUDY LIST PANEL

In both registered active-X and standalone viewers, display the list of available studies from the Study List
window, shown below. The study list contains a table of studies that exist on the CD/DVD (standalone
viewer) or in the local cache (registered active-X viewer). In the registered viewer, it is possible to obtain
a list of all available studies on the server by clearing the Local Only checkbox at the top of the study list
window.

Study Panel &
Study Panel
jim : [— Unnamed — = [ EditFielas ] [ Filters ] [ sorting ] ¥ STAT first I™ Local only Page 4
Batch = @ # C(b| Date £ Patient Marme Status Modality Description Referting Physician | Reading Physician | # Imgs
SelectAll | None o a8 Uirlizr e} i) &5 2] o] o]
Wiewed
n[i" 88 0 @ > (ML o, iy Unviewed  [CT Fracture radius  (GARSON SISKO o
n‘[i" B8 & T » fg‘%gﬁgggg Bob, Billy Urviewed  (OT Pathology Slides Df'hy- Marcus A& oo 4
2 oo Aug 13,1999 - M,
nﬁr oo & T hEan COLLARY , MARY Unviewed — ©T HEADACHES  UBER NEEDER 57
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nli g8 & W (20 Ross, Sara Urviewed  [CT PancREATTS  HTTLE ILSON 35 =
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| [P Luim M7 1000 FHBAMIC

To load a study, open the study list window by clicking the button, , in the Standard toolbar, or selecting
CD Contents or Study Panel from the View menu. The study list has many of the functions available on
the browser worklist, including sorting and filtering (registered viewer only) capabilities. Using these
functions, locate the study you want to load. Click on the patient name, or the open button, &, on the left
side of the row.

To open multiple studies at one time, use the batch open function in the study list window. Using the list
filter and sorting functions, get all the studies you want to load onto a single page in the study list. For
each study, click to put a check in the box on the far left of each row. When all the studies are marked,

click on the batch open button, E in the top left corner of the study list.

If eRAD PACS finds prior studies when attempting to open a study in the registered viewer, it displays
them in the study list. The study you select is indicated by the shaded row. The other studies are relevant
priors that have been prestaged from the archive. Clear the Local Only setting to get the server worklist,
and load the study.
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eRAD PACS does not support adding a new study to a list of studies already open in the viewer. If you
need to add a study to your viewer, you must save your work, close the current study, and open it again,
this time adding the additional study to your list of selected studies.

5.1.2 OPENING A STUDY IN THE ACTIVE-X VIEWER

The eRAD PACS active-X viewer is a downloadable application that displays images stored on the eRAD
PACS server. When you log onto the server, eRAD PACS checks to see if you have permission to
display images in the active-X viewer. If so, it checks the version of the viewer currently installed on your
workstation. If no eRAD PACS active-X viewer exists, or a newer one exists on the server, the viewer
automatically downloads to the workstation. Under certain circumstances, you may be prompted before
the download begins. You are advised to always download and install the latest version of the eRAD
PACS viewer. Follow the instructions in section 2.3.2 to install the active-X viewer. When complete, you
are ready to open studies.

Opening a study in the eRAD PACS active-X viewer starts with the worklist page in the web browser.
Request a study by clicking on the hyperlink in the Patient Name column, or click on the Open button to
the left of the study information on the worklist. To open multiple studies at one time, use the worklist
filter function and page size field to get all the studies listed on one worklist page, and then check the box
on the far left side of each row. At the top left corner of the worklist, click on the batch open button. The
eRAD PACS viewer loads all the selected studies.

When opening a study from the hyperlink, eRAD PACS checks the database for relevant priors that
match the selected study. If it finds any, it displays the list in a new worklist. The study you selected is
identified by the shaded row. Select the studies you want to include by putting a check in the box to the
left of each line, and click on the batch Open button at the top left corner of the worklist. If you want to
open just one of the listed studies, click on the patient name hyperlink, or the Open button in the study’s
row.

For additional information on selecting a study list from the eRAD PACS worklist, refer to the eRAD PACS
Operator’'s Manual.

If the eRAD PACS active-X viewer is running in standby mode, it will appear on the screen rather quickly.
If standby mode is disabled, Windows will load the program into memory, and then it will appear on the
screen. Since this involves reading the application from disk and loading it, it may take a considerable
amount of time to launch the viewer, depending on the configuration of the workstation. To improve the
time to launch the viewer, run it in standby mode. See section 4.2.1 for information on enabling standby
mode.

There are two stages to opening a study. The first is the transfer of the study information from the server
to the viewer. This occurs regardless of the whether or not the study already exists in the viewer’s local
cache. The progress of this download is shown by a blue line progressing across the Status bar, and by
a completion percentage displayed in the far right of the Status bar. When the transfer completes, the
EE| viewer has all the information it needs to display the thumbnail
£ images, select a hanging protocol template, and start loading the
— w==% | jmages and report data.

The second stage of opening a study in the eRAD PACS viewer is the loading of the image and report
data. First, eRAD PACS checks the local cache to see if the data is already on the
workstation. If found, the data is loaded from disk. Otherwise, the viewer pulls the data
across the network from the eRAD PACS server. If redirection is enabled, the viewer pulls
the data over from the closest server to minimize network traffic and download time. A blue
progress bar located along the bottom edge of each thumbnail image shows the progress of
each image download. To instruct eRAD PACS to download a specific image first, load that thumbnail
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into a frame in the main viewer workspace. All the series loaded into the main viewing workspace go to
the front of the download queue, and the images displayed at the top of each frame get downloaded first.

5.1.3 OPENING NEXT AND PREVIOUS STUDY

In the eRAD PACS viewer, the user can immediately open the next study in the worklist by using the Ctrl-
Alt-Down keys. Similarly, the Ctrl-Alt-Up keys open the previous study in the worklist. These functions

are also buttons available in the Standard toolbar, and .

To determine the next study, eRAD PACS first applies the current filter to the database, then finds the
study you currently have open, and finally, opens the study that immediately follows it on the worklist. For
the previous study, eRAD PACS does the same except it chooses the study that immediately precedes
the current study on the worklist. The viewer does not qualify the study, meaning it is not possible to use
the next/previous feature to open, say, the next Unviewed study. To accomplish this, you need to apply
the appropriate worklist filter prior to using the next/previous function.

When you use the next/previous function, you are required to respond to any prompts that appear before
eRAD PACS will close the open study. For example, if you have entered a report but failed to send it to
the server, the viewer prompts you to either send it or delete it. Once you have cleared all the prompts,
the current study closes and the next one opens without having to re-launch the viewer.

5.1.4 SAVE CURRENT WORKSPACE TO OPEN ANOTHER STUDY
When using the eRAD PACS viewer, a user can bookmark his or her work, and return to it later. To

bookmark the active study, click on the Bookmark button, @ select Bookmark from the File menu, or
press the Ctrl-Alt-B keys. eRAD PACS saves the study’s current state, including the image layout,
selected key images, annotations, dictations, and study state. After bookmarking a study, it is safe to
close the study and open the viewer again with another study, log out of the system, or open the same
study again. To reload a bookmarked study, close the study you opened after bookmarking the original,
click on the Restore button, , or press the Ctrl-Alt-R keys. If you changed user accounts, you need to
re-login in as the original user to return to the bookmarked study state.

If the eRAD PACS viewer is open with a study that contains edits, eRAD PACS bookmarks it for the user
automatically if the auto-logout timer expires. To restore the study, log in, open the viewer from the
system tray, and click on the Restore button.

5.1.5 STuDY LOCKING AND READ-ONLY MODE

If you open a study but cannot make changes, the study is in read-only mode. This applies when you
open a study from a CD, do not have report editing privileges or some other user has the study open

already. When in read-only mode, you receive a notification X
informing you of this. You can continue to look at the study, but no e sty f Eceian Lt

changes you make are recorded. Some users may be given the & has been locked by Admiristator

ability to override the read-only privileges. If you have this ability, fortmn

the notification informs you of who currently controls the editable [ Breaklok | Open Read Orly

version of the study, and prompts you to break the lock, as seen in
the screen shot shown here.

If you opt to break the lock, you have the only write-enabled copy of the study. The other user receives a
warning that you have taken the lock, but is unable to stop you from doing so. He will be unable to save
his work to the server. It is advisable to verbally notify the user listed in the notification that you intend to
break their lock before doing so. This provides him with an opportunity to save his work.

If you receive a notice indicating another user has taken editing rights (i.e., the study lock) away from you,
you can save your work to your local workstation. When you open the study again and are granted the
editing rights to the study, you can import the saved changes (provided you are working on the same
workstation), and then save them.
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5.2 Organizing the Study Data

Displaying images with eRAD PACS is completely customizable. You can change the characteristics of
the display area, and specify how much of the window you want an image to occupy. You can stack
images, tile them, increase and decrease image size, flip, rotate and invert images, change the window
width and center, invert the grayscale slope, run a cine loop for a set of images, magnify images, change
image attributes, and more.

The primary tools for organizing the images are the thumbnail panel, the layout manager and the hanging
protocol assistant. The thumbnail panel contains a sub-sampled rendering of each image, usually
grouped into series. The thumbnail panel exists to the left of the main viewing area, and is available at all
times. The layout manager is a popup window that consolidates the entire viewing area across all
configured monitors into a manageable popup window. From the layout manager, you can define the
viewing workspace, organize the images, and save the settings as hanging protocols. The hanging
protocol assistant automates the application of hanging protocols. It interprets study characteristics and
finds an appropriate hanging protocol to apply.

5.2.1 THUMBNAIL PANEL

The thumbnail panel lists all the available series. By default, the thumbnail panel is hidden. To display
the thumbnail panel, select it from the View menu, or press the Alt-T keys. When displayed, the
thumbnail panel appears on the left of the main viewing area of the primary monitor. See section 3.4 for
details on the thumbnail panel.

Load a series of images from the thumbnail panel into the main viewing workspace by either double-
clicking on the thumbnail image, or click and drag the thumbnail image to the viewing area using the left
mouse button. To overwrite an existing set of images, use the drag-and-drop method. When you drop
the series into a populated image frame, the new series replaces the previous one.

To concatenate multiple series into a single frame in the viewing workspace, hold down the Ctrl key while
you drag and drop the series into the desired frame. When concatenating images and series into a single
image frame, the cursor changes from the normal drag-and-drop cursor to one with a plus sign (+). This
mode indicates the series being dragged will be added to the images that already exist in the frame.

To quickly load all of the series in a study into the main viewing area, o [ —— o
double-click on the study’s header. This method for loading series into :
the viewing workspace sets the viewer's grid across all available — Study Header
monitors to accommodate all of the series, and then loads one series

into each image frame. The maximum number of image frames eRAD

PACS creates on a single monitor is based on the monitor size, but is -
somewhere around 16. If more series exist than image frames, only the first few series are loaded. Use
the drag and drop method of loading series to replace the series displayed in one of the image frames.

Instruction Summary — Loading Images Into Image Frame
To load the thumbnail in the next open image frame:
» Position the cursor over the thumbnail image and double-click the left mouse button.

To load or overwrite the thumbnail in a specific image frame:
» Click and drag the thumbnail image using the left mouse button to the selected image
frame and release.

To concatenate multiple thumbnails to a single image frame:
> Load the first thumbnail series into an image frame.
» While holding down the Ctrl key, click and drag the second thumbnail image/series into
the same image frame.
» Repeat as necessary, until all series are loaded into the selected image frame.
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To load an entire study:
» Position the cursor over the study header and double-click the left mouse button.

5.2.2 LAYOUT MANAGER

The layout manager consolidates the entire viewing area across one or more monitors into a compact
popup window. Depending on your configuration, the layout manager may appear automatically when
you load a study. When hidden, display the layout manager by selecting it from the View menu or press
the F6 key. For details on the layout manager, refer to section 3.6.1.

The first step in loading the images into the viewer workspace from the layout manager is to select the
grid layout. From the grid tools toolbar, select the number of image frames you want to appear on each

monitor. If you want a single grid to span across all your monitors, select the span button, L&, To
apply a different grid to each monitor, ungroup them. By default all monitors are grouped. The white
frame around each monitor in the layout manager notes this. Select each monitor independently by
clicking on the colored (blue or gray) title bar in the monitor in the

layout manager. When only one monitor is selected, assign the Colored title bar
grid layout. To regroup all the monitors together, press and hold
the CTRL key when clicking on the colored title bar. e ;—,emls Tecks

|@|@|@|X@| H LNEHEEE]
Save

o = e e

The layout appears on the emulated monitors in the Layout
Manager. Each time you click on a predefined grid button, the
layout will change. You can resize the frames in the default grid
by placing the cursor over the boarder lines in the emulated
monitor, clicking the left mouse button, and dragging the line to
obtain the desired size.

Loading the images into the grid is the same from the layout [Nl EEtERI
manager as from the thumbnail panel. Refer to section 5.2.1 for 1
information on loading the series into the viewing workspace.

eRAD PACS's default display mode is to display the layout manager when the study loads. If you want to
prevent the layout manager from appearing each time you launch a study, set it to remain hidden until
manually activated. Open the Customize Settings window and go to the layout page. Clear the
checkmark in the box labeled Show Layout Manager to hide it. A check in the box instructs eRAD PACS
to always display the layout manager. If the checkbox is disabled, it is because the hanging protocol
assistant is enabled. In this case, temporarily disable the hanging protocol assistant by clearing the
checkbox labeled Use hanging protocol assistant. Make your changes to the other settings, and then re-
enable the hanging protocol assistant by putting a check back in the box.

5.2.3 HANGING PROTOCOLS

eRAD PACS provides hanging protocols for reducing the time needed to organize the image data in the
viewer. A hanging protocol is a record of how the series and images in a particular study are arranged in
the main viewing workspace. You create hanging protocols by saving the current layout under a defined
template name. When you select the hanging protocol template, eRAD PACS applies the grid layout, and
then moves the series and images into the defined image frames. It also applies the defined linking state,
window and level settings, zoom factor and frame position. See section 4.4.2 for a thorough description
of hanging protocols.

Apply a hanging protocol by selecting the template from the Template toolbar. The Template toolbar can
exist in the layout manager or the main viewing workspace. Click on the arrow button to display the list of
available templates. Select the desired entry. eRAD PACS applies the template to the current study to
the best of its abilities. If one or more series defined in the template do not exist in the open study, eRAD
PACS leaves the image frame empty.
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Instruction Summary — Applying a Hanging Protocol Template
» Open a study in the eRAD PACS viewer.
» From the template toolbar (in the main viewing area or layout manager), select a predefined
template from the pull-down list.

Hanging protocol sets in the hanging protocol selection box are designated with an asterisk (*). To apply
a hanging protocol set, select it from the drop-down box in the Template toolbar. The buttons beside the

hanging protocol selection box change to ﬁ, Modify Current Hanging Protocol Set, and |@ Go to Next
Layout in the Hanging Protocol Set. Repeatedly click the Go to Next Layout button to advance through
the hanging protocols in a sequence. When you reach the last hanging protocol, it loops and starts over.

The hanging protocol assistant is the tool that automatically checks the characteristics of the new study
against the defined hanging protocol templates, including hanging protocol sets, and selects one to apply.
If no good match is found, the hanging protocol assistant pops open the layout manager. Otherwise, it
displays the series and images as the template specifies. For detailed information on how the hanging
protocol assistant selects a template, refer to section 4.4.2.3.

When you end a study session, the hanging protocol assistant makes a note of the studies characteristics
and the template you have applied at that time. The assistant analyzes this information and adds it to its
rules base. Note that if you change the template before closing the study, the assistant will not learn how
to apply them correctly.

5.3 The Viewing Area

The eRAD PACS viewing workspace displays the full-fidelity diagnostic images. This area makes up the
majority of the graphical user interface, and is generally clear of any formatting or obstacles. To render
the images in a manner conducive to each user’s individual preferences, the user can apply different tools
to manipulate the area’s layout. The user can apply a predefined or custom grid layout, display images in
a stack mode or in a tiled mode, create a common or disassociated environment across all monitors, and
quickly hide all screen objects except the image to eliminate any distractions the interface may cause.

5.3.1 GRID LAYOUTS

eRAD PACS uses a dynamic grid to display images in the main viewing
workspace. For example, a common grid layout is a 4-up symmetrical grid,
consisting of two rows and two columns, as shown here, before adding the
images. You can select from predefined grid configurations, define custom
symmetrical grids, and create asymmetrical grids using the framing tool.

The tools for selecting and creating a grid pattern are available from both
the main viewing workspace and the layout manager. The most common
tool used for choosing a grid layout is the Grid toolbar. Click on the button
showing the grid layout you want to apply to the main viewing workspace. You can also select a grid
layout from the Grid layouts submenu on the Settings menu. On eRAD PACS workstations with multiple
monitors, you can apply a different grid layout to each one. By default, all monitors use the same layout.
To set just one, open the layout manager, and click on the colored title bar of the graphic that represents
the monitor you want to make unique. The white border appears around the selected monitor only. Click
the button on the grid toolbar to set the monitor setting. To move to another monitor, select it by clicking
on the colored title bar. To group all the monitors again, hold the CTRL button while clicking on the
colored title bar. A white border appears around all the selected monitors.

Each frame in a grid contains an independent instance of the images. This means when you place an
image or series in multiple frames, each instance has its own display characteristics, such as window and
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level setting, zoom factor, orientation, and any characteristics. For example, you can render the
abdominal series of a CT study in two different frames, and apply a tissue window/level setting to one
frame and a lung setting to the other.

When you select a grid pattern, the defined frames always remain on the screen. However, you can
change the size of each to the frames by dragging the borders to enlarge or reduce their size. When you
place the mouse cursor over the line separating the grid’s individual frames, the cursor icon changes to
either a two-directional arrow or a four-directional arrow. The cursor indicates the direction in which you
can move the border. While holding down the mouse button, drag the mouse and the grid changes size.
If you have the images displayed as Fit to Window, the image size changes in relation to the grid size.
Once you have loaded the images into the image frames, you can rearrange Frame dragging hook
them by dragging them from one frame to another. When you move the
images to another frame, the images in the destination automatically move to
the original frame. Basically, you are switching the data in the two frames. If
the destination frame is empty, the original frame clears after the move.

[ LIII/ UIELUT LU LU ISLILLLU

Level [ 8255 —J—

To move the images from one frame to another, position the mouse over the
top left corner, over the two diagonal lines. The cursor changes to a hand.
Click and hold down the left mouse button. Drag the frame to any other frame
in the viewing workspace. Release the mouse when your cursor is situated
over the destination frame.

To clear the images from a frame, drag the frame back to the thumbnail panel (on the main viewing
workspace or in the layout manager.) You can quickly clear all the series by selecting a new grid layout
from the grid toolbar.

5.3.1.1 Customizable grid layouts
The grid toolbar offers the user a fixed set of grid layouts. These consist of 1-up, 2-up, 4-up, and other
symmetrical layouts, plus an asymmetrical 3-up. Two methods exist for creating custom grid layouts.

The custom grid button, @, on the grid toolbar enables you to create symmetrical grids that are not
already available. Click on the custom grid button. A popup window appears prompting you to enter the
number of rows and number of columns to apply to your grid layout. After entering the values, click OK.
eRAD PACS applies the defined row and column count. A limit to the number of rows and columns does
exist. The particular limit depends on the resolution of your monitor.

The second customization tool creates asymmetrical grid layouts. With the frame-splitting tool, you can
split existing frames in half. Each frame created has the same independence as any of the default grid
frames, meaning you can insert any group of images into customized frames and apply a window and
level, zoom factor, orientation, etc., to it. You can also save these customized layouts as templates.

To customize a layout, start with the best-fitting predefined grid layout from the grid toolbar, or use the
Grid layouts submenu on the Settings menu. To split any one of the available frames into two
independent frames, click to select the frame you want to split into two frames. From the Grid layouts
submenu from the Settings menu, go to Split selected cell, and choose the position of the new frame
relative the selected frame. A new, empty frame appears next to, above or below the original frame. To
remove one of the frames, repeat the procedure, except select Join selected cell from the Grid layouts
submenu.

5.3.2 TILE LAYOUTS

By default, each grid displays the series in stack mode, meaning the image at the top of the stack takes
up all the space in the frame, with the other images behind it. This is actually a 1-up tile mode. You can
expand the stack into individual image slices by selecting different tile mode. For example, if you want
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the images in a frame to appear similar to a common 12-up sheet of film, you would apply a 12-up tile
mode, with four rows and three columns. eRAD PACS's tiles modes are on the Tile toolbar, which is
available in the main viewing workspace and the layout manager.

A tool exists for defining a custom tile layout. On the Tile toolbar, click the custom tile button, B, and a
popup window appears prompting you to enter the number of rows and columns to apply to your frame.
After entering your preferences, click OK, and eRAD PACS applies the tile mode to the selected frame.
Note that the number of rows and columns you can use is limited. The particular limit depends on the
resolution of your monitor.

5.3.3 FuLL SCREEN MODE

eRAD PACS provides a display mode that removes all screen objects, such as the toolbars, menus,
thumbnails, and Windows taskbar, and displays the selected frame as large as possible on the monitor.
This permits you to eliminate all potential distractions and extraneous light from the screen, leaving just
the pixel data in the image object.

To display an image in the full screen mode, click on the frame and then press the F5 function key. While
in full screen mode, you can apply most functions eRAD PACS makes available on the mouse, including
window and level, panning and zoom. To return to the normal display mode, press the ESC button, click
the close button in the top left corner of the image, or press F5 again.

5.4 Managing Series

eRAD PACS groups all images into series, usually as defined by the imaging source. In some cases, the
series is defined as sequential images acquired as a result of a single pass through a scanner. Other
times, they may be a collection of seemingly random screenshots. Generally speaking, a series is just a
collection of one or more images. Each series in a study appears on the thumbnail panel and in the
layout manager.

The sections that follow contain information on how to organize and manage series of images.

5.4.1 GROUPING AND UNGROUPING SERIES

By default, eRAD PACS uses the series grouping defined when the study was created. Sometimes,
studies contain images grouped into series that users general prefer to view individually. eRAD PACS
provides tools for automatically separating images based on their orientation, ungrouping series into
single-image series, and manually splitting a series into one or more series.

5.4.1.1 Automatic Series Splitting

Imaging modalities group images together in a number of ways. For example, one vendor's CT may
group the localizer image together with the first sequence of axial images, while another vendor's CT
separate the localizer into its own series. eRAD PACS can look at the orientation of each image in a
series, and regroup them accordingly. If configured to perform this check, the studies from both CTs in
the example appear in the viewer with the localizer image in one series and the axial images in a second
series. Another example is when a modality embeds a multi-frame image into a series with single image
frames. Enabling Split Series separates the multi-frame image into its own : :
series in the thumbnail panel. Settings | View  Layout | mage

— Manitor setting

To enable this check, open the Customize Settings window, and select the % Muliple maritar

Layout page. In the Automatic Settings section, check the Split Series box.
This setting can be assigned to any modality or to all modalities by selecting e sl
the modality label in the Settings For menu.

v Find localizers
v Split series

Another automatic series splitting function addresses the situation when an ¥ Sort series
imaging device puts multiple images into a series and the user prefers they be Series spit length: [0
managed independently. An example of this is when a CR acquisition system —
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puts both the AP and lateral x-ray into a single series. eRAD PACS can be configured to separate all
images in a series into individual series. This is most useful when the number of images in the series is
fairly small. For this reason, eRAD PACS uses a threshold to define the point at which it will separate the
images into separate series, or keep them together.

To force all images in a series into separate series, open the Customize Settings window and go to the
Layout page. Insert a non-zero value into the Series Split Length field. The value refers to the point at
which the images remain in a single series in the Layout Manager and Thumbnail Panel. For example, if
the value is 4, eRAD PACS separates each series with 1 through 4 images into 1, 2, 3 or 4 series. For
series with more than 4 images, eRAD PACS leaves the series intact. A value of 0 means the function is
disabled. This setting applies to the selected modality type only. The Default setting does not apply to
this function.

5.4.1.2 Concatenating Series

When loading images into an image frame, eRAD PACS copies each series to a separate grid location.
To load two or more series into a single image frame, you must use the drag-and-drop mechanism as
described in section 3.4 while holding down the CTRL key. Series concatenation mode is indicated by
the cursor. With the CTRL key depressed, the icon includes a ‘+’ marker, indicating you are adding the
selected series to the existing image frame, rather replacing it.

To quickly load all the series in a study into a single image frame, press and hold the Ctrl key while
double-clicking on the study header in the thumbnail panel.

5.4.1.3 Manually Splitting and Joining Series

eRAD PACS provides the tools needed to manually split one series into two or more series. Start by
scrolling through the thumbnail images, or the images in an image frame, until you arrive at the position
where you want to insert the break. Right-click on the thumbnail image to display the popup menu. From
the Tools menu, select Series, and then Cut series. A new series appears in the thumbnail panel or in
the layout manager. The original series contains the images up to the break point. The new series
contains the images from the break point to the end. These modified series remain defined until you
close the study. Note that any instance of the series left in the main viewing area contains the original
image series.

If you or eRAD PACS has separated a series and you want to join it together again, select the frame.
From the Tools menu, click on Series, and then choose Join series forwards or Join series backwards.
One of the two series will disappear from the thumbnail panel and layout manager. The resulting series
contains the images from both original series.

5.4.2 SORTING SERIES

By default, eRAD PACS displays images in the order in which the modality acquired them. Unfortunately,
scans frequently occur in both directions when the procedure calls for multiple series. In these cases, the
first and last images in the series are opposite each other. This makes linking series irrelevant. To
address the problem, eRAD PACS can sort the images based on slice position (relative to the patient) so
that the order of the images in each series is the same.

To set it, open the Customize Settings window from the Settings menu. Go to the Layout page, and
check the Sort Series box in the Automatic Settings section of the panel.

If you want to enable the sort for all modalities, first select Default from the Settings For: list. If you want
to override the default setting, choose the modality you want from the list and enable or disable the sort
setting in the checkbox. The setting will take effect the next time you launch a study.

5.4.3 LINKING SERIES

eRAD PACS has the ability to link together multiple series into independent groups of linked series. For
example, if you have four series rendered in the viewer, you can link two series together into one link
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group, and link the remaining two together into a second link group, and have the two sets operate
independently from each other. Create up to 8 independent linked groups simultaneously.

To create a link group, click on the Link cursor mode button, E or click the middle mouse button until the
Link mode appears. Move the cursor to the first frame you want in the link group, click and drag the
mouse to the second frame, and then release. A link icon appears in the top left corner of each frame.
To add a third frame to the group, repeat the process, starting on either of the currently linked frames,
and ending on the new frame. To create an independent link group, perform the same steps on two
frames that do not belong to any other link group.

eRAD PACS only permits a frame to belong to a single link group. If you need to connect a frame to two
different groups, you need to remove the original link. If you attempt to attach the frame to another link
group, you will be prompted to acknowledge the ungrouping from the first group.

Instruction Summary — Linking Series
» Load two series into different image frames.
» Select the Link cursor mode by clicking the Link button, 2,
» Position the cursor over the first series in the image viewing area.
» Click and hold down the left mouse button, drag it to the second series, and release.

By double-clicking the Link button, the Viewer automatically links together all series from the same study,
in the same image plane and tagged as spatially related to each other by the imaging modality. When
finished, you can identify which series are linked together by matching up like-colored link icons (in the
top left corner of the frame). You can manually add additional series to the automatically defined links, or
unlink them.

Additional link properties are available under Settings/Link Property, or from the Link toolbar. The Mirror
setting sets the panning and rotation features to operate in opposite directions across the linked image
frames. The Magic Glass setting results in a separate Magic Glass window in each of the linked image
frames. The Unhook setting (Link control toolbar, only) temporarily disassociated the link settings so you
can apply an image manipulation tool to a single image frame.

To remove the link, select the frame you wish to remove from the link group, and then click on the link
icon on the image, or click the Link item in the Cine menu.

5.5 Managing Images

eRAD PACS offers a number of image manipulation tools for enhancing the data. You can change the
image’s window width and center, apply a zoom factor, flip, rotate and pan the images, and stack them to
emulate a cine playback. Many of these settings can be applied automatically through hanging protocol
templates, but they are most flexible when applied manually to individual situations. The sections below
provide detailed information on applying image enhancement tools to the images loaded in the eRAD
PACS viewer.

5.5.1 STACK MODE SCROLLING

eRAD PACS includes a 1-up, stacked frame tile mode. This tile mode can appear in any image frame, as
explained in section 5.3.2. A few methods exist for scrolling through the images in the frame:

e Using a three-button mouse with a wheel, left-click on the frame to select it, and then spin the
wheel to scroll through the images. Reverse the wheel direction to scroll in the opposite direction.
e When the image is display in Fit-to-window mode (section 4.2.4) scrolling is available from the left
mouse button. Press and hold down the left mouse button while the cursor is over the image
frame, and drag the mouse back and forth to scroll up and down the stack. Release the mouse to
end the scrolling. Note that the left mouse button controls the panning function when the image is
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not in Fit-to-window mode. When this is the case, hold the CTRL key down while you drag the
mouse with the left mouse button pressed to scroll the image.

e The Up and Down arrow keys advance the image stack. Select the image frame using the
mouse, and then hit the Up or Down arrow key on the keyboard to move forward or backward
through the stack. The Home and End keys jump to the beginning and end of the stack,
respectively.

By default, scrolling through a series of images may skip some slices in order to keep up with the drag of
the mouse. This enables users to advance through a large series very quickly, but is problematic when
you wish to smoothly progress through every image in the series. The Continuous Image Scrolling
setting on the Customize Settings’ Settings page (section 4.2.1) toggles between skipping quickly through
the images and forcing every image slice to appear. When enabled, eRAD PACS displays every slice in
the series if you drag the mouse and continue to hold it down until it reaches the desired image frame.

In addition to these manual scrolling tools, eRAD PACS supports a cine mode that automatically cycles
through a series of images in an image frame. The cine mode setting is available in any image frame that
contains more than one image. You can apply the cine mode setting to one or more of the image frames
simultaneously, and to linked image frames.

The cine mode controls are available from the Cine menu (section 0) and the Cine toolbar (section 3.1.9).
The cine mode controls include play/stop playback, step one frame forward or back, cycle/reverse mode
setting, and a speed adjustment.

To activate cine mode, select the image frame using the left mouse button, and select the Play option
from the Cine menu or toolbar. The images display at a rate defined by the speed control. To activate
cine mode in another window, repeat the process on the other image frame. If the frame is linked to one
or more image frames, all of them play back the images at the same display rate. To stop the cine mode
playback, select the image frame, and then the Stop option from the Cine menu or toolbar.

The Next/Previous functions in the Cine menu are equivalent to manually scrolling the image stack, as
described earlier in the section.

When the cine playback reaches the end of the image stack, the cycle/reverse mode setting defines how
eRAD PACS continues. In Cycle mode, cine playback cycles back to the beginning and repeats the
same sequence. In Reverse mode, cine playback reverses the direction and displays the images in the
reverse order until it reaches the beginning, at which time it reverses direction again, and continues. By
default, cycle mode is selected. Find and change the applied cycle/reverse mode setting from the Cine
menu or toolbar.

You can set the relative speed of the playback by adjusting the playback speed gauge in the Cine toolbar,
or selecting Faster and Slower from the Cine menu. The playback speed is not synchronized to any
clock, so there is no quantitative value to the speed setting. Use this feature simply to increase or
decrease the rate at which images in the stack appear in the frame.

5.5.2 WINDOWING AND LEVELING

eRAD PACS provides multiple tools for adjusting an image’s window width and center values. These
include a sliding gauge, mouse control, predefined setting, explicit numeric definition, a region of interest
histogram, and greyscale inversion. The customize settings includes some configuration parameters for
assigning default values to images without a predefined window width and center, and for overriding
those assigned values.

The quickest way to adjust the window width and center values for an image is by applying a preset
setting to the image frame. On the Window/Level toolbar, click the pull-down list to display the available
presets. Select one of the entries. The settings are applied to the selected image frame. For instructions
on setting a preset window/level setting, refer to section 4.4.1.
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The simplest tool for dynamically adjusting the window width and center values is the mouse control.
Place the cursor over the image. The image can be a thumbnail or one that is loaded into an image
frame in the main viewing workspace. Press and hold down the right mouse button while you drag the
mouse. Right and left movements increase and decrease the window width. Backward and forward
movements increase and decrease the window center. When you release the mouse, eRAD PACS
updates the other images in the series by applying the same offset.

The mouse window/level tool applies the offset resulting from the mouse movement to all the images in
the selected series. For example, after releasing the mouse, the new settings may have increased the
window width by 10 and the center by —50. eRAD PACS applies +10 and —50 to the current window/level
values of each image. If the other images in a series start with a different window/level setting, they will
be different after using the mouse tool. To quickly update all the images to the same window and level
value, first apply a preset window/level setting to the series, and then adjust it using the mouse.

You can assign an explicit window width and center value to an image from the Window/Level toolbar.
Click in the text field next to the appropriate label, delete the present setting, and type a new value into
the area. Press the Enter key to apply it. If you enter in a value that is out of the range of pixel values,
eRAD PACS will set it to the maximum.

The other controls for setting window and level in the Window/Level toolbar are the sliders. eRAD PACS
distributes the possible range of values across the slider. By moving the slider left and right, you can
quickly change the respective value. Start by selecting the image. Then click and hold down the window
or level slider in the toolbar. Move the mouse left and right to move the slider. When you have come to
the desired value, release the mouse.

eRAD PACS provides a window/level tool that uses the pixel distribution within a defined region of
interest to calculate a window range with a center value set to the medium value, and then apply those
settings to the entire image. This is a quick method for applying a density-specific setting to the entire
image. For example, you can apply a bone window to an MRI object by selecting a part of the bone as

the region of interest. To define the region of interest, select the ROI with window/level cursor mode, ﬂ
and position the mouse cursor over the area in the image you want to define. Click and hold down the left
mouse button while you drag the mouse to define the region of interest. As you move the mouse, lines
outlining the region appear. Release the mouse to create the region. You can resize the region by
selecting one of the edges with the mouse and dragging it. Position the mouse cursor over the middle of
the defined region, click and hold down the left mouse button, and you can move the region around the
image. As you do, the window/level within the region continues to update, using the pixels within the
region to create the curve. Each time you release the mouse, eRAD PACS applies the window width and
center values from the region to the entire image. To remove the region of interest, click on the image
anywhere outside the region of interest area.

eRAD PACS supports an automatic inversion of the slope of the curve used to apply the window width
and center. The result is an inverted greyscale image. To apply this setting, select the image in the

image frame, and click the Invert image button, H, in the Toolbox toolbar, or select Invert from the Tools
menu.

To reset the window width and center values of the images in an image frame, click on the reset
window/level button, ﬂ in the Toolbox toolbar, or select Window/level from the Reset submenu in the
Tools menu.

For color images, eRAD PACS can apply a greyscale color map in place of the color palette. The result is
a black and white rendering of the color image. To remove all color from a color image, click on the

Color/Greyscale button, , in the Toolbox toolbar, or select Greyscale from the Tools menu. Note that of
monochrome images, this feature is disabled.
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At times, the images eRAD PACS receives have improperly encoded window width and center values, or
the technologist may have inserted erroneous values into the image objects. To accommodate these
situations, eRAD PACS provides configuration settings it can use to override some default values. On
the Image page in the Customize Settings window, three settings exist for working around problems that
may exist in images.

Use W/L Range — When the image object contains no preset window and level setting, eRAD
PACS can define the default range to use for calculating the values. When this setting is
enabled, eRAD PACS uses the actual range of pixels values to define the default window
width, and positions the window center in the middle of the pixel range. When disabled,
the defined minimum and maximum values are used to set the window width, with the
window center set to the middle of the range.

Auto W/L Setting — Some image objects include unused bits in their definition of the pixel value,
resulting in a very wide window width, even though the pixel data is confined to a
considerably smaller area. When active, this setting overrides the study/series/image
with the actual pixel range as calculated by eRAD PACS. Use this setting when a
particular modality’s images define a window range that is too large.

Auto W/L Range — Some images have noise at the extreme ends of the pixel distribution curve,
which can distort the calculated window width and center values. Use this setting to
eliminate the noise by defining how much of the pixel data to image include in the
automatic calculation of the pixel distribution.

5.5.3 VOILUTs

When a values of interest (VOI) look-up table (LUT) is present in the image object, the eRAD PACS
viewer can apply it in place of the window and level setting. When present, the VOI LUT is included in the
list of available presets. The VOI LUT label is used, preceded by a pound character (#).

When a VOI LUT is applied, the linear window and level toolbar features are disabled. The viewer
denotes this by displaying Using VOI LUT setting in their place. When you use the mouse to change the
setting, eRAD PACS viewer deactivates the LUT, applies the best W/L setting it can, and enables the
window and level fields on the W/L toolbar.

5.5.4 PRESENTATION STATES

The eRAD PACS viewer applies DICOM presentation state objects belonging to the study. The
presentation state is a specific representation of the image data, usually created by the user of another
system such as the imaging modality or perhaps another workstation. Presentation state objects are
used to indicate layouts, window and level settings, zoom factors, overlays and other viewing
characteristics. Sometimes, presentation states are used by other systems to represent key images.

When a presentation state object exists for a specific image displayed in the main viewing area, a
presentation state indicator, ﬁ, appears in the top left corner of the image frame. Click on this icon to
pop up a list of available presentation state descriptions. Select one of the listed descriptions to apply the
corresponding presentation state object on the image. Multiple presentation states can exist for each
object, and you can apply them in any combination. When a presentation state is applied to the image,
the presentation state indicator changes, <>}

The partially applied presentation state icon, B3 is used when overlays or annotations in the
presentation state settings are applied and others settings are not. For example, the presentation state
sets the zoom factor, W/L values and a graphic annotation. If you change the WI/L setting, the image no
longer displays the presentation state’s W/L value, but still displays the annotation.

To remove all presentation state objects from an image, reload the image or series from the thumbnail
panel, or click the icon and select the Delete Overlays from the list in the popup window.
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5.5.5 IMAGE Zoom

eRAD PACS offers a variety of tools to magnify images. You can apply a predefined zoom factor to the
entire image, define a region of interest and zoom that area to fit the image frame, pop up a magnifying
glass window that magnifies the data behind it, dynamically magnify an image, and with some image and
monitor calibration tools, display the image in its actual size.

Within an image frame, the image appears with some magnification factor applied, or it is automatically
sized to fit inside the frame. When fit to the image frame (fit-to-window mode, section 4.2.4), the entire
image appears, and the zoom factor is optionally displayed as overlay text (section 6.1.) All other display
modes apply a magnification factor. When magnified, some of the image may exist outside the image
frame. When in this state, eRAD PACS activates a panning function that allows you to move the image
around within the image frame to center a particular section of the image that may otherwise fall outside
the display region.

When you apply a magnification factor to an image, the thumbnail images, if displayed, show the
viewable region. The coinciding thumbnail image contains a dotted white line indicating the selected area
of interest.

To quickly return the image to its starting point, use the reset buttons in the Toolbox toolbar. There are
buttons to reset the image size to its original display mode (fit-to-window or original size), reset the image
position after panning, plus additional reset functions to return the image orientation and window/level
settings.

5.5.5.1 Applying Magnification

eRAD PACS provides two different cursor modes to magnifying an image. Start by loading an image
thumbnail to an image frame, and then select the image frame. Activate general magnification mode by
clicking on the magnify cursor mode button, &. The cursor turns into a magnifying glass. When in this
cursor mode, there are two ways to zoom into an image. The first is to position the cursor over the center
point of the area you wish to magnify, and press and release the left mouse mutton. The behavior differs
depending on which buttons you hold down when you click the left mouse button, as follows:

None Increase magnification factor doubled

Shift Increase magnification factor quadrupled

Ctrl Decrease magnification factor by one half
Shift+Ctrl Decrease magnification factor by one quarter

The second way to use the magnification mode is to draw a region defining what potion of the image to
display in the image frame. After setting the cursor mode to magnify, position the cursor in the center of
the region you want to define, press and hold down the right mouse button, and drag the mouse. Dotted
lines appear to define the region of interest. When you release the mouse button, eRAD PACS fits the
defined region in the image frame, applying whatever zoom factor is needed. Note that the Center
Region Zoom setting on the Customize Settings’ Settings page toggles between defining the region from
the center out, as described here, or from the top left corner of the area. For details, see section 4.2.1)

After you right or left click the mouse, the cursor mode returns to the Normal cursor mode. If you want to
keep the cursor in magnification mode, hold down the ALT key as you click the left mouse button.

A dynamic zoom mode is available from the gauge on the Toolbox toolbar. When the toolbar is available,
select the image to magnify, and drag the gauge to increase or decrease the magnification factor.

The interpolation mode on the Customize Settings window’s Image page specifies the interpolation
algorithm used when the image is resized. There are various options for determining interpolation. The
Nearest Pixel (default) option uses a pixel replication algorithm to create new pixels. The Bilinear option
performs a first order interpolation using the bordering pixel values to replicate the missing pixels. While
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bilinear interpolation results in a smoother image, there are more derived pixel values than there are
when using the nearest pixel algorithm.

To display the selected image frame on the entire monitor, press the F5 key, or click on the Tools menu,
select Zoom In/Out, and click on Full Screen. When in full screen mode, all of eRAD PACS'’s toolbars,
menus and other graphics disappear, and the entire monitor is used to display the selected image frame.
Many of the same tools that are available in the normal mode are also available in full screen mode,
including window/level, scrolling, and panning. To return from full screen mode, press the ESC or F5 key,
or click on the close button in the top left corner.

When a frame displays images in tile mode other than 1-up, you can quickly enlarge one particular image
to the frame size by double-clicking on the image. For example, if the frame is configured to show 2 rows
and three columns, and you want to look more closely at the fourth image of the six displayed, place the
cursor over the fourth image and double click. The image will appear a large as the frame will allow,
which is equivalent to displaying it in 1-up tile mode. To revert back to the NxM tile layout, double click
again.

5.5.5.2 Dynamic Zooming

Dynamic zooming is an interactive function for enlarging or shrinking an image some indeterminate
amount. Hold down both the left and right mouse button as you drag the mouse forward to zoom in and
backward to zoom out. When zooming in, the region is centered at the cursor’s starting position. The
applied zoom factor appears above the zoom gauge on the Toolbox toolbar

5.5.5.3 Magic Glass

A magnifying glass tool exists for zooming in on images. The Magic Glass feature is a floating magnifying
glass that magnifies the image behind it. To activate the Magic Glass, select the Magic Glass entry in the
View menu, click on the Magic Glass cursor button, , from the toolbar, or type Alt-M on the keyboard. A
popup window appears in the main viewing workspace. Move the popup window over the image(s) by
dragging it with the mouse. The area under the Magic Glass window is magnified by the zoom factor
defined on the Customize Settings’ Setting page. Be aware that while the mouse button is pressed,
eRAD PACS uses a pixel replication algorithm for magnification. When you release the button, eRAD
PACS applies the configured interpolation algorithm. Only image data is magnified. To clear the
magnifying glass, left-click anywhere outside the zoom area.

An enhanced magic glass allows the floating magnifying glass to be applied to multiple, linked images. To
use the enhanced magic glass, link two or more image frames. Check the Magic Glass check box in the
link control toolbar or from the Settings/Link Properties menu. When you apply the magic glass tool at this
point, a magic glass window appears in each of the linked image frames.

You can resize the Magic Glass window that floats over the images can by dragging the edge of the
window. Move the mouse over the edge of the window until it changes to a bi-directional arrow. Click the
left mouse button and drag to resize the window. The window size can be up to 20% of the size of your
display resolution. Note that large Magic Glass windows may result in ghosting as you drag it around. If
this is not acceptable, reduce the size of the Magic Glass window.

5.5.5.4 Actual Size Mode

The Actual Size Zoom mode is a setting that affects the way an image is rendered when not displayed in
fit-to-window mode. The Actual Size Zoom button, i, appears in the toolbox toolbar. When depressed,
the eRAD PACS renders the images in real-world size. When not depressed, eRAD PACS renders the
images in pixel size, matching an image pixel to a monitor pixel. You can toggle the actual size zoom
mode by clicking on the button in the toolbar, or selecting it from the Tools menu, under the Zoom
submenu.

In order for actual size zoom mode to work, both the monitor and the images in the study need to be

calibrated. When you first enable actual size zoom mode, eRAD PACS automatically prompts you to
confirm the monitor calibration. If the selected image does not already contain pixel size and spacing
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information, eRAD PACS automatically prompts you to define it. See sections 5.5.8 and 4.7.1. Note that
if you apply the image calibration settings to the entire study, you are not prompted for this information
again, at least not until you open another study.

5.5.5.5 Image Panning

After magnifying an image, the part you are interested in may fall outside the image frame. eRAD PACS
provides a panning tool to let you reposition the image within the image frame. To pan a magnified
image, position the mouse cursor over the image and press and hold down left mouse button. Then, drag
the mouse to move the image to the desired location. When panning an image, the cursor changes to the
panning mode. Note that in order to pan images, the images must be displayed in some mode other than
fit-to-window.

Use the reset position button, +], in the Toolbox toolbar to reset an image position to the center. Use the
reset size button, &, in the same toolbar to reset the magnification mode.

5.5.6 FLIP AND ROTATE

eRAD PACS's transform functions let you flip an image horizontally or vertically, as well as rotate it to the
right or left. This function works on thumbnail images as well as images displayed in an image frame.
Click to select the image you want to flip or rotate, and then apply the respective function from the
Orientation toolbar, from the Transform item on the Tools menu, or using the shortcuts: Ctrl-H to flip
horizontally; Ctrl-U to flip vertically; Ctrl-L to rotate left; and Ctrl-R to rotate right. To reset the image

orientation, use the reset button, £, in the Toolbox toolbar.

If the image information displayed on the image obstructs the image, it may be useful to flip the text

horizontally. Use the Flip Image Information function, ﬂ in the Orientation toolbar or on the Transform
submenu of the Tools menu to move the image information in the applied image frame.

5.5.7 IMAGE CROPPING
Cropping an image allows the user to mask out unwanted parts of an image. To define a crop area, load

the image into an image frame. Select the Crop mode button, E, in the Toolbox toolbar, or select Crop
from the Cursor item on the Tools menu at the top of the screen. Paosition the cursor over the top-left
corner or the area you want to keep, press and hold down the left mouse button, and drag the cursor to
define the cropped image. When you release the mouse button, eRAD PACS hides everything except
what is within the defined area. A dotted-line frame appears around the entire image.

To resize the area, move the cursor over the edge of the dotted-line frame until the cursor changes to a
bi-directional arrow. Click and drag the mouse to position the edge of the crop area. To resize the image
to fit the frame, click on the Fit to Window button, ==, in the Toolbox tool bar.

Remove the crop area by moving a thumbnail into the frame, or double-click on the image.

5.5.8 IMAGE STITCHING

Stitching is the process of combining two or more images to make a single image that you can
manipulate. This is most commonly applied to spine images or extremities. For example, if you want to
take two CR images of the spine, one upper spine and one lower spine, you can stitch them together to
make a single image, and then calculate a Cobb angle based on the entire spine.

To stitch two images together, you must download and install the Stitching plug-in module, as defined in
Section 3.7. Once installed, the stitching control appears in the Post-processing menu. To activate the
stitching process, load an image into an available image frame, pull down the Post-processing menu and
select Stitch from the Stitching sub-menu. The selected image frame turns into a stitching frame, with the
stitching toolbar displayed along the bottom edge of the frame and the image fit into the frame size.
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The stitching toolbar consists of tools to pan the images, individually
and as a group, tack the image to the workspace, magnify and crop “W 'iﬂw}lf&l@lﬂl Iﬁﬂ ﬁl
the image, and automatically match the images up.

Function  Button Description

Drag mode @W? Drag the image under the cursor around the image frame. Click on the image with the left
mouse button and drag.

Pan mode l~\r|'r5|| Move all the images in the frame. Click on the image with the left mouse button and drag.

Pushpin % Tack the image to the workspace at a specified location. Left click to apply a pushpin. Multiple

mode pushpins lock an image’s position and angular orientation. To remove a pushpin, left click on
the pushpin in the image.

Magnify Q| Increase or decrease the size of the images in the image frame. Left click zooms in. Hold the

mode ALT key and left click to zoom out. Note that dynamic zooming (left+right button drag) works in
any mode.

region. Release the mouse and the area outside the region is eliminated.

Allow When enabled (i.e., depressed), with a single pushpin inserted into the image, left-click-drag

Crop mode 12|:| Remove extraneous information from the image. Click and drag the mouse to define the crop
P
rotation —— rotates the image around the pushpin.

Allow 4—>| When enabled (i.e., depressed), with a single pushpin inserted into the image, left-click-drag
scaling rescales the image size.

Auto align } When the two images are roughly lined up, click the auto align button to find the best overlap.

Start by loading the images into the stitching frame from the thumbnail panel. Since all the images
default to fit-to-window, size the image in the frame so there is enough room to work. Use the zoom
mode button on the toolbar, or dynamically alter the image size by holding down both the left and the right
mouse button at the same time and dragging the mouse. Click on the Drag mode button, and position the
images in their approximate location. Then click on the Auto Align button to have eRAD PACS find the
best fit. When finished, double click on the image to export it to an image frame. The stitching frame
disappears, leaving a single image in the viewer. The image is added to the thumbnail panel. You can
apply any tool to the new image, save it to the eRAD PACS server, and attach it to the report as a key
image.

There are times when it is necessary to manipulate the images in the stitching frame before you can
combine them. For example, it may be necessary to rotate the images so they are properly aligned, or
crop part of an obstruction or border out of the image.

To scale and rotate an image, you must first lock down the image using a
single push pin. Enable and disable rotation via the Allow Rotation button.
When depressed with one pushpin applied to the image, the Drag mode
rotates the image around the pushpin. The same applies to the Allow
Scaling button. When depressed with one pushpin applied to the image,
the Drag mode alters the size of the single image. If you want to rotate
without rescaling the image, apply a single pushpin, press the Allow
Rotation button, unselect the Allow Scaling button, and drag the image.

- : .—eennen . ONCE the orientation is applied, remove
' the pushpin but clicking on it again.

To remove extraneous information from an image, use the crop tool. Left-
click on one of the corners of the image to identify the starting point of the
region you want to keep, and drag to the diagonal corner of the region.
When you release the mouse, the area outside the region is automatically
removed. Be aware that cropping applies to only one of the images at a
time.

By dragging the images, you can position them so they line up. The
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gauge on the left side of the stitching frame indicates the distortion between the two images. The
objective is to make this gauge as small as possible. When you get the images close, use the Auto Align
function to have eRAD PACS try to improve on the image matching. While there is no guarantee that the
automatic alignment function will result in a better signal-to-noise ratio than you can accomplish yourself,
it can usually improve the result. The automatic alignment tool does not try to resize the image.

5.5.9 MASK SUBTRACTION

Mask subtraction is used to eliminate the commonalities between two images, & =
leaving the differences behind to render on the monitor. This is often useful
when tracing some type of bolus or injected die through various parts of the
body. The modality generally provides this information so the workstation can
apply it. If eRAD PACS viewer detects mask subtraction information in the
image, it can automatically initiate the process to apply the parameters and
generate a post-processed series.

iton | Postprocessing Help To use the mask subtraction feature, you E== :

Basic3D AT must download and install the Mask Subtractlon plug in module as

R !ack Subiracton Plugin_» JRSEEES defined in Section 3.7. Once installed, the mask subtraction control

i ' appears in the Post-processing menu. To activate the subtraction

Stitching v process, load a series of images into an available image frame, pull

down the Post-processing menu and select Create from the Mask

Subtraction sub-menu. The plug-in creates a new series and adds it to the thumbnail panel and layout
manager. To display the subtracted image series, drag it to an available image frame.

The mask subtraction tool has configuration settings. From the

Postprocessing menu, select the Mask Subtraction submenu and
] ot el click on Configure. The mask subtraction configuration panel pops
¥ Display Notiiations up. The Automatic Mode setting is to have the viewer automatically
perform the mask subtraction operation on images that contain the
required attributes. The Display Notifications setting pops up a
notice prior to applying the function to the images. By default, both
of these settings are enabled.

If configured to automatically create a subtracted series when FTEEETE SRR T Y

the viewer opens the study, and displaying notifications is
enabled, you will see a notice pop up when you open a study. | Mask Subtraction obiects detectet.

If you select to process the images, the subtracted series are | % '@ Proesss when sl images are downioaded?
automatically created. If you opt to skip this step, you can | ‘oucan disable this dialog in the Mask Subtiaction
manually invoke the mask subtraction process at any time by | Fluginconfiguration dislog

selecting Create from the Mask Subtraction sub-menu in the ‘as Mo
Post-processing menu at the top of the viewer.

Configure

A series of subtracted images has all the properties of a series in the original study. You can window and
level them, apply a zoom factor, measure the structures in the image, annotate the image, save the series
on the server for others to use, and attach one or more as a key image in a report. Be aware that before
you can attach a post-processed image, you must save it to the server first.

5.5.10 CALIBRATION

Some imaging modalities convey enough real-world pixel size and spacing information that Practice-
Builder 1-2-3 can automatically render images using the correct aspect ratios, calculate distances and
area measurements, and display objects at their actual size. For the imaging modalities that do not
provide this information, such as frame grabbed images and scanned film, the user can have eRAD
PACS generate the information by calibrating the image that appears on the screen.
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When the pixel size and spacing information is available, whether supplied by the modality or entered by
the user, eRAD PACS still needs to have information about the monitor in order to render some images
properly. For this reason, the user has the ability to calibrate the monitor. While manual calibration for
images needs to be performed for each study, monitor calibration is only needed once for each monitor.
For safety reasons, the user is prompted to confirm the monitor calibration for each study. Since eRAD
PACS records the previous monitor calibration settings, if the monitor or display resolution has not
changed, then the user simply needs to confirm the setting. Section 4.7.1 contains instructions for
calibrating the viewer monitors.

To perform image calibration, select the Calibration item on the Settings menu, and select Image. The
» Image calibration wizard window appears showing the

* Dontosias current pixel sizing information. If the Use DICOM
C e DICOM coraionda Horontay |8 Vessooly |0 o e calibration data setting is selected and contains non-zero
© lse merslcaibin s Hoeonaly (1799055 vaticaly [DEECEE e values, it means the image object already contains enough

™ Use T specae information for eRAD PACS to use. The Apply To section

Apply to

nily has no calbration data =
ibratiat 1

of the window allows you to assign the calibration
information to an image, a series of images, the entire
ak _ study, or to all the images loaded into the selected image
Ll frame. The default setting is usually the best. If you need
) EE boeboptteeius | [ ] to override the default, click the option you want to use for
these parameters.

sl

el
 sel

seler

If the image does not contain DICOM calibration data, you need to calibrate the image manually so eRAD
PACS can determine the spacing information it needs to assign real-world dimensions to the pixel data.
To manually calibrate the image, click on Add or Change Calibration Rulers. The viewer enters image
calibration mode, and displays the image and a new set of tools.

The calibration tools lets you x
draw one or more rulers on the =

image and then assign a length to
each one. Using this information,
eRAD PACS calculates the pixel
sizes. When you first enter
calibration mode, a full-screen
window appears with an image
display. The cursor is now a ruler
cursor, similar to the linear
measurement annotation tool.
Click, drag and release the
mouse to place a ruler over the
image. When you release the
mouse, you will be prompted to
enter in a distance, in millimeters.
The objective is for you to draw
the ruler over an object in the
image for which you know the
distance. For example, place the
ruler over a measurement graph, or a lead ruler/marker, that appears in the image. You can pan and
zoom the image to get a more accurate result by clicking on the buttons in the top left corner of the
window. The more rulers you define at various angles, the more accurate the size calculations will be.
When finished, click Done. When back at the main calibration window, chose to apply this setting to the
present image, the series, the frame or the entire study, and then click on Finish.
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5.5.11 MAGIC X POSITION LOCATORS

When a study contains multiple series in multiple orientations (axial, coronal and sagital), it is sometimes
necessary to display the same point in all three axes simultaneously. You can do this using eRAD

PACS'’s Magic X function. Set the Magic X cursor mode by selecting the button, ¥, from the Toolbox
toolbar, or from the Cursor item in the Settings menu. Your cursor will change to a fat X. Place the
cursor over the point of interest on one of the images. Left-click and release the mouse and the slices in
the other frames that also contain this point are displayed. Left-click and drag the mouse to make the
Magic X cursor persist, and as you change the position of the cursor, the other images update to display
the intersecting point. If you have localizer lines enabled on these other images, you will see how the
entire slice intersects the other images. After clicking on the image, the cursor mode reverts back to the
normal mode. If you wish to reposition the images again, you need to reselect the Magic X cursor mode.

The Magic X cursor changes when the icon falls outside a defined distance from the intersecting image.
The purpose of this is to provide the user with a clear indication that the referenced image displayed
when using the Magic X tool (i.e., the closest intersecting image to the primary image) is far enough away
from the primary image that the intersection is really not relevant.

The user can define the distance from the intersection used as an indication that it is out of range by
setting the Magic X Limit values on the Hash Marks page in the Customize Settings window. The first
field, Dimmed Magic X after N millimeters, causes eRAD PACS to dim the Magic X icon in the referenced
images once the active Magic X icon moves more than N mm away from the closest slice. This happens
most often when you reach the end of the series. The second field, Disable Magic X after M millimeters,
erases the Magic X icon in the referenced image once the active Magic X icon moves more than M mm
way from the closest slice.

5.5.12 POST-PROCESSED IMAGES

Post-processing involves creating a new image from existing images. These new images may have the
same diagnostic quality as the original, but regardless, you can apply all of eRAD PACS’s image
manipulation functions to them. The sections below describe the different tools available for creating
post-processed images as well as added features that apply just to these image sets.

5.5.12.1 Saving and Deleting Post-processed Images

A post-processed image created in the eRAD PACS viewer only exists during the viewer session unless
you explicitly elect to save it to the server. If you want to attach a post-processed image to a key report,
you must first register it on the eRAD PACS server. If you want the post-processed image available to
other users when they open the study, you must register it. Registering a new image or series means
you send it to server, at which time the server processes it and makes it a permanent part of the study.
Since this is not done automatically, you must explicitly select the post-processed images you want to
send to the server and transmit them.

When you create a new post-processed image or series of images, they appear in the thumbnail panel.
To save the image, load it into an image frame, or select the image frame if already displayed in one. Pull
down the File menu and select Send image to server or Send series to server. The viewer starts
transmitting the image/series to the eRAD PACS server. Be aware that image transfers can take some
time, especially on slow or congested networks. You will be unable to close the viewer until the
transmission completes. The Status toolbar displays the message Sending Image while the transmission
is in process.

If you close the viewer without saving the post-processed images to the server, they will be deleted. To
get them back, you will have to process the original images again. If you want to remove a post-
processed image yourself, you can do so by loading the image into an image frame, pulling down the File
menu, and selecting Delete image/series.
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5.5.12.2 Multiplanar Reconstruction Images
eRAD PACS supports multiplanar reconstruction as a plug-in module. Refer to section 7.1 for complete
details on the MPR plug-in.

5.5.12.3 Basic 3D Images

eRAD PACS supports basic three-dimensional volume rendering as a plug-in module. The 3D plug-in
module creates a volume, supports rotation, positioning and shading tools, permits the definition of cut
planes to intersect the volume, image segmentation, and maximum intensity projection. Refer to section
7.2 for complete details on the basic 3D plug-in.

5.5.12.4 Stitched Images

Stitched images are two or more independent images that are concatenated to create a single image. In
most cases, this is done to two or more CR images or scanned films. eRAD PACS treats the resulting
images as a post-processed image. For details on creating a stitched image, refer to section 5.5.8

5.5.12.5 Templating Results
The results of an orthopedic templating session may include the device report. This report is managed as
a post-processed image, as opposed to a text document. The report can be attached to a report as a key
image, and it can be stored as a post-processed image in the eRAD PACS archive. Other rules for post-
processed images apply to these report images. For details on creating templating reports, refer to the
templating plug-in section, 7.3.

5.5.12.6 AVI Images

eRAD PACS can create an AVI object from any series of images. The AVI object displays the images at
a defined frame rate. While an AVI object is a post-processed image, it does not posses many of the
same properties. AVI objects cannot be saved as a new series, attached to a report or stored on the
eRAD PACS server. For details on creating an AVI object, refer to the AVI plug-in section, 7.4.

5.5.12.7 Mask Subtracted Images

eRAD PACS can apply a mask subtraction algorithm to images that include the requisite attributes.
These attributes must be defined by the modality. eRAD PACS manages the resulting images as a post-
processed image. For details on applying mask subtraction to a series, refer to the Mask Subtraction
section, 5.5.9.

5.6 Warning Indicators

eRAD PACS viewer uses some graphics to inform the user of some condition that may be medically
relevant about the image in the image frame.

5.6.1 IMAGE COMPRESSION

When compression is used to download images from the eRAD PACS server to the viewer, the image
may contain bit errors that result in modified pixel values. This is common when employing compression
ratios that are not hit conserving. To inform the user when an image was downloaded using a lossy
compression ratio, a warning icon, 2\, appears in the upper left corner of the image frame. To eliminate
this warning, select Uncompressed in the image settings page’s Compression section, or select Wavelet
and set the Wavelet Quality setting to Lossless.

5.6.2 IMAGE NOT INTENDED FOR DIAGNOSTIC INTERPRETATION

A Not Intended For Diagnostic Interpretation Indicator © displays for any image not intended for
diagnostic interpretation. Different DICOM objects are used for conveying unprocessed data and
processed data. The warning appears if the image belongs to one of these object classes. For example,
this warning can be seen when opening an unprocessed mammography image.
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5.7 Closing a Study

eRAD PACS uses the action of closing a study to perform a few maintenance operations. First of all, it
verifies that the user saved their work. After saving the work, eRAD PACS updates the user profile on the
main server. As a final step, eRAD PACS sees if there is a bookmarked study that needs to be
reopened.

In the event the user recorded a dictation, created a report, attached key images, or changed the study
state, and did not save those changes, eRAD PACS natifies the user. The notice asks if the user wishes
to save his or her work. The prompt permits the user to update some of the information in the notice
window. When not possible, the user must return to the specific area and save the work. One of the
fields to update is the study state. The suggested state included in the prompt is configurable from the
Settings page in the Customize Settings window. See section 4.2.1.1 for details.

You can close a study from the File menu by selecting Close Study. This leaves eRAD PACS viewer
running, although there are not open studies, and therefore most of the functions are disabled. You can
also close the study by terminating the eRAD PACS viewer. The last way to close a study is to open a
new study. If you return to the worklist or the study panel and select a new study, eRAD PACS
automatically closes the open session before loading the new one.

Note: If you want to add a new study to the studies already loaded, you must return to the worklist or study
panel, and add the new study to the group of studies you want to open, and select a batch open.

5.6.1 TERMINATING THE VIEWER

To terminate eRAD PACS, select Quit from the File menu. The conventional Windows close button in the
top right corner of the application performs the same action as the Quit function.
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6 Overlays and Annotations

eRAD PACS supports overlays and image annotations. Overlays are lines of text containing details
about the patient, the acquisition procedure, the image and other information usually defined by the
imaging modality or information system. When displayed, overlays appear in the corners of each image
frame.

Annotations are text and graphics that usually reference some detail in the image, such as a linear
measurement or an arrow pointing to some anatomical structure. When displayed, annotations appear
on top of the image. See the example of text labels and a measurement annotation in the picture below.

Overlay
Text
Measurement
Annotation
Orientation
Text Markers
Annotation Overlay

The sections that follow give details on creating, displaying, hiding and saving overlays and annotations.

6.1 Overlays

Overlays consist of textual and graphic information identifying the patient, exam type, acquisition data,
and image characteristics. Overlays appear on the image in the corners of each image frame, centered
along the edge of the image (in the case of orientation markers), and directly over the image (in the case
of hash marks). Overlay configurations are specific to each user account, and for each modality type. By
default, overlays as displayed in each image frame, but you can hide them at any time using the function
keys.

6.1.1 TEXT OVERLAYS

Text overlays contain information defined by the modality and encoded in the image object along with the
pixel data, plus some calculated values. To display the text overlays in the image frame, press the F10
button, or select Show Image Info from the View menu. To hide the text overlays, repeat the action.

The default user profile includes a general overlay configuration that is applied to all image types. You
can customize these settings to your own preferences from the Customize Settings window. Open the
window from the Settings menu, and go to the DICOM Fields page. Select the modality type whose
overlay configuration you want to modify, select the location on the image, and use the Add, Remove and
arrow buttons to insert, delete and move the identifiers to the preferred location. See section 4.2.7 for
additional details. Save your settings, and they appear on the image frame.

To set the font size for text overlays, return to the DICOM Fields page of the customize settings window.
The font size is configurable for each area of the image. Again, select the modality type and the location.
Set the font size in the Character Size field by deleting the current setting and entering in a new value, or
use the up/down arrows to the right of the text box to increase/decrease the font size. When you click on
OK, the changes will take place immediately.
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6.1.2 ORIENTATION MARKERS

Orientation markers indicate the position of the imaged body. There are six orientation labels plus one
label to indicate an unknown value:

Anterior (or front)
Foot

Head

Left side

Posterior (or back)
Right side
Unknown

NOOUrITT>

Orientation markers appear in the center of each side of the image. Generally, one marker appears on
each side. If the gantry was tilted during the acquisition, there is a chance the direction increases in
multiple directions. When this is the case, the orientation markers are multiple values, and are listed in
the dominant order. For example, an orientation marker of LH indicates the primary direction of the
vector leading off to that side of the image is toward the patient’s left side, but also progresses toward the
patient's head. Usually, when this appears, the mirror side of the image would contain the opposite
orientation markers. In this example, you would likely see RF on the other side of the image.

When the orientation marker contains multiple values, it is often beneficial to have a visual representation
of the image to understand the degree of tilt in the image. To assist in this visualization, eRAD PACS
provides an overlay that shows how the image slice exists in the 3-dimensional space. It appears as a
cube along the lower edge of the image. The Alt-F11 key sequence toggles the display of this orientation
overlay. In the cases where the image is square to the patient, the overlay appears as one of the letter
labels encased in a square. However, if the image orientation is angled to any degree, the overlay
appears as a 3-dimensional box with the letter identifying each respective orientation.

eRAD PACS determines the orientation markers from information encoded in the image object. When
the image object does not provide enough information for eRAD PACS to accurately determine this
information, no orientation is provided. In this case, eRAD PACS displays question marks (?) in place of
the orientation marker.

To display the orientation markers, press the F11 key, or select Show Orientation from the View menu.
To hide the orientation markers, repeat the action.

6.1.3 SCALE RULERS

Ruler overlays exist for all calibrated images. Calibrated
images are those that contain dimensional information
in the DICOM attributes, or have been manually
calibrated using the image calibration function. (Refer
to section 5.5.9.) They appear on the outside edge of
the image frame. You can assign the location of the
rulers, and whether they exist for the vertical, horizontal
or both planes.

By default, rulers are hidden, but when enabled, appear
in successive viewer sessions if left enabled. Change
the current setting from the View menu by clicking
Show Scale and selecting the location. A hot key, Alt-
F10, is also available. Click repeatedly on the hot key
to advance through the locations. Change the color of
the scale rulers from the Color tab in the Customize Settings window. From the pull-down list, select
Scale Markers, and assign the color. The change takes place after clicking the OK button.

Page 82



eRAD eRAD PACS

Your workflow solution Viewer Manual

6.1.4 LOCALIZERS LINES AND HASH MARKS

Localizers lines and hash marks are overlays the show the intersection of a referenced image on an
orthogonal view. When they appear, they reference the image or images in the selected frame. If you
select a different image frame, the localizer lines and hash marks on the images change to reflect the
intersection of the newly selected image. In most cases, localizer lines and hash marks appear on
orthogonal images.

Note that localizer lines and hash marks appear only when the images are defined by the modality to be
in the same frame of reference. If the modality does not explicitly define all the image objects this way,
eRAD PACS cannot identify the relationship between the images, and therefore it cannot show where
one intersects the other. You can verify two images are in the same frame of reference by opening the
Information Panel, and comparing the value Frame of Reference UID. If the attribute is missing or the
value is different, localizer lines and hash marks are not supported.

While localizer lines and hash marks refer to the same information, eRAD PACS makes a small
distinction between the two. In eRAD PACS, localizer lines refer to a single line showing the intersection
of the referenced image on the other views. Hash marks are the collection of localizer lines showing the
intersection of all the images loaded into the referenced frame on the other views. When displaying a
localizer line, a single line appears. When displaying hash marks, multiple lines appear.

If an image is encoded by the modality as a localizer, eRAD PACS automatically displays localizer lines
and hash marks on it. For all other image types, you must instruct eRAD PACS to display them. If you
want eRAD PACS to attempt to detect which images are localizers, go to the Settings menu and select
Localizers. Then click on Auto find localizers to mark it with a check. Repeat the process to remove the
check. When enabled (checked), eRAD PACS tries to identify images that are orthogonal to the other
images in the series or study, and separates it out as a localizer. When identified as a localizer, eRAD
PACS automatically displays the localizers lines on it.

To show localizer lines, press the F12 button, or go to the Settings menu, select Localizers and then click
on Show localizer lines on all images. To hide localizer lines, press the F12 button again, or select Hide
localizer lines on all images from the same Settings menu. You can make this setting permanent from
the Hash Marks page in the Customize Settings window. Select the modality type, and put a check in the
box to show or hide the localizer lines.

To display hash marks, press the Alt-F12 key combination, or go to the Settings menu, select Localizers
and click on Show hash marks on all images. To hide hash marks, press the Alt-F12 key combination
again, or select Hide hash marks on all images from the same Settings menu. When hash marks are
displayed, one line is highlighted. This line indicates the intersection of the image currently displayed in
the reference frame. You can make this setting permanent from the Hash Marks page in the Customize
Settings window. Select the modality type, and put a check in the box to show or hide the hash marks.

Displaying localizer lines in tiles frames takes on some of the properties of displaying hash marks. If two
image frames, each with a multiple image series in two different orientations (e.g., axial and coronal) are
displayed in stack mode, and you enable each series to show localizer lines and select one of them, the
other shows the intersection of the selected one as it intersects it. If you change the tile mode from stack
mode to two by three tile mode, you will see six localizer lines displayed on the image still rendered in
stack mode. These six lines correspond to all six images displayed in the tile frame. As you scroll
through the tile frame, the six localizer lines change to reflect the six displayed images.

In the Customize Settings window, the Hash Marks page contains some configuration parameters that
affect localizer lines and hash marks. The hash mark spacing parameter defines the space between
hash marks. If the slice thickness is too small, eRAD PACS’s hash marks may run together, resulting in a
solid block of color and completely obstructing the image. To make sure there is enough space between
the hash marks so the image underneath can be identified, use the hash mark spacing field to define the
minimum distance between hash marks.
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The localization criteria parameter in the Hash Marks page defines the angle eRAD PACS uses to
determine whether or not two images are in the same plane or not. If the angle between the image
planes is greater than the value defined, the two planes are considered orthogonal, and a localizer line
appears.

Section 4.2.8 contains details for setting the hash mark spacing and localization criteria parameters.

6.1.5 EMBEDDED OVERLAYS

Embedded overlays are overlays created by third-party devices, such as the imaging modality, and
encoded in the image object. When applied to an image, the corresponding image pixel is replaced by an
overlay pixel, which when combined with other overlay pixels, result in a graphic displayed on top of the
image. Overlays can exist for any object, but are frequently found on summary images or localizer
images.

By default, overlays are displayed if they exist for an object. To toggle the embedded overlay setting, use
the Ctrl-F9 function key, or select Show Overlays from the View menu.

6.1.6 ORTHOGONAL IMAGE OVERLAYS

Orthogonal image overlay is used to display a localizer image as an overlay on an image, serving as a
position reference. The user specifies which overlay image to use. The user can overlay an orthogonal
image with hash marks on printed images. Orthogonal image |g -
overlays also appear on key images when displayed in the
viewer, but not when the key image is rendered as a JPEG image
on the report page from the browser.

The orthogonal image overlay setup is controlled under
Settings/Customize Settings/View. Under Orthogonal Overlay,
set the size and default location of the overlay image.

To apply orthogonal image overlays to an image frame, follow
these steps:

1. Select Show Scout Overlay from the View menu.

2. Drag the image you want to display as the orthogonal
image into the lower right or left corner of the image
frame, and drop it. When positioned over the appropriate area, the image drag cursor changes to
an orthogonal image overlay icon.

3. To move or remove the orthogonal image overlay from an image frame, click on it and drag it to
the desired location, or back into the thumbnail panel.

6.1.7 MAMMOGRAPHY CAD OVERLAYS

A CAD marker provides computer-aided diagnosis to mammography images. eRAD supports the Hologic
Image Checker (formerly R2). Refer to the Hologic Image Checker user manual to learn more about
Image Checker.

If a study includes a CAD marker, the presentation state icon ﬁ appears in the top left corner of the
image when it is displayed in an image frame. To apply a CAD marker, click on the presentation state
icon in the top left corner of the image. The presentation state selection window appears. Select the CAD
marker you want to display, and click on Apply. The icon changes to a partially applied presentation state
icon, . Repeat this process for each CAD marker and each image.

The number and type of marker is listed beside the R2 logo at the top of the image. Refer to the Hologic
Image Checker user manual for more information if necessary.
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6.2 Annotations

Annotations provide you with the ability to attach text and graphics to an image. The Annotation Toolbar

contains a series of eight buttons for working with annotations. The Annotation button, ﬂ puts you in
the annotation mode, providing you with the ability to create, move, modify and delete an annotation. The
available annotations are adding text strings, linear and angular measurements, area measurements
using circular and free-form regions of interest, Hounsfield units, a pointer graphic, key image numbering
and spine labels. When a specific annotation tool is selected, the cursor changes to identify it. Set the
specific annotation tool by selecting it from the annotation toolbar, or if already in annotation cursor mode,
spin the middle mouse button to advance through the available tools.

Most annotations consist of a graphic such as a line representing a rule for linear measurement, or a ring
representing the area defining a region of interest, a value such as the measured length, or a text string,
and an annotation index number. The index number starts at one (‘1') for each image, and increments by
one for each annotation you add to an image. When displayed, these indices can be used as references
to the annotations in the report, or when discussing the data during a collaboration session. The value
and index components float independently from the graphic. If one is obstructing part of the image, click
on the component with the left mouse button, and while holding the button down, drag it to another
location. To move all three at the same time, move the graphic component.

You can hide all the annotations using the F9 function key, or by selecting Show annotations from the
View menu. When hidden, the annotations still exist, but do not appear on top of the image. To display
the annotations again, repeat the sequence.

To set the font size of annotations, open the Customize Settings window from the Settings menu and go
to the Advanced page. The font size is specified in the field labeled Annotation font size. To change the
setting, delete the value and type in a new size, or use the up/down arrows to the right of the edit box to
increase/decrease the font size. When you click on OK, the changes get applied to all existing and future
annotations.

To modify or remove an existing annotation, click on the Annotation button to enter — pgo=i=
annotation mode, and then click to select the annotation you want to change. When

selected, you can drag the annotation around, or adjust its settings. Right click on the — "
annotation to pop up a menu (shown here) containing annotation commands. From this v shawindx
menu, you can remove the selected or all annotations, show or hide the annotation index ™=
number, numerical value such as the length or area or the tick marks in a linear ruler, or
change the font size or color.

Font size ...

Show tick marks

Cancel

6.2.1 TEXT ANNOTATIONS

Use the Add Text button, ﬂ to create or add text to an annotation that you want subsequent viewers to
see. Click on the image where you want to insert the text string. A window appears with a field for
entering the text string. This field is also pull-down list containing the previously entered annotation
strings. If you have entered the text string before, you can select it from this list. The feature supports an
auto-completion capability such that eRAD PACS automatically fills in the value once you have entered
enough for it to find a match. By default, the history file retains the last 20 values. Enter the text and click
on OK. To remove unwanted values from the history list, select the value from the text annotation
window and click on the Delete button.

6.2.2 MEASUREMENT ANNOTATIONS

eRAD PACS supports linear measurements, ﬂ angular measurements, ﬁ, Cobb angle measurements,
A, and area calculations on oval, g, and free-form, ﬂ, regions. Linear measurement values are
displayed in millimeters. Angles are displayed in degrees. Area values are in square millimeters. If the
image object does not contain pixel size and spacing information, eRAD PACS displays measurements in
pixels. To convert pixels to real-world dimensions, you must calibrate the image. (See section 5.5.8.)
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To use the linear, angular and oval ROl measurement tools, select the respective annotation button and
left-click with the mouse on the image. While holding down the left mouse button, drag the cursor to
expand the measurement ruler or region. Release the mouse button to get the measurement value. You
can adjust the measurement graphic by clicking on one of the edges and dragging it to resize.

For the angle measurement, select the angle tool and left-click with the mouse on the image, and drag.
The initial application of the graphic defines only one leg of the angle graphic. You will have to click and
drag the second leg of the graphic to set the angle properly.

The Cobb angle tool measures angles whose vertex exists outside the image. This is useful in measuring
very small angles, such as spine curvature. Select the Cobb angle tool, click on the image and drag the
mouse. The line connecting the two vectors of the angle appears. To casts each vector, click on the end
point of the line perpendicular to the connector and drag. Position along the axis you need to measure.
Repeat with the perpendicular line at the other end of the connector. The angle created when these two
lines intersect is displayed. See the example shown to the right.

The free-form region of interest tool defines a geometric area that cannot be
enclosed using the other ROI tools. To define a space, click on the free-form
ROI button. Move the cursor to a starting point on the image and click the left
mouse button. While holding down the left mouse button, drag the mouse to
define the region. When you release the mouse button, eRAD PACS
automatically closes the region by connecting the end point with the start
point. eRAD PACS calculates the area within the defined space and displays
it on the image. To correct the region outline, move the mouse until it crosses
over the point to want to move. The cursor changes to either a two-directional
or four-directional arrow. Click the left mouse button and drag the mouse to
move the line. If you hold the Shift key while dragging, the line will move in an
arc. Without the Shift key, you will just move the point under the cursor.
When done, release the mouse button. eRAD PACS recalculates area inside
the region.

The calibration tool uses the linear measurement annotation tool to define the ruler used to calibrate the
image. Linear measurements added during image calibration appear only when in calibration mode.

6.2.3 HOUNSFIELD UNIT ANNOTATIONS

The Hounsfield annotation tool creates a region of interest and calculates its average pixel value and the
standard deviation on the distribution. To perform this calculation, select the Hounsfield ROI button, @,
click on the image, and drag the mouse to define the region of interest. When you release the mouse,
eRAD PACS calculates the values and displays them. Resize the region by clicking on one of the edges
of the graphic, and drag it.

To get the value of a particular pixel anywhere in the image, select the Hounsfield annotation tool and
position the cursor over the pixel of interest. The pixel value is displayed in the lower right corner of the
Status bar, along the bottom of the screen. If the Status bar is hidden, display it by going to the View
menu at the top of the screen, select Toolbars, and click on Status Bar.

6.2.4 REPORT IMAGE NUMBERING

When attaching key images to a report, it is useful to label each image so you can reference them in the
report. With the text annotation tool, you can manually add a textual identifier to each key image before
attaching it to the report. With the Report Image Numbering annotation tool, eRAD PACS can drop a
sequential numeric label onto each image in the report, eliminating the need to explicitly type in a text
annotation. To use the report figure numbering tool, click the button, E, open the full-size report panel,
and click on a key image. The next number in the sequence appears where you clicked. To move the
numeric label, select the annotation and drag it to another location on the same key image. To delete the
annotation, right-click on the selected annotation and select Delete.
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6.2.5 POINTER GRAPHIC ANNOTATION

The pointer graphic tool draws an arrow on the image. Select the pointer annotation button, ﬂ, and click
on the image. Drag the mouse to adjust the size of the pointer. You can rotate the graphic around its
head by clicking on the end of it and dragging it around.

The pointer graphic tool can contain a text string. The advantage of adding text to the pointer graphic
over using the text annotation tool is that eRAD PACS manages the two annotations as one. Therefore, if
you move or adjust the point graphic, the text automatically follows. To assign a text string to a specific
pointer annotation, first drop the pointer annotation onto an image. Hold the Ctrl key when you click to
place the pointer annotation on the image, and the text box automatically appears. Alternatively, right-
click on the pointer to display the popup menu and select Edit text. The text list appears. Select a text
string from the pull-down list, or type a new string into the text window. Click OK.

6.2.6 SPINE LABELING ANNOTATION

The spine-labeling tool is for labeling vertebrae and disk interspaces. The result is similar to adding text
annotations to an image of a spine, except the spine-labeling tool uses predefined labels, and displays
them in their corresponding location on images in all orthogonal planes.

Select the spine-labeling tool by clicking on the spine label annotation button, 3 . When active, a spine
labeling control panel appears, listing the predefined vertebral and disk interspaces. To apply a label,
select the starting point from the control panel, and then click on the image to place the label. The label
automatically advances to the next label after you place each one, so left-click again to drop the next
label. To automatically advance in the opposite direction, check the box labeled Reverse Direction in the
spine labeling tool window. Continue until you are done. To skip a label, change the next label in the
pull-down list in the popup window. To toggle between vertebral labels and disk interspace labels, press
and hold the Alt key while clicking on the mouse. For disk interspaces, and when you drag vertebrae
labels away from their default location, a line appears. To display the line after you are done labeling the
image, check the box labeled Show Lines in the spine labeling tool window.

To customize the spine-labeling tool, use the Spine page in the Customize Settings window. You can set
the default starting point for both disks and interspaces, and select which one is enabled initially. You can
include or exclude L6, and define the default labeling direction. You can also modify a default label used,
and the spacing between vertebral bodies when placing the spine labels on orthogonal views. See
section 4.2.11.2 for details.

When placing the specified labels in the orthogonal images, eRAD PACS uses the label’s focus point. If
the graphic intersects the image within the defined distance from the focus point, it appears in intersecting
plane. The spine labels appear in all orthogonal images automatically, as long as the images belong to
the same Frame of Reference, as defined by the original images modality. If the Frame of Reference is
not predefined, you will have to label each of the images individually. If the focus point falls outside the
distance specified, no label appears.

The center point of the annotation is identified by the little dot next to the label. This is the focus point,
referenced when identifying the point on other images. You can add or remove a line connecting the dot
to the label by dragging the text away from its default location. To make the lines persist after exiting the
annotation mode, select Show Line in the control panel. Move the label by selecting annotation cursor
mode, and dragging the label where it needs to go. To remove a single label, select annotation cursor
mode, right-click on the label to pop up the annotation menu, and select Delete Selected. Select Delete
All from the same menu to remove the spine labels and all other annotations. To remove all spine labels,
including all the labels in intersecting planes, and leave other annotations, click Reset on the spine label
popup window.
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7 Plug-in Modules

eRAD PACS uses plug-in modules to add packages that perform specific functions. Plug-in modules are
individually licensed. When you log in and open the eRAD PACS viewer, it checks the server to see
which plug-ins are licensed. The viewer then loads the licensed modules, which may result in the
addition or modification of menus, popup windows, and toolbars. The sections below provide instructions
on using a particular plug-in module.

7.1 Multiplanar Reconstruction Plug-in

eRAD PACS supports multiplanar reconstruction (MPR) as a plug-in module. The MPR plug-in is
available for the active-X and standalone versions of the viewer. When the viewer starts, it obtains the
plug-in licenses from the server. If the viewer finds a valid license for the MPR plug-in module, it
automatically downloads and installs the plug-in on the workstation. If the MPR plug-in was installed
using one server and the user switches to an eRAD PACS server that does not contain a valid MPR plug-
in license, the viewer does not initiate the plug-in and MPR is unavailable.

Like the general eRAD PACS viewer, if a newer version of the plug-in is available, the viewer downloads
and installs the update automatically. Since a plug-in does not require a formal installation process,
Windows administrator privileges are not necessary to install or upgrade a plug-in.

MPR allows a user to create a completely artificial view of the available image data. For example, if an
axial series exists, and you wish to view the images in a coronal orientation, MPR can create the coronal
view. Additionally, you can use MPR to create a view at an oblique angle. The MPR module creates a
volume using the available data, and allows the user to select the plane o o

that cuts through the volume. The result is a series of images that the
user can view, save to the server, archive, and attach as a key image.

To create the MPR volume, load a series into the main viewer and select .
Create from the Reconstruction submenu of the Postprocessing menu at Show locaizer Ines
on the top of the eRAD PACS GUI. Use the series with the most slices —

to obtain the best results.

When you create an MPR frame, the volume is created and the image frame separates into four smaller
frames. Each frame contains a single orthogonal view (sagittal, coronal, and axial) plus an oblique angle
view. The oblique image frame is the
results window, and is represented by the
purple localizer in the coronal view. The
other three frames are control windows.

If the series is particularly large, creating
the volume may take a little time. A
progress bar appears to show you how
much additional time is needed to create
the data volume.

Using the color-coordinated localizers
(i.e., the color of the line matches the
color of the frame containing the image in
that plane), move and rotate the oblique
image. You can window and level the
image using the regular window/level
tools. The other tools are unavailable in
an MPR image frame.

Oblique (generated) view /
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When you have the results you want, export the series to EP by double-clicking on

the oblique image, or selecting Export from the Reconstruction menu. Once the  Humberosices

series is exported back to the viewer, it is available from the thumbnail panel and [

you can perform any available function on the image. From the Reconstruction S,U,aceba,wmhcaffmm]:
menu, the Export Setup item opens the exporting control panel. From this control =~ ——
panel, you can define the number of slices to include when you export the ¢ 10
regenerated series (default is 9 slices) and define the spacing you want to use ~ S&ormmese e
between the slices (default is the same as the original series). To change the
default, uncheck the box, and enter the number in the respective field. Concel_| x|

™ Adiust spacing to series

You can send exported regenerated images and series to the server to be available to other users. From
the File menu, select Send Image to Server or Send Series to Server. Once an exported image is saved
to the server, you can attach it to a report as a key image.

7.2 Basic 3D Plug-in

eRAD PACS supports basic three-dimensional image processing in the active-X version of the viewer as
a plug-in module. The basic 3D plug-in supports volume rendering, cut planes, image segmentation and
maximum intensity projection (MIP). A user can create a volume from any image series, although the
best volumes result from a large number of thin images. Basic manipulation tools are available to move,
rotate and resize the volume, alter the shading and color settings, and change the window and level
values. More advanced tools are available to change the iso-surface values, segment sections of the
image, change the view perspective and save images as a new series. Details for using these tools are
included later in this section.

eRAD PACS's basic 3D plug-in module requires certain hardware resources. The processor speed
should be greater than 2GHz and the minimum amount of RAM required to render a volume is twice the
size of the series. For example, if you have 800 CT slices at half a megabyte each — that's 512 by 512
12-bit images — you will require a minimum of 800MB of RAM (800 images x 500KB per image x 2 =
800MB). If you attempt to create a volume on a machine with insufficient processing power or memory,
eRAD PACS may display a message saying it cannot process the data. Be aware that the minimum
amount of processor or memory may lead to very poor performance. If you find your workstation
processes image volumes slowly, consider a CPU or memory upgrade.

When the viewer starts, it searches the server for the plug-in license. If a valid license exists, the viewer
automatically downloads and installs the basic 3D plug-in module on the workstation. If the plug-in was
installed using one server and the user switches to an eRAD PACS server that does not contain a valid
basic 3D plug-in license, the viewer does not initiate the plug-in and 3D tools are disabled. Like the
general eRAD PACS viewer, if a newer version of the plug-in is available, the viewer downloads and
installs the update automatically. Since a plug-in does not require a formal installation process, Windows
administrator privileges are not necessary to install or upgrade a plug-in.

To start the basic 3D plug-in module, select a series and load it into an " | Postrocessing Templaing Help
image frame. It is best to select the series with the greatest number of = [ g ™
images. Activate the plug-in by pulling down the Post-processing menu at Stitching »  Delete
the top of the eRAD PACS user interface, and chose Create from the Basic
3D submenu. The plug-in displays a progress bar as it creates the volume.
The plug-in is ready to use when the progress bar disappears and an
image appears in the image frame. If some of the images are still in transit BRGNS
to the workstation, you will see a message on the screen indicating the plug-in is waiting for them When
all the images are available, the volume gets created and the tool is ready to use.

Configure

The basic 3D plug-in does its best to handle series with images that are not equidistant or not parallel to
each other, but there are times when a stray image can prohibit the plug-in from creating the volume. If
you receive an error when creating a volume, find the problem images and remove them from the series.
(See section 5.4.1.3 for information on cutting and joining series.)
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The basic 3D plug-in frame consists of a rendered volume, a number of toolbars, presentation
information, an orientation cube and a gauge showing relative size or signal to noise ratio, depending on
the applied mode. Figure 7.2-1 shows a generic basic 3D plug-in frame.

lewel 0
window 1000
/ isosurface at-300
Presentation Rendered
information volume

Gauge

Orientation
cube _p -

f

Toolbars

4“
ﬁl"fr

g

2|[~ @lelof|| x|2|2|7]|

Figure 7.2-1 Basic 3D Plug-in Frame

Controlling the object relies on a series of settings and mouse controls. The settings are available from a
number of toolbars that appear by default around the border of the image frame.

Toolbar Function Button Description
Positioning Rotate *I“j Rotate the image volume around a center point of reference.
*
Orbit o Rotate the image volume around an external point of reference.
>
Slide @ Move the image volume up, down, left and right.
Roll ,ﬂ;;, When tumbling is enabled, roll the camera in addition to move it close
== or further away.
Display Iso surface H Adjust the dynamic range of the iso-surface curve.
Characteristics
Window/level @ Adjust the window width and center of an intersecting plane on the
image volume.
Color Modify the hue and saturation settings applied to the image volume.
Shading (= ) Modify the specula ratio and coefficient applied to the image volume.
Cut Plane Cut plane mode .-K: Set mouse controls for cut plane mode and define a cut plane.
Select plane @- Toggle between the defined planes on the image volume.
Adjust plane 7 Rotate and move the cut plane around a center point.
L
Delete plane Kﬂ Remove the selected cut plane.
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Toolbar Function Button Description
Segmentation  Segmentation Set the mouse controls for image segmentation.
mode
Region of Define a region of interest and remove everything outside of it.
interest
Range Adjust the values of the segmentation curve applied to the image
volume.
Rendering Surface shading Surface shading applied to the image volume.
Mode
MIP Maximum intensity projection applied to the image volume.
Opaque Display the image volume as a full-range image object with no shading
applied.
Projection Parallel Display the image volume using a flat two-dimensional perspective.
Mode
Perspective Display the image volume using a three-dimensional perspective.
Save Snapshot Export an image or series of images to the eRAD PACS viewer.
Reset Reset view Reset the position and zoom factors of the image volume to their

original values.

Reset cut plane

Remove the cut planes from the image volume.

Reset color

Reset the color and shading values of the image volume to their
original values.

Reset
segmentation

Restore the parts of the image removed by image segmentation.

The basic 3D controls exist in the mouse. The specific function assigned to a mouse button depends on
the cursor mode applied at the time you activate the mouse. The following table lists the possible cursor
modes and the function applied when you apply the defined action.

Mode Setting Left Mouse Center Mouse Right Mouse Left+Right Mouse
Rendering | Rotate Click Toggle Click Popup menu: preset
Mode threshold, orientation
Dbl-click | Save
image
Drag Rotate Scroll Zoom in/ | Drag Adjust display Drag Adjust
object out characteristics™ 2 distance®
Orbit Click Toggle Click Popup menu: preset
Mode threshold, orientation
Dbl-click | Save
image
Drag Shift Scroll Zoom in/ | Drag Adjust display Drag Adjust
object out characteristics™ distance
Move Click Toggle Click Popup menu: preset
Mode threshold, orientation
Dbl-click | Save
image
Drag Move Scroll Zoom in/ | Drag Adjust display Drag Adjust
object out characteristics™ 2 distance®
Roll Click Toggle Click Popup menu: preset
Mode threshold, orientation
Dbl-click | Save
image
Drag Roll Scroll Zoom in/ | Drag Adjust display Drag Adjust
4 Bl . 3
camera out characteristics distance
Cut Adjust Click Toggle Click Popup menu: preset
planes plane Mode threshold, orientation
Dbl-click | Select
plane
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Mode Setting Left Mouse Center Mouse Right Mouse Left+Right Mouse
Drag Rotate Scroll/ Advance | Drag Tilt plane Drag Advance
object Drag plane5 plane6
Define Click Toggle Click Add plane
plane Mode
Dbl-click | Select
plane
Drag Rotate Scroll Zoom in/ | Drag (Add and) position Drag Adjust
object out plane distance®
Segment- | Thresh- Click Toggle Click Popup menu: preset
ation old Mode threshold, orientation
Dbl-click | Apply
threshold
Drag Rotate Scroll Zoom in/ | Drag Adjust lower Drag Adjust
object out threshold/ISO value distance®
Region Click Toggle Click Popup menu: preset
of Mode threshold, orientation
interest’
Drag Rotate Drag Define region of
object interest
Densit Click Toggle Click Popup menu: preset
range Mode threshold, orientation
Dbl-click | Apply
threshold
Drag Rotate Scroll Adjust Drag Adjust
object range distance®
Notes

1) Adjust the iso-surface, window/level, hue/saturation or specula highlight depending on the applied display

characteristics mode.

2) The x-axis adjusts the specula ratio and the y-axis adjusts the specula coefficient.

3) Perspective mode only.

4) Rotational degree of freedom (ie, tumbling) mode only. Refer to the configuration panel for details.
5) This function (adjust cut plane via middle wheel scroll) is also available via the Up/Down arrow keys.
6) Using the scroll wheel or the UP/DOWN keys slides the cut plane in direction of its normal. The

LEFT+RIGHT button drag slides the plane relative to the camera.

Basic 3D Setup

7) Parallel mode only.

8) Mouse over the image to get the iso value at that location,
and to highlight the other iso values in the same defined
range.

The configuration panel defines the settings applied to the
basic 3D plug-in frame. These settings are saved for each
user account and get applied each time you initialize a 3D
frame. To display the configuration settings panel, select
Configure from the Basic 3D item on the Post-processing
menu. To change a setting, click to add or remove a check to
the respective checkbox, or enter a value in one of the fields.
When finished, click Done to save them.

The details of the configuration setting are listed in the table
below.

sS5D

[ Depth-shadowing in perspective projection
™ Depth-shadowing in parallel projection

V¥ Project greyscale cross-sections to cutplanes

Maouse

[ Invert axis Speed X: 250 =y oy 250 =g
Iv¥ Constrain rotation DOF ("o tumbling mode™)
Segmentation
[ -1585 [ 2274 | 233

FloodLaow FloodHigh FloodRadius
Iv¥ Flood-fill constrained by cutplanes
Misc
™ Highlight edges
Presets

Clear all | Add Facory Preset(s) |

Done |

Section Setting Description

Surface
shading (SSD)

Depth-shadowing in

perspective mode object.

When using perspective projection, apply depth shadowing to the

Depth-shadowing in
parallel mode

When using parallel projection, apply depth shadowing to the object.

Project greyscale cross-
sections to cut planes

plane.

Display a greyscale cross-section of the object on each defined cut
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Section Setting Description
Mouse Invert Y axis Toggle the rotational direction of the y-axis when dragging the mouse
forward and back.
Speed X Relative speed of the rotation along the x-axis.
Speed Y Relative speed of the rotation along the y-axis.

Constrain rotation DOF | Constrain the rotational degree of freedom. When unconstrained, you
can tumble the object while using the Roll tool.

Segmentation Flood low Lowest available density for segmentation
Flood high Highest available density for segmentation
Flood radius Tolerance level used as an offset from the current density value
Flood-fill constrained by | Include or exclude the portion of volume hidden as a result of a cut
cut planes plane when applying segmentation.

Miscellaneous Highlight edges Display the edges of the cube that defines the object.

Presets Clear all Clear all preset iso-surface threshold settings.
Add factory presets Add the factory default iso-surface thresholds to the preset list.

To save an image or series of images, use the snapshot function. The snapshot panel provides controls
to define the image size and number of images to save. Select the resolution from the Resolution menu.
If you click OK, a single image is created. Each time you save a single image using the snapshot panel,
the image is added to the same series started in this EP session.

To save a series of images, open the snapshot panel and check the

Rotation Series box. The pull-down menus activate, allowing you to —

select the direction to rotate the image (up, down, right or left), the '

number of degrees to rotate it (90, 180, or 360), and the step | & Aoonsses

increment. eRAD PACS starts with the current image, saves the | [5] i [S] 10 demess & [=] 9 degresstope
image, rotates the image in the specified direction by the degrees

defined by the step increment, and saves the next image. It continues —
until it covers the total number of degrees selected.

Cancel |

You can save a single image using the default image resolution by double-clicking on the 3D object with
the left mouse button while in any of the rending modes. When created in this manner, the basic 3D
frame deconstructs, and the image is placed in the image frame and as a thumbnail in the thumbnail
panel.

To reload an image you previously saved from the basic 3D plug-in, load the image into an image frame
and start the basic 3D plug-in by selecting Create from the menu. eRAD PACS recreates the image
volume as it existed when the image was saved, allowing you to make changes to the saved image
without having to start from the beginning again.

To save the image or series as a permanent addition to the study, you must send the captured images to
the eRAD PACS server. From the File menu, select Send Image to Server or Send Series to Server.
Note that the images may be large and it will take some time to transfer them to the server. The status
bar displays Sending Image while the images are in transit. When transferred, the status bar displays
Sent.

7.2.1 MAXIMUM INTENSITY PROJECTION

Maximum Intensity Projection (MIP) is a volume rendering technique which is used to visualize high-
intensity structures within volumetric data. At each pixel the highest data value, which is encountered
along a corresponding viewing ray, is depicted. The basic 3D plug-in module can render any volume as a
MIP image. You can rotate the MIP image as you would any other volume, making it possible to see the
projection from any orientation. You can export a MIP image or series to the main viewer, which you can
then save to the eRAD PACS server and archive.
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level 780 dia 757 mm)|

To create a MIP image, click on the MIP button, wrl, in |t

isosurface at-705

the rendering mode toolbar. When the volume is cuplanes

)

a

displayed in this mode, the window and level tools are
more applicable than the iso-surface tools. Use the
window/level tool, '#, to adjust these values. Move the
cursor left and right to adjust the window setting. Move
it forward and back to change the level setting. These
values are displayed in the top left corner of the basic
3D frame as well as in the window/level toolbar in the
main viewer.

2| Bw] s | B |2 2][miE]s

The positioning, cut plane and segmentation tools work
on MIP images as they do on a surface-shaded object.
To measure MIP objects, you must export the image to

the main viewer and use the basic measurement tools. [ %|4¢ ~[oele]| % e

7.2.2 IMAGE SEGMENTATION

In the analysis of the objects in images it is essential that we can distinguish between the objects of
interest and "the rest." One technique that is used to find the objects of interest is referred to as image
segmentation. Image segmentation is the process of separating out mutually exclusive homogeneous
regions of interest.

dia 405 mm)

The basic 3D plug-in module provides a few ways to
segment out different objects in an image. Perhaps
the most basic way is to eliminate everything not
connected to a specific object. This is a good way to
remove stabilizers or uninteresting body extremities.
You can quickly remove unwanted objects in the image
by selecting segmentation mode, #, and then double-
click on the object you want to keep. All objects in the
volume that are separated from this object (by extreme
density change such as air) are removed.

When many objects in the volume intersect, you can
define a region of interest to keep. This is more of a
manual segmentation than automatic, but it provides a
good deal of control over the total object. Click on the
segmentation ROI tool, %, and then hold down the
right-mouse button while you drag the mouse to
enclose the region you want to keep. Since you are
drawing a two dimensional region of interest on a three
dimensional object, it is best to use this tool while using
parallel projection mode. When you release the
mouse, everything outside the region of interest is
removed from the image.

[ al+%| [~ @l@le]| x|2|z|7]| =] A tool for segmenting an object out of a volume is to
define the density range to keep. To do this, click on the segmentation range tool. Place the cursor over
a single pixel. This pixel and all others that exist within the defined segmentation radius are highlighted.
Increase and decrease the defined range by scrolling the middle mouse button. When you have
highlighted the pixel values you want included in you segmented image, double-click on the image. The
basic 3D plug-in removes everything in the volume that is not within the defined pixel range.
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An alternative to image segmentation is to apply an iso-surface threshold to the image. This extracts
objects in the volume based on its iso-surface value. This function is available in most modes by holding
down the right mouse button and dragging. The iso-surface threshold appears in the top left corner of the

frame.
i Reference frame #

For a faster way to apply a threshold, use the preset threshold
settings. These are available from the popup menu that appears
when you click the right mouse button. Select Quick Thresholds to

: - : e ; Delete >
display a list of available presets. Select one and it is automatically Toolbars b Remember current...

applied to the volume. A number of factory default presets exist.
You can modify these and create you own. To create a preset
threshold, set the threshold to the value you want to save using the
right mouse drag function. Then, click the right mouse button and
select Quick Thresholds and Remember Current. In the popup text
window, enter a label for the setting and click on OK. To change an existing preset, type the label you
want to change. You will be prompted to overwrite the preset settings.

Delete
Configure

Skin CT (-300HU)
Bone CT ( 300HU)

Heart CT (-210HUI)

7.2.3 CuTt PLANES

To intersect a volume with an oblique plane, you can use the basic 3D plug-in's cut plane tool. This
feature allows you to scroll through the volume using views that are not available from a series of two-
dimensional images. You can apply multiple cut planes to a volume at the same time, alter their angle of
intersection as well as their relative position in the volume.

To create a cut plane, click on the cut plane tool, RSt

X, Since the basic 3D plug-in defines a planc |

using a two-dimensional tool, it is best to create
cut planes while in parallel mode. Place the
cursor over the image at the point where you
want to define a plane, hold down the right
mouse button and drag the mouse. A line
appears, showing you the edge of the plane. The
short perpendicular lines exist on the side of the
plane that will be hidden initially. Drag the mouse
to position the plane. When you release the
mouse, the plane is defined. Rotate the image
slightly to see the new plane. Repeat the
process to create another cut plane.

To manipulate the plane, toggle through all the
planes using the plane selection button, &. The
selected plane is highlighted by a transparent
disk that appears around the volume. To tilt the plane, click and drag the right mouse button. To scroll
through the volume as though it was a stack of image slices, scroll the mouse wheel or press and hold
both the left and right mouse button at the same time while you move the mouse forward and back. The
up and down arrow keys also scroll through the volume.

|[& =[] ~@l@o]|[X 2]zl

| |l

To remove a cut plane, select it and click the plane delete button, @. To remove all the cut planes at one
time, use the cut plane reset button, Il

7.3 Orthopedic Templating Plug-in

Digital orthopedic templating in eRAD PACS uses OrthoView™. This application has been incorporated
into a plug-in module, which is available on the active-X version of the viewer. When the viewer loads a
study, it obtains the plug-in license from the server. If the viewer finds a valid license for the orthopedic
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templating plug-in module, and the user is assigned one of the available OrthoView user licenses, it
automatically downloads and installs the plug-in on the workstation.

If OrthoView is not installed, eRAD PACS prompts the user to download and install it. Installing this
application requires Windows administrator privileges. The OrthoView application is large, and will take a
while to download. When the download completes, follow the instructions on the screen to complete the
installation.

In general, within the eRAD PACS viewer, if a newer version of a plug-in is available, the viewer
downloads and installs the update automatically. This is not true for updates of the OrthoView
application. To update a version of OrthoView, you must remove the package from the Windows control
panel. Select Add or Remove Programs, find the OrthoView application, and click on Remove. When it
has been deleted, you are prompted to install the updated version the next time you load a study into the
EP viewer.

To initiate a templating session, load a study into the main viewer, click on the ;mmﬂg\ﬁjﬂmg 20
Planning

Templating menu at the top of the screen, and select Planning. If you want to load ———F rawing s

multiple images into OrthoView, load them all into a single image frame and select N

Planning (stack) from the Templating menu. The OrthoView application displays a
splash plate on the screen as it loads the application, device templates, and other
information. When loaded, the OrthoView application appears on top of the eRAD PACS viewer.

To initiate the templating process, select a procedure from step one. A list of available device templates
appears in step two. Select the digital templates from those listed. The image(s) you loaded into
OrthoView appear in step 3. Select the image you want and click the Open Selected X-rays button near
the top of the screen.

8 OrthoView

Fila Panel Window Help Userijim | Server :http:/fhelen, eradi
[ eraminaten |5/ pemosecono-se e )| |
[ Scaling l Plannin: g l Templating ] Pelvis [R + AP] E]E] Templating
‘D |1D |ZD ‘]D ‘4D ‘SD ‘SD |7D |ED ‘QD ‘1DD ‘11\} ‘1ZD|1]D|14D|15D ‘16\} ‘17\} ‘IED|19I}|ZDD|ZID|ZZD ‘Z]D ‘ZleZSD |ZBI}|Z7D|Z&D|Z§D ‘]DD ‘llDllll
| || B o] <[o[4[=[am][o][]
Templat:
[E] shell
Stern
is Selector
OrthoView Generic
Orthopaadic Digital Imaging Acetabular Cup
rCup si rSocket si
40 l 28
5 42 EQ ]
ISEEELOn &-Template MUST NOT be used for orthepaedic templating. - 44 l 32z
SEh -
48 =
30 LY.
OrthoView Generic
Orthopaadic Digital Imaging Femoral Stem
rSi roffset
[1 | |[sratt ]
2 Medium
3 Large
a
E]
Head diameter rHead length
|-zs |-3 |
30 Standard
32 +3

The templating process is a repeated sequence of scaling, planning, and templating. Scaling involves
defining the linear dimensions of the image so OrthoView can properly size the prosthetic device. Using
the scaling tool, define the linear range and assign the dimension to it. You need to establish the
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oversize percentage of the joint before you can move on to the planning stage. After scaling the image,
OrthoView automatically calculates an oversize percentage. Accept it or change it manually.

The planning phase is an optional step that assists you in selecting the correct size prosthesis. Start by
selecting the components you want to include in the planning phase, such as the Stem for a hip
prosthesis, and fit them to the area on the image. Use the left mouse button to drag the different parts of
the template around the image until they are properly positioned. At this point, move on to the templating
phase.

Whether you implemented the planning phase or jumped right to the
templating phase, select the template components you intend to use,
such as Stem for a hip prosthesis, and then select the parameters of
each component. The digital template appears on the image. Using
the left mouse button, drag the template around to place it properly
over the image. When you have the correct device properly defined
and positioned, you can complete the templating process by clicking
on Finish. At this point, a summary report appears, listing the details
of the process, including the user details, operation details, planning
results, prosthesis selection details, and other relevant information.

Orthoview™ Templating Report
Report Date: gl 26, 2005

Patient Details
0
User Details
Heport Generated by:  jm

Operation Details
Procedure planned: Tatal hip replacement
Procedurs Side: Right

Planning Results

To finalize the templating process, you need to save your results.
Two options exist. If you chose to save a work in progress, click on
the Save Session button. This saves the current state of the
templating process. If you load this study into OrthoView at a later
time, you start where you were when you clicked on Save Session. A
more permanent save option exists from the Commit button. When
you save the results of your session using the Commit function, you cannot make further changes to the
results. The generated report may be exported to eRAD PACS and attached as a key image to the
study’s report.

Prostheses Selected

EF

Generie Acetabular Cup System

For further detailed instructions on using OrthoView, consult the OrthoView user's manual. It is available
from the Help menu at the top of the OrthoView application window or by hitting the F1 function key. Use
the Index tab to view an alphabetical view of help topics. Alternatively, to locate specific information, use
the Search tab.

7.3.1 INSTALLING ORTHOPEDIC TEMPLATES

OrthoView is supplied with generic training templates, which are not for medical use. To use OrthoView
for planning orthopedic procedures you need to obtain and install templates for the prostheses you use in
surgery. The manufacturers of prostheses require that their templates are only supplied to registered
OrthoView users. Because of this, we are only able to supply templates to people who have a valid
OrthoView registration number.

To request templates as a registered user

Open your Internet browser.

Enter http://www.orthoview.com.

On the your account menu, click login.

In the Username box, enter your user name.

In the Password box, enter the password you provided when you registered.

On the your account overview page, click Request Templates or on the your account menu, click
Request Templates.

To request templates, complete the online form and click Send.

When you have finished, click Log Off.

OO WNPEF

o0~
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When your request is authorized, you will be sent an e-mail informing you that the templates are available
to download. Occasionally, templates might not yet be available from your requested orthopedic
manufacturer. In this scenario, we will ask you to contact the relevant manufacturer.

Upon receipt of an e-mail notification, go to the OrthoView web site (www.orthoview.com), so that you can
download the template(s). For information on how to download the template(s), follow the online
instructions.

To install Templates

Download the templates to a location on your computer.

Navigate to the location, on your machine, where you downloaded the templates.

Double-click a template.

Click Next to confirm your selection and to install the template.

When the installation is complete, click Finished. You can then either install more templates or start
using them in OrthoView.

abrhwNBE

When you receive templates, they are registered to your registration number. The templates install
themselves to your OrthoView templates directory (C:\Program Files\Orthoview\PracticeBuilder\
Templates) and are available to use next time OrthoView is started.

7.4 AVI Plug-in Module

eRAD PACS creates audio video interleaved (AVI) images via a plug-in module. The AVI plug-in is
available for the active-X version of the viewer. When the viewer starts, it automatically downloads and
installs the plug-in on the workstation. If the AVI plug-in was installed using one server and the user
switches to an eRAD PACS server that does not contain a valid AVI plug-in license, the viewer does not
initiate the plug-in and AVI creation is unavailable.

Like the general eRAD PACS viewer, if a newer version of the plug-in is available, the viewer downloads
and installs the update automatically. Since eRAD PACS plug-in modules do not require a formal
installation process, Windows administrator privileges are not necessary to install or upgrade it.

AVI allows a user to create a movie from the available image data. If the series does not contain a
recommended frame rate, the plug-in module prompts the user to enter one. The images are then
converted into an AVI file that the viewer can play back at the specified frame rate. Unlike the results of
other post-processing plug-in modules, AVI objects cannot be annotated, saved to the server, or attached
as a key image.

n |Enstprncessing Help
~—  BasiciD
IMask. Subtraction Flugin

To create an AVI object, load the selected series into an available image
frame. If you want to combine multiple series into a single AVI object,
concatenate (Ctrl-drag) the additional thumbnail series into the image
frame. From the Postprocessing menu, select AVI Player, and then
Create. The plug-in prompts you to confirm the applied frame rate. Enter
the value in the popup window and click on Continue. A progress bar
appears indicating when the process will complete. On large data sets, it
could take a couple of minutes to create an AVI object. When the
process is complete, the AVI object appears in the frame.

Create
Delete
Save as

Configure

Flay
Stop

Previous Frame
Mext Frame

Zoom 1:2
Zoorm 1:1
Zoom 2:1
Fit ko Window

The AVI plug-in plays the image back at the defined frame rate.
Frequently used tools are displayed in a toolbar
at the bottom of the AVI frame. These and
other tools are also available in the AVI Player

Time information E

Half Speed
Mormal Speed

e submenu from the Postprocessing menu. Frame rate 0 fps
Tools include buttons to start, pause and stop the playback. When the :
playback is paused or stopped, you can manually advance the AVI image by

dragging the progression bar or by clicking on the next and previous frame
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buttons on either end of the
progression bar. The applied frame
rate is displayed on the toolbar as well.
From the AVI Player submenu, you
can apply a zoom factor to the AVI
images.

AVI images cannot be exported back
to the viewer, meaning they cannot be
stored on the eRAD PACS server.
You will have to recreate the AVI
object each time you want to display it.
You can save the AVI file to the local
workstation as an AVI file. Use the
Save As item on the AVI Player
submenu to bring up a Windows panel
to select a folder in which to save the
data.

The AVI plug-in configuration panel is
available from the AVI Player menu in
the Postprocessing pull-down menu at
the top of the viewer. Click on
Configure to pop up the configuration

window. The AVI configuration allows you to define a default frame rate to use when the series does not
contain a recommended value and to override the recommended frame rate when one is defined.

Setting Description
Override recommended | When checked, the defined default will be
display rate proposed for all series. Disabled by default.

Default frame rate

The default frame rate (frames/sec) to propose
when no recommended frame rate exists, or
Override Recommended Display Rate is enabled.

Select codec

Select the preferred codec to use for creating the
AVI images. The list comes from the codecs
available to Windows on the workstation.
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8 Reports

eRAD PACS includes reporting functions that enable a user to record a text or dictated report or
addendum, and to attach selected images to a report along with their presentation state. Existing reports
from prior studies are available for display from the viewer. A user also can create an addendum to a
report.

Two report panels exist as described in section 3.6.3. The full report panel includes the patient and
procedure information, the report text, and the key images, amongst other details that make it useful for
reviewing information about prior studies. The compact version of the report panel is better suited for
dictating a report or addendum. The compact report panel contains some basic study identification
information plus controls for recording a voice clip. You can configure eRAD PACS to default to one
report panel or the other from the Customize Settings’ Settings window.

Since the report panel is customizable, yours may appear with more or less information than this manual
describes. The default report panel contains a report state (empty, preliminary or final), patient and
procedure information such as the patient name, date of exam and the order number, report information
such as the name of the radiologist who generated the report and the date, the report text, addendums,
key images, a number of buttons and the study status. The functions assigned to the various buttons on
the report panel are as follows:

e e P e d Button Description
== =i St S B2 S Compact/Full  Toggle between the compact report panel
Sees R— m‘:‘:“'“"“'"“"" — and the full report panel.
o L A Dazisa. 198 M5 wwmessl|l  Send Report  Submit the report to the eRAD PACS
| x'.“ﬂf.?;-'fm‘f.‘.'g‘;'s‘.f;é’.“‘ 5 server.
b el | Ben o Reload Report Erase all the changes and restore the
: = — original report.
| Restore saved If you previously saved a report to your
I A — ausERvATION Woris:8 Chars: 0 report local workstation (using the Save to hard
“ Unewed ' disk option in the Report menu), read it
iged from disk and load it in this report panel.
D Dictation/Listen Play back the dictation for this report
i component. A Listen button exists for the

main report and for each addendum.

IMPHESEION Woeds: 0 Chars: 0

Status buttons  Set the study status to the selected state.
In a Final report, only the last addendum

; lelal % L || 2] sl wlolals] Tima) has an active Status button section.

The report panel contains an audio toolbar, an annotation toolbar and a formatting toolbar. These
toolbars are described in detail in section 3.1.

The following sections contains information on opening prior reports, creating text and recorded reports,
attaching key images, and submitting the changes to the eRAD PACS server.

8.1 Displaying Reports

When eRAD PACS loads a study into the viewer, it includes the report if the server has a copy. Reports
for prior exams could come from one of many sources. A user can enter it directly from the eRAD PACS
viewer. The report could be transcribed into eRAD PACS from the report editing web page. Reports
created from third-party devices such as a Radiology Information System (RIS) can be imported into
eRAD PACS as well. Once the server has the report data, it makes it available in the viewer’'s report
panel.
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To display the prior report, open the full report panel by clicking the report button, €, from the toolbox
toolbar. If you have more than one study loaded into the viewer, the report panel displays the report that
corresponds to the selected image. If no images are loaded into the main viewing area and no image
frame is selected, the report panel displays the report of the first study listed in the thumbnail panel.

8.2 Creating a Report

Before you can create a report in eRAD PACS, you must possess reporting privileges. Creating a report
includes entering text or a recording, plus attaching a key image or even changing the study state. If the
report panel does not contain editable fields, you are not authorized to save report text, dictation or key
images to the eRAD PACS server. Speak with your system administrator if you need to change the
settings on your account.

When you want to create a report, start by selecting an image in the study. Click on an image frame or a
thumbnail image. This informs eRAD PACS which study you want to edit. To create the report, open the
report panel by clicking on the Report button, €, in the toolbox toolbar. If you press the Record button on
a Philips Speechmike, you will open the compact report panel.

A report can consist of an observation, an impression, addendums, key images, and the voice recordings.
Only one of these components is needed to make up a report, although a report can consist of all of
them. Creating an observation, impression, addendum and a dictation are described in the following
sections. Attaching key images is described in section 8.3.

8.2.1 TEXT REPORTS

The fields available for entering a text report exist only in the full report panel. The default report format
consists of an observation section and an impression section. eRAD PACS does not apply any
restrictions to the use of these fields other than they will remain separate, both in the viewer, and from the
eRAD PACS web page report. To enter text into either of these fields, click in the window and type your
report.

The Notes section of the report panel contains radiologist notes. The text in this field is entered by and
displayed for users with report editing privileges. All other users, typically referring physicians,
technologists, and administrators, do not have access to the contents of the Notes field. The purpose of
this field is for users to submit comments to the radiologist. If a note exists and the Impression and
Observation fields are empty, the note automatically pops up when the study is loaded into the viewer. To
govern this popup, check or clear the Show Report Note on the Settings page in Customize Settings.
Notes are retained in the eRAD PACS database and can be edited any time prior to signing the report.

8.2.1.1 Formatted Text

eRAD PACS supports some basic text reporting functions, including font type and size, bold, italics,
underlines, color, alignment and bullets. Like most word processors, you can apply the text formats as
you type or afterwards. To apply a specific text format characteristic, select the tool from the report
formatting toolbar or from the Format menu at the top of the full report panel. To turn off the formatting
control, select the tool again. To change the default font, open the Format menu, select Default Font, and
choose from the available fonts. For a detailed description of the formatting tools, refer to the report
formatting toolbar section, 3.1.9.

8.2.1.2 Spell Checking

To use the spell checker, click to select the section of the report (i.e., Notes, Impression, Observation or
Addendum) you want to check. Then click on the spell check button on the report formatting toolbar or
from the Format menu in the full report panel. A popup window appears. In this window is the first word
that needs correcting plus a number of suggestions. You can click on the Change button to replace the
misspelled word with the highlighted suggestion. The Change All button changes all occurrences of the
misspelled word. Another option is to ignore this instance (Ignore button) or all instances (Ignore All
button) of the word. If you want to add the word to your dictionary, click on Add. When done checking
the text, click Cancel to close the spell checking window.
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If you have not installed the eRAD PACS spell checker,
you will be prompted to do so when you first load the
viewer. Note that this process installs an application on

Mot in Dictionary:

|vascu|alu

Suggestions:

your PC, which means you must have Windows
administrator privileges on your workstation if the install

Add words to: Add

is to work. If you do not have Windows administrator [corentt 3

L. L. carrect - Sy
privileges, contact your local PACS administrator. =L e [ |C#‘t|
When you agree to install the spell checking < A

application, it will download and self install. When it is done, you are ready to use the spell checking
function.

To use the spell checking function from the eRAD PACS web-based report edit page, you must have
previously installed the eRAD PACS viewer and the spell checker plug-in module. The EP viewer must
also be running in standby mode at all times.

8.2.1.3 Normality Flag

The normality flag allows a user to tag a report as high priority. When the normality flag is set, the study
containing the report appears normal on the worklist. To highlight the worklist entry, clear the normality
flag on the report panel. The normality flag, if displayed, appears immediately above the Observation text
field.

The presence and label of the normality flag on the report panel is configurable.
editable by the system admin.
more details.

It is a server setting,
Refer to the Server Configuration section of the Operator’'s Manual for

8.2.1.4 BIRAD Values

BIRAD values can be assigned to a study in the report, but are only displayed for mammography images.
To assign a BIRAD value to a report, open the Report panel and use the drop down box beside the
Radiologist field at the top of the report to
select a value. Accepted values are n/a, 0,
1,2,3,4,4a,4b, 4c, 5, and 6.

Radiologist: | ~ Bl RADS: nja ~

These values are available from the worklist as well, allowing a user to search for studies with a defined
BIRAD value.

8.2.1.5 Report Panel Keyboard Shortcuts

The report panel supports various keyboard shortcuts to activate specific formatting functions. The eRAD
PACS shortcuts operate only within eRAD PACS viewer, and may be in conflict with hot keys employed
by other application installed on your PC.

Home Go to beginning of text box Up Arrow Move up one line

End Go to end of text box Down Arrow Move down one line

Page Up Page up Insert Toggle Insert/Overwrite mode
Page Down Page down Delete Delete selected text

Ctrl-Z Undo (text editor) Ctrl-U Underline (text editor)

Ctrl-X Cut (text editor) Ctrl-A Select all text (text editor)
Ctrl-C Copy (text editor) Ctrl-F Find (text editor)

Ctrl-v Paste (text editor) F3 Find next (text editor)

Ctrl-B Bold (text editor) Ctrl-H Replace (text editor)

Ctrl-l Italic (text editor) Del Delete (text editor)
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8.2.2 CANNED REPORT TEMPLATES

Create a collection of predefined reports and apply them in place of dictating a report or typing a custom
report. Each report template belongs to a user’s profile, meaning it can be customized to each user’'s
preference and is available from any eRAD PACS workstation. The administrator can copy canned report
templates from one account another, after which the new user can further customize the report template.

The report text, state and flag settings do not have to be saved as a single entity. When saving a canned
report template, the user can specify which fields are affected, and then combine multiple templates to
compose a single report. The individual fields making up a report template are note, status, normality flag,
observation, and impression. To save a report template, follow these steps:

1. Open the Full Report panel.

2. Select Template/Edit. The report panel changes to the report template window, enabling only the
fields that can be saved in a report template.

3. Enter text into the fields to be saved in the report template.

4. Check the Overwrite checkbox for the fields you wish to replace when importing the canned
report template. If the Overwrite checkbox is unchecked, the contents in that field will be
concatenated to any existing contents when importing the canned report template. Check the
Overwrite checkbox in the status field to replace the status with that of the template.

5. Select Report Template/Save.

6. Enter the name of the canned report template.

7. Click Save.

When you want to apply a canned report to a study, open the report panel in the eRAD PACS viewer, pull
down the Template menu, and select Load. From the list of saved report templates, select the one you
want to apply. eRAD PACS downloads the report from the server and enters the text into the respective
fields. At this point, edit the text as needed.

8.2.3 DICTATION

eRAD PACS records dictations in the viewer using any Windows compatible microphone and sound card.
Follow the manufacturer’s installation instructions for these components before attempting to record a
report in eRAD PACS.

The recording controls are located in the Audio toolbar, which you can attach to the report panel by
selecting Audio Controls from the View menu in the report panel. The recording controls contain a
play/stop button, and record button and a delete button. There is also a progress gauge showing you
where in the current recording you are.

Start recording a dictation by selecting the Record button on the Audio Toolbar, or from the Audio menu.
When you have finished recording, click on the Stop button. Play back the dictation by rewinding it to the
beginning of the recording and pressing the Play button. Use the speed control gauge on the Audio
toolbar to adjust the speed of the playback.

Playback speed control gauge
: A/ y p gaug
‘ plolp(l _‘l_ | 3 _I“\ 1.00

If multiple editable studies are loaded in the viewer when you start dictating, eRAD PACS prompts you to
select the report you want to dictate. The popup window is displayed below. By default, the system
chooses the report that corresponds to the selected image. Select the study you want to dictate and click
OK. To disable the study selection prompt, deselect Enable Dictated Study List in the Customize
Settings’ Settings page. When disabled, dictation applies to the study that includes the image in the
selected image frame.
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Patient Name Patient ID Study Date Modality Accession No. Description Body Part Report Status
o Bob, Billy 12345 Aug 16, 2004 16:56:15 oT 320028 Pathology Slides Unviewed
 Bob, Billy. Dr.. Jr. 51344 Jan 30, 2003 oT 003694 Pathology Slides Final

You can remove part of a recording by positioning the locator at the start of the unwanted section and
clicking on the Delete button in the Audio Toolbar. The entire recording from the present location to the
end will be deleted. eRAD PACS does not support removing just a section in the middle of a recording.
Deleting removes everything to the end of the report. Modifying a middle section must be done through
inserting verbal instructions into the voice stream, indicating the start and end of the section to purge.

It is not possible to delete any part if the report component (observation, impression or addendum) has
been approved and is in the Final state.

8.2.3.1 Philips SpeechMike™ Support

The eRAD PACS viewer supports tighter integration with the Philips SpeechMike than it does for other
microphones. Install the SpeechMike device according to its instructions, and then restart the viewer.
When installed, you can use the SpeechMike for recording dictations. Figure 8.2.2.1-1 shows the
SpeechMike and the buttons available from eRAD PACS.

The SpeechMike has two functional modes. By
default, the device is used to adjust the current

position in the recording (rewind, fast forward) and EOL\ k_,_,_ RECORD
to play back the recording. When in this mode, the

indicator light is off. When the SpeechMike is NS —d‘v’.-' Q,—|NS/OVWR
activated, the indicator light turns on, the compact

report window appears on the screen, and the >ll

device is ready to record a dictation. Toggle
between the two modes by pressing the Record
button.

To start recording, press the Record button to

activate the SpeechMike, then the Play button to .
start recording, and speak. To stop recording, press _«&" -
the Play button again. Depending on the state of *
the Keep SpeechMike Active setting in the
customize settings window, pressing the Play button

will either return to Pause mode, or disable the
SpeechMike.

Figure 8.2.2.1-1 Philips SpeechMike™

To add to an existing dictation, press the Play button to append the voice to the existing recording. If you
select Rewind or Fast Forward, you can reposition the starting point for recording more data.

If your SpeechMike’s control mode setting is Persistent, the SpeechMike controls are as follows:

Button Condition Action
EOL Button not used
RECORD Record until released
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Button Condition Action
INS/OVWR _ Delete remainder of dictation: No Insert audio
Delete remainder of dictation: Yes Overwrite audio from current position to end
<< Rewind mode: Steps, press and release Rewind for configured Step Time
Rewind mode: Steps, press and hold Rewind to beginning of recording
Rewind mode: Continuous Rewind until released
>|| Play recording from current position
>> Fast forward mode: Steps, press and release Fast forward for configured Step Time
Fast forward mode: Steps, press and hold Fast forward to beginning of recording
Fast forward mode: Continuous Fast forward until released

If your SpeechMike’s control mode setting is State-based, the SpeechMike controls are as follows:

Button Start Mode Condition Action
EOL Not Button not used by eRAD PACS
applicable
RECORD OFF Enter PAUSE mode
PAUSE Turn SpeechMike OFF
RECORDING Keep SpeechMike Active is disabled Turn SpeechMike OFF
Keep SpeechMike Active is enabled Enter PAUSE mode
INS/JOVWR  Any Delete from current position to end
RECORDING _ Delete remainder of dictation: No Insert audio
Delete remainder of dictation: Yes Overwrite audio from current position to
end
<< Any Rewind mode: Steps, press and release Rewind for configured Step Time
Any Rewind mode: Steps, press and hold Rewind to beginning of recording
Rewind mode: Continuous Rewind until released
> OFF Play dictation from current location
PLAY Stop playing dictation
PAUSE Enter RECORDING mode and record
RECORDING Keep SpeechMike Active is disabled Turn SpeechMike OFF
Keep SpeechMike Active is enabled Enter PAUSE mode
>> Any Fast forward mode: Steps, press and Fast forward for configured Step Time
release
Any Fast forward mode: Steps, press and hold  Fast forward to beginning of recording
Fast forward mode: Continuous Fast forward until released

If you need audible feedback to know what mode the SpeechMike is in, check the SpeechMike Button
Click and SpeechMike Pause Click boxes in the Settings page of the customize settings window. When
the button click setting is enabled, each time you press a button on the SpeechMike, you hear a soft click.
When the pause click setting is enabled, a click is sounded every two seconds while the SpeechMike is in
pause mode. The click sound continues until you either start recording or disable the SpeechMike.

The assigned clicking sound and volume is managed by Windows. By default, the click sound is
start.wav. To change the click sound file, click on the Windows Start button, select Settings and then
Control Panel. Double click on Sounds or Sounds and Audio Devices, depending on the version of
Windows you have loaded. Select the Sounds tab. In the Program Events list, find the Windows event
for the SpeechMike and select it. The Sounds list activates. Select any of the available sound files, of
select Browse to load a custom sound file. When you've selected the sound file, click on OK to save.

8.2.4 SPEECH RECOGNITION

Speech recognition (SR) is the function of converting spoken language into editable text without manual
transcription. Instead of using a keyboard to type text into an editor package, the user talks and the
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words appear in the text area. The converted text has the same properties as text entered manually into
eRAD PACS, whether it was from the viewer’s report panel, the transcriptionist’s report panel, or the RIS.

eRAD PACS provides optional embedded SR support, where the SR tools are integrated into EP’s basic
reporting function. The embedded SR functions are described in section 8.2.4.1.

For users running a third party SR application on the workstation, learning a new SR application may be
inconvenient. eRAD PACS includes an optional interface to Dictaphone’s Powerscribe application as an
alternative to its embedded solution. This interface is described in section 8.2.4.2.

8.2.4.1 Embedded Dragon Naturally Speaking

The embedded speech recognition (SR) package provides integrated speech-to-text conversion tools in
the eRAD PACS viewer. Although the toolset is similar to dictation, SR automatically converts the user’s
statements into text and inserts them in the report panel. The user can review the text, edit it and format it
prior to submitting it.

eRAD PACS embedded SR package is provided as an optional plug-in module. It requires a plug-in
module license, plus a licensed copy of Dragon Naturally Speaking (DNS) installed on each workstation.
The embedded SR package is intended to be used with a Philips SpeechMike. Other microphones are
supported, but the integrated controls are only available on the SpeechMike.

To configure the EP viewer to use embedded SR, 0pen the e || s | | b e |
Customize Setting window from the Settings menu, and click on | aspstssecchfesogmion [ Ditatone P e

the Speech Recognition tab. If the Dragon Naturally Speaking R - %,W
option is available, it means the license has been installed on the L

server, and a valid copy of Dragon exists on your workstation. kSt e Gy i —
X . .y " Nore ownload Yoice Commands
Select it, and click on OK to set the embedded speech recognition | & i Feseiee —Dormontioes ot |

@ Dragon NatualbSpeaking IR

as your default report recording tool.
I~ Auts Record WiV when dictating & while dictating

~
I~ Show Full report panel after dictating Always

When using SR, it is possible to retain a copy of the WAV file
created when dictating the report. This would be unnecessary if
the user is responsible for editing the resulting text. However, if the
results of the SR processing need editing by a third party, such as
by a transcriptionist, save the original recording for validation.
Check the box labeled Auto record WAV when dictating to save the
WAV file.

0K I Cancel Reset All

When Dragon Naturally Speaking is selected as the default dictation mode, Ielp | speech Recognition
the Speech Recognition menu appears at the top of the EP viewer. Thisis ——

the where you will find all the Dragon controls and tools. For detailed e
information on each of these tools, refer to the Dragon Naturally Speaking
user manuals. Open User
MNew User
Menu Item Description Trzellesr
User Displays the current user account name
- - . Manage Users
Microphone Enable/disable the microphone
Open User Open an existing user account Audio Setup Wizard
New User Create a new user account General Training
Close User Close the current user account LElans
Roaming User Options  Set up roaming user configuration e
Manage Users Edit DNS user accounts My Commands
Audio Setup Wizard Set up the microphone and sound controller
. - Accuracy Center
General Training Train DNS to understand speech patterns L
- N .. Recognition History
Train Words Train DNS to understand specific words
Vocabulary Editor Add and edit the DNS dictionary Options
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Menu Item Description
My Commands Add and edit custom commands, including EP
commands

Accuracy Center

Tools to help you improve how DNS hears and

understands what you say

Recognition History

Display most recently used words recognized by DNS

Option

Set DNS options

eRAD PACS has integrated a set of voice commands specific to the features available in the EP viewer.
These commands must be downloaded from the eRAD PACS server and uploaded into the Dragon
vocabulary. The available EP-specific commands are given in the following table.

Voice Command

Description

Comments

approve Approve a report and set state to

Final
bold font Set selected text to bold font Applies to selected text only
close study Close the current study Leaves the viewer open
close views Close the image views

compact report panel

Display the compact report panel

customize settings

Open Customize Settings window

end dictation

End the dictation and disable the
microphone

end study End the current viewer session
exit from viewer Close the study and the viewer
fit image Set image zoom to fit-to-window Requires a selected image frame
focus to addendum | impression | | Set cursor focus to the report's | Available with the full report panel is
note | observation Addendum, Impression, Note or | open
Observation field
full report Display the full report panel
full screen Display selected image in Full | Requires a selected image frame
Screen mode
help contents Pop up the Help window
hide report panel Close the compact or full report

panel

invert image Invert the selected image’s greyscale | Requires a selected image frame
setting

italic font Set selected text to italics font Applies to selected text only

layout manager Display the layout manager

next frame Scroll to the next image Requires a selected image frame

OK Select the OK button Available when the close prompt

notice is displayed

open next study

Open the next study on the worklist

open previous study

Open the previous study on the
worklist

overlays Showr/hide overlays

play cine Start recursive cine mode Requires a selected image frame
previous frame Scroll to the previous image Requires a selected image frame
record Start recording dictation

record stop

Stop recording dictation

report templates

Set focus to the report templates
toolbar

Available if the full report panel is
open and it has the report templates
toolbar displayed

reset image size | orientation | | Reset the selected image's size, | Requires a selected image frame
position orientation, or position
reset window level Reset the  selected image’s | Requires a selected image frame

window/level setting

send report

Send the report to the server
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Voice Command Description Comments
set state read | dictated | preliminary | Set the study state to Read,
| final Dictated, Preliminary or Final
show hash marks Display hash marks on all images
show localizers Display localizer lines on all images
show report panel Display the default report panel
stop cine Stop recursive cine mode Requires a selected image frame
underline font Set the selected text to underline font | Applies to selected text only

To download the commands, follow the following steps.

Step 1 Open the Customize Settings window from the Settings menu, and select the Speech
Recognition tab.

Step 2 Click the button labeled Download Voice Commands. A popup window appears describing the
install process. Click OK. A window appears allowing you to select where to save the file you are
about to download. Select the folder, or choose Desktop, and click Save.

Step 3 After the file transfer completes, click on the Speech Recognition menu at the top of the EP
viewer, and select My Commands. This starts the DNS command browser.

Step 4 In the DNS Command Browser window, click the Manage button

Step 5 Click on the Import button. From the Windows browse window, find the folder where you saved
the command file in step 2, select the file (you may need to change the File Type to show All
Files) and click Open.

Step 6 Click Yes to validate the command file.

Step 7 If you want to remove some of the EP commands, uncheck the ones you want to exclude. When
ready, click on Import to import the remaining commands.

Step 8 Close the DNS Command Browser when you are done.

8.2.4.2 Dictaphone Powerscribe

Dictaphone Powerscribe users can use their speech recognition application with eRAD PACS viewers.
The interface between the two applications is performed by the Dictaphone PACS Bridge, an application
included with your Powerscribe package. Consult the Powerscribe documentation for information on
setting up PACS Bridge.

To configure the EP viewer to use Powerscribe as the default dictation mode, the eRAD PACS
Powerscribe plug-in module must be licensed, it must be downloaded onto each workstation, and
Dictaphone’s PACS Bridge must be installed and running on each workstation. Set the dictation mode to
Powerscribe by opening the Customize Settings window from the Settings menu in the EP viewer. Click
the Speech Recognition tab. If the plug-in license exists on the server, and PACS Bridge is installed on
the workstation, the Dictaphone Powerscribe option is available. Select it to set Powerscribe as your
default dictation mode.

Confirm your user account and password. By default, the eRAD PACS account ID and password are
used. If these do not match your Powerscribe ID and password, set them to their correct value.

Dictaphone PACS Bridge looks for control files in a folder on the workstation. The default location is
C:\Dictaphone. If your PACS Bridge is not activating Powerscribe, or the default setting has been
changed, set the correct folder in the XML File field in the Dictaphone Powerscribe section of the window.
The file name, study.xml, should not be changed.

When all the settings are made, click on OK to save them. Record button
DEBBIE, LITZLE - Oct 17, 2001 -

With Dictaphone PACS Bridge running and the EP viewer
configured to use Powerscribe as the default dictation mode,
users can activate Powerscribe by clicking on the Record
button in the EP viewer. The Record button can be found on  [Unviewsd =] Serdieport | | Ful |
the Audio toolbar, which can be docked to the Full report

-
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panel. The Compact report panel can be docked to the main viewer so it is more easily available. The
accession number of the selected study is passed to PACS Bridge. If Powerscribe contains an order for
the same procedure, the order is opened automatically. Powerscribe audibly notifies the user when no
order for the selected study exists.

When you head the two beeps from Powerscribe indicating it is recording, start dictating. When finished,
press the Done button on the Powerscribe microphone to pop up the Powerscribe user interface. When
you finish with the report, close the Powerscribe user interface. Control returns to eRAD PACS viewer.
Set the appropriate study state, send the report, and close the study.

The report created by Powerscribe does not appear in the EP viewer report panel immediately.
Powerscribe sends the report to eRAD PACS, or to the RIS which then sends it to eRAD PACS. To see
the report text in the viewer, you must reload the study after the PACS processes it. The study state on
the eRAD PACS viewer may change from what you set it to when it receives the report from Powerscribe
or the RIS.

8.2.5 ADDENDUMS

You can correct or modify uneditable (Final) reports from the report panel by attaching an addendum to
the report. If a report or an addendum is unapproved, you can modify the report. When a study is in the
Final state, the approved text and dictation are not editable and a new addendum section appears at the
bottom of the report panel, after the original observation and impression text and other addendums, if
present. Enter the addendum as you would for the initial report. Click on the Record button to dictate an
addendum, or enter text into the editable text field on the full report panel to type an addendum.

To play back an addendum’s dictation, open the full report panel, scroll down to the addendum section,
and click on the Listen button.

8.2.6 RESTORING A REPORT

eRAD PACS provides two methods for restoring a report. The first method is to restore the report with
the version that is presently stored on the eRAD PACS server. Provided you have not saved any
changes, click on the Reload Report button in the full report panel. eRAD PACS retrieves the last stored
report from the server.

After creating a report, it is possible to encounter problems when you attempt to save it to the eRAD
PACS server. For example, while reading the study and creating a report, the network between your
workstation and the server may have gone away. Another example is when another user forced eRAD
PACS to remove the write permissions from your session, and you were not notified. To save your work,
you can make a temporary copy of the report on your local workstation’s disk, and restore it at a later time
S0 you can submit it to the eRAD PACS server. To save a report to your workstation, select Save to hard
disk from the report panel’s Report menu. To restore it, open the study from the worklist at a later time,
open the full report panel, and click on Restore saved report. The text, dictation, key images and study
state you previously saved are loaded into the report panel. You can now submit it to the server using
Send report.

8.3 Key images

In eRAD PACS, you save the presentation state of a rendered image by making it a key image and
attaching it to a report. Key images selected for a particular study are displayed in the full report panel.
To display the full report panel, select Report Panel from the View menu, or press the F8 function key.
The key images, rendered in their saved window/level settings and with the saved annotations, appear at
the bottom of the report.

eRAD PACS indicates an image has been marked as a key image by displaying a key image icon in the

top left corner of the image when it is displayed in an image frame. Clicking on the icon opens the report
panel and displays the image attached to the report.
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The viewer contains two key image icons: a paper clip and a key. A paper clip icon, ¥, denotes that a
particular image is attached to the report and viewable on the report panel. The key icon, T, indicates
that the marked image is rendered using the same display characteristics (window/level, annotation, etc.)
as the image attached to the report. These icons allow the user to discriminate between multiple
instances of the same images attached to a report, each with a different set of parameters.

8.3.1 ATTACHING KEY IMAGES
To save the presentation state of an image in the main viewing area, select the image when the cursor is

in key image mode. To select the cursor mode, click on the key image button, E, in the toolbox toolbar.
The cursor changes to a paper clip. Position the cursor over the image you want to save, and click the
left mouse button. The key icon appears in the top left corner.

If you want to save the image as a key image again, make the necessary changes to the image — the key
image icon in the top left corner changes to a paper clip, indicating the image in the frame no longer
appears like it does in the report panel — set the cursor to key image mode and click on the image again.
In the report panel, two images appear, each with their individual display characteristics.

To select multiple images without having to reset the cursor mode between each click, hold down the Alt
key while you click on mouse button. The cursor mode will remain in key image mode after each mouse
click.

Instruction Summary — Saving a Key Image
» Load an image into an image frame, and set the display characteristics (window, level,
annotation, etc.)

» Select the key image cursor mode button, E, from the toolbox toolbar.
» Click on the image.

In the full report panel, the number of key images attached to each report segment (main report and
each addendum) is listed in each segment’s header.

When attaching key images to a report, it is useful to label each image so you can reference them in the
report. With the text annotation tool, you can manually add an identifier to each key image before
attaching it to the report. With the report figure numbering annotation tool, eRAD PACS can automatically
drop a sequential numeric label onto each image in the report, eliminating the need to explicitly type in a
text annotation. To use the report figure numbering tool, see section 6.2.4.

8.3.2 MODIFYING KEY IMAGES

Images in the full report panel are editable, as if they were in an image frame. Open the full report panel,
select the image, and change the window or level, add an annotation, change the zoom factor, etc. When
modifying the image in the report panel, there is no need to reassign it as a key image.

Additionally, you can drag and drop the key image from the full report panel into any image frame to
manipulate its settings. Note that changed settings from an image frame are not saved unless you
reselect the image as a key image and resubmit the report. To drag an image, position the cursor over
the diagonal lines in the top left corner of the image until the cursor changes to a hand. Press and hold
down the left mouse button, and drag the image to its destination. When the cursor is over the
destination image frame, release the mouse button.

Once a report is approved, i.e., the study state becomes Final, the images attached to that report

segment cannot be modified. To make a change, you must add an additional key image reflecting the
updated settings.
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8.3.3 PRINTING KEY IMAGES

To quickly add all the key images in a report to the print panel, open the report panel, click on the Images
menu, and select Add All Key Images to Print Panel. When you open the print panel, the key images
appear in the display area. You can edit or remove any image from the print panel.

8.3.4 REMOVING KEY IMAGES

To remove a key image, open the report panel, select the image and press the Delete key. You can also
remove a key image if it is displayed in an image frame in the main viewing workspace. The image in the
image frame must appear exactly as it does in the report panel as well. If the key image icon appears as
a key icon, T, then the image is ready for deleting. If this icon is not displayed on the image, you must
move it from the full report panel to an image frame. To do this, open the full report panel, and find the
key image you want to remove. Click on the diagonal lines in the top left corner of the image, and drag it
to an available image frame in the main viewing workspace.

To complete the remove process, put the cursor into key image mode by selecting the key image cursor

mode button, 8], Move the cursor over the image frame of the image you want to remove. The cursor
changes to a key with an ‘X’ through it. When in this mode, click on the image. You are prompted to
confirm the delete request. Click on Yes to remove the key image. You can also remove the key image
when in Normal cursor mode by placing the cursor over the key image icon in the top left corner of the
image. The cursor changes to a key with an ‘X’ through it. Click on the icon, the confirmation prompt
appears. Confirm the removal as before.

Instruction Summary — Removing a Key Image

» Click on the report button, ’| to open the full report panel.

» Scroll to the key images, and find the one you want to remove.

» Click on the top left corner of the key image and drag it to an image frame in the main
viewing workspace.

» Select the key image cursor mode, 0,

» Click on the image.

» At the popup notice, confirm the removal by selecting Yes.

It is not possible to remove a key image attached to a report segment that has been approved and is in
the Final state.

Removing one key image has no affect on any other key image, or any other instance of the selected
image that may be saved as a key image. To remove multiple key images based on a single image, you
must remove them individually using the procedure defined above.

8.4 Submitting Reports

After you create any report component, including recording a dictation, adding text to the report
impression, attaching a key image, amending a report or just changing the report state, submit the report
by selecting the Send Report button on the report panel.

If you create a report and decide to continue working on the study before submitting it, you can close the
report panel at any time by clicking on the OK Button. When you close the study, eRAD PACS checks to
see that you saved your work. If the report is not submitted, eRAD PACS prompts you to send the report.

When you attempt to save a report, and the viewer encounters a network problem, you can save the
report on your local hard disk so you can submit it at a later time. From the full report panel, select the
Save to hard disk option from the Report menu. Be aware that this is not the equivalent to submitting the
report to the eRAD PACS server. It simply saves your work on your local machine so you can come back
to it at another time. When the network problems are resolved, open the same study. eRAD PACS
detects the saved report, and notifies you that you have a copy of a report on your machine. From the
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notice, click on Yes to import the saved report. Everything you saved is now returned to the viewer, and
can be saved to the eRAD PACS server.
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9 User collaboration

When multiple users need to consult with each other while viewing a study, eRAD PACS allows them to
share a common instance of the viewer. When a user initiates a collaboration session, his/her viewer
appears on the workstation of the invited participants, and the actions applied by any one of the users is
rendered on the other's workstation. There is dual-cursor support so that each user can see what the
other is doing, and what they are highlighting. When used in combination with a telephone, the
participants can communicate and review the same study as though they were sitting together at the
same workstation.

Collaboration requires that the other participant(s) have the eRAD PACS viewer installed on their
workstation and running in standby mode (see section 4.2.1), and are presently logged into the same
eRAD PACS server under his or her own account.

Xl To establish a collaboration session, select the Connect option on
Enter session name. the Collaboration menu. A window appears, with a list of users

| connected to eRAD PACS. At this point, there are two options. If all

the intended participants are directly accessible from the network by

Creste nsw ssssion_ | the server, meaning they are on the same local area network, or the

— _ network does not consist of NAT devices or other redirection
Join existing session . . . . ..

—I devices, the collaboration host can invite users to join. If the server

Inwite: user from list | Disconnect | cannot reach one or more of the participants, the host must explicitly

create a collaboration session and the participants must individually
Uszers logged in ta server: join it.

Lois Laine

In the case were the server can address the workstation of each
participant, select the user you want to add to the collaboration
session and click on Invite User From List. The other user will
receive a prompt notifying him that you wish to establish a
collaboration session. If they accept the session, eRAD PACS
launches itself on the other user’'s workstation, and displays what is
presently displayed on your workstation.

In the case were the server cannot address the workstation, or when
the invite request fails with a message indicating the server could not
connect to the workstation, the host will have to create a session and each user will have to join it. Start
by having the host create a session name and click on Create New Session. Then have each participant
type in the same session name and click on Join existing session. When everyone has joined the
session, the workstation screens will contain the information displayed on the host’s screen.

When the connection is accepted, you will see a second cursor appear on your workstation. The white
cursor is yours. The red cursor is the cursor on the other user’s workstation. As each of you moves your
cursor, the other will see it move on his own workstation. Any action you take to change the image
display, including window/level settings, scrolling, series selection, zooming, annotations, etc., will appear
on the other workstation. The collaboration session only affects the main viewing workspace. The popup
windows, including the report panel, settings windows, notices, layout manager, and print panel, are not
shared on other participant’s workstations.

At all times during a collaboration setting, one of the users is the master, meaning they have control of the
session. By default, the host is the master. For security purposes, none of the other users can obtain
control of the session without the master granting it to him. To request control, the other user simply
clicks their mouse on the workstation. A notice appears on the master's workstation indicating that the
other user requested control of the session. The master user can either turn over control to the other
user, or deny the request. If control is passed over, then the original master must request it back using
the same technique.
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When the session is over, either user can request to terminate the session by selecting the Disconnect
option from the Collaboration menu, or the user who established the session can close the viewer. Once
the session is terminated, the users revert to the same access to the studies as they had prior to the
collaboration session.
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10 Saving data

The eRAD PACS viewer allows the user to save the image data to files on the local workstation using a
limited number of standard formats.

10.1Saving JPEG images

Users can save a copy of an image or series of images to the local file system in a JPEG formatted file by
using the Save function. Under the File menu, select Save Image, which saves the selected image, or
Save Series, which saves all the images in the selected series to individual JPEG files. After requesting
one of these options, eRAD PACS pops up a window from which the user can select a destination
directory and a file name. If saving a series of images, eRAD PACS automatically appends a numeric
increment to the base file name and places one image in each file. The resulting file contains the
annotations, zoom factor, window/level setting, and all other display characteristics as they appear on the
screen.

A user can also copy the selected image into the system clipboard so the image can be pasted into
another application. Select the image and choose the Copy option from File menu. To paste the image,
open the other application and select the paste option as defined by that application.

10.2Saving DICOM images

To save a copy of the original DICOM image, you must use the browser interface. The eRAD PACS
viewer cannot save DICOM objects. From the browser interface, you can create a DICOM-conformant
media by using the Export function, downloading the resulting 1SO file to your workstation, and then
writing this to a CD or DVD using the CD/DVD writing software installed on your PC. eRAD PACS does
not provide an application to write the data to the CD/DVD media. Refer to the eRAD PACS Operator’s
Manual for additional information.
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11 Printing

From the eRAD PACS viewer, you can print full-resolution images to DICOM conformant imagers, or to
ordinary printers supported by your Microsoft Windows operating system. The printing procedure starts
by selecting one or more images that are currently loaded into the eRAD PACS viewer, and arranging
them in the print panel. For information on the print panel, see section 3.6.4 and the section below.

You can print or hide the image overlays when you print images to either a Windows printer or a DICOM
printer. If the overlays are displayed on the screen when you request the print job, the resulting images
will display them as well. If the overlays do not appear on the images, they will not appear on the film or
paper. To display the overlays, select Show Image Information from the View menu, or hit the F10 key.

When printing images from the eRAD PACS viewer, if hash marks are displayed on the image, they will
appear on the printout.

If the user has defined a print header for Windows printouts, it also appears on DICOM printouts.

11.1 Print panel
To display the print panel, select Print S =

Trom the File menu. If you have _an & wWindows  Dicom Diopimage: ¢ Single © Series ¢ Study € Prompt
image frame selected when the print : _ = .

panel pops up, eRAD PACS _Proviow | [RONEADP722 ] setings| o [
automatically loaded it into the print Delete | Clear 41 | Layou [T 2] HDWS;P j Cancel|

panel. The number of images eRAD
PACS loads depends on the Drop
Image setting. eRAD PACS either
loads the selected image, the entire
series, the entire study, or prompts the
user to select an image range. If no o ,
image frame or series is selected, the
print panel opens with no images
automatically loaded.

To load additional images into the print
panel, position the cursor over the :
diagonal lines in the top left corner of .
the image in the image frame. The
cursor changes to a hand.  While
holding down the left mouse button,
drag the image over the print panel and
release the mouse button. You can
also drag the from the thumbnail panel into the print panel. The images in the print panel appear in a tile
mode, meaning they are not stack. Use the scroll bar on the right of the window to see all of the images.

To remove any or all images in the Print window, click to select the image and then click on the Delete
button. If you want to clear all the images, click on the Clear All button. It is not possible to delete more
than one image at a time with the exception of deleting all the images.

If you need to reorganize the images in the Print window, click on the image’s top left corner and drag it
from its current location and drop it into the destination position.

The remaining fields on the print panel are specific to the print device's protocol. See the following
sections for additional information.
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11.2 DICOM Printing

When printing to a DICOM printer, select DICOM in the print panel. This enables all of the DICOM
printing options. The pull-down menu lists all of the available DICOM printers. Select the printer you
want to send the print job to, and the Layout. The Layout shows the number of columns and rows on a
printed sheet of film. The options are represented as column, row.

To review the default printer parameters as defined in the printer configuration file on the server, click on
the Settings button. In most cases, the default settings are defined to work with the selected printer and
changes should not be necessary. However, there are times when you may want to change a setting for
a single print job. Modifying the parameters from this window changes them for the current print job. If
you wish to make the change permanent, you must have the system administrator change the setting on
the server.

The DICOM print settings consist of three tabbed pages. The Film page contains the settings that apply
to the film itself. The Session page contains the settings that apply to the entire print job. The Others
page contains miscellaneous settings. Each of these settings is described in the table below.

Many of the settings contain an option to use the default. The default is a value defined in the DICOM
printer configuration file. This file is created by the systems administrator, and is available from the
Server page in the browser interface. The default settings are usually the best option. Only override the
default when you know how it will affect your results.

Page Setting Parameters Description
Film Film Orientation | Portrait, Landscape Specifies the orientation of the film. Default is usually portrait.
Trim Trim, No Trim Specifies whether the film sheet is to contain trim. The default
is usually no trim.
Layout Rows, Columns Layout options configured for this printer.
True Size Printer specific Print the images at their true dimensional size.
Decimate/Crop Request crop, Request | Specified what happens to the image when it does not fit
behavior decimate, Request fail | within the defined boundaries of the image box.
Presentation LUT | Identity Not used.
lllumination Set presentation LUT illumination field to the defined value.
Default is 2000.
Reflection Set presentation LUT reflection field to the defined value.
Default is 10.
Session | Film session Copies The number of copies to request.
options Destination If the DICOM printer supports multiple destinations, indicate
which one to request.
Priority Specify the print priority, if supported.
Owner Indicate the owner of the print job.
Annotation Annotation Submit this value to the printer to use as annotation. The
options application of this string depends on the printer.
Prepend date Prepend the date to the annotation added by the printer.
Prepend printer name |Prepend the printer name to the annotation added by the
printer.
Prepend illumination Prepend the illumination information to the annotation added
by the printer.
Medium type Blue film, Clear film, Specifies the type of medium to use in the print request. The
paper application of this value depends on the capabilities of the
printer.
Film session Print this value as a header to each sheet printed. By default,
label this contains the information specified in the print header
defined on the Customize Settings’ DICOM field page.
Others | Film size ID Printer specific Specify the default film size.
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Description

Magnification

Printer specific

Specify the default zoom factor applied. This is in addition to
any zoom factor already applied to the image when it is
loaded into the print panel.

Smoothing type

Printer specific

Specify the smoothing algorithm to use when interpolating the
data.

Border density

Printer specific

Specify the density of the border. Usually a value of BLACK
or WHITE is sufficient.

Resolution ID

Printer specific

Specify the resolution identifier.

Config info Printer specific Printer-specific configuration parameter to send to the printer.
Empty image Printer specific Optical density to use in areas where no image exists.
density

Max density Printer specific Maximum density to use when printing.

Min density Printer specific Minimum density to use when printing.

Image box Printer specific Override the default magnification for a specific image.
magnification

type

Image box Printer specific Override the default smoothing type for a specific image.

smoothing type

Image box config | Printer specific Override the default printer-specific configuration parameter
info for a specific image.

The one notable print setting is the header used on the printed sheet. The default print header is defined
on the Customize Settings panel, under the DICOM Fields tab. Change the default string by editing it in
the print panel. Whatever appears in this field will appear at the top of each sheet of film. In order to
appear on the film, the DICOM printer must support the Field Session Label feature.

After selecting the printer, the layout and confirming the printer settings, if necessary, click on Print to
initiate the print job. A popup window appears notifying you that the print request is in process.
Depending on the type of printer, a print request may take a long time. When the printer confirms it has
received all the information and can proceed with the print job, eRAD PACS pops up a notice indicating
the request is complete. If any errors occurred, an error message appears.

It is possible to obtain detailed information exchanged between the eRAD PACS viewer and the printer
during a DICOM print session. This is only necessary when some anomaly occurs, and the print request
failed. To enable print logging, open the Customize Settings window from the Settings menu, and go to
the Advanced page. Make certain the value in the Keep the last N DICOM print log files is greater than
zero. Print logs are stored in the c:\Program Files\PracticeBuilder\dicomprint\logs directory. If print
problems exist, a customer support representative may request these files.

11.2.1 TRUE SIZE PRINTING

eRAD PACS supports true size printing via its DICOM print interface. The parameter in the printer-specific
section(s) of the DICOM Print configuration file, TrueSize, controls this setting. Refer to the the eRAD
PACS DICOM Printer Configuration Manual for details on DICOM printer configuration. When set to
“true”, print jobs submitted to this printer will be printed true size. To override this setting, open the print
panel click on the DICOM Settings button, and on the Film tab, check the True Size box to print the
image(s) in true size, or clear it to let the print size the images accordingly.

11.3 Windows Printing

When all the images you want to print are present in the Print window, select the number or rows and
columns you want to appear on the printed sheet. Note that the images displayed in the print panel do
not necessary conform to this setting. To preview the print results, click on the Preview button. In the
popup window, select the printer and click on OK. A new popup appears showing you what the results
should be on the selected Windows printer. You can either select to continue the print from this point, or
cancel out to return to the eRAD PACS print panel and click on Print to execute the print job.
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11.4 Printing Reports

eRAD PACS can print a copy of the report directly from the viewer to a printer connected to your PC. To
print the report, open the full report panel. From the top of the report panel window, select Report and
then click on Print. Your standard print window will appear. Click on OK to send the report and the
attached key images to the printer.
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12 Online Help and Troubleshooting

eRAD PACS viewer has integrated help files explaining the features and functions of the software, plus
data collection capabilities when more in depth assistance is required.

12.1 Online Help

eRAD PACS provides an online help system that provides assistance to users while they are using the
interface. The online help contains a searchable database containing information on many topics and
features, plus a summary of the latest features available in the viewer. From the online help, you can
also obtain details on the version of the eRAD PACS viewer you are running, which can be requested if
you need to contact support for assistance.

In the event the online help does not provide enough information on the requested topic, please consult
the written documentation.

To display the release news, select News from the Help menu. A window appears containing links to a
number of subjects, arranged in functional groups. To obtain details on any particular topic, click on the
link.

To display the complete help system, select Contents from the Help menu. A window appears consisting
of some tabbed pages. The Contents section is an organized collection of the help subjects. This
information is useful if you need to obtain an overview of some area of eRAD PACS. For information on a
single topic, select the Index tab, and type the subject in the field provided. When you find the specific,
double click to open the detailed information on the topic. To get back to the Index, select Help Topics
from the details page.

To obtain details about the specific version of the eRAD PACS viewer installed on your workstation,
select About eRAD PACS from the Help menu. If asked by a customer support representative which
version of the eRAD PACS viewer you have installed on your machine, provide the version number (and
the build revision if specified) listed in the popup window.

12.2 Activity Logs

Activity logs record every action performed during a viewer session, including user profile details and
information about studies loaded into the viewer, and ending when the session ends. This information is
used by eRAD support to play back the entire viewer session, to determine what actions were performed
and reproduce an anomaly, if present.

Since activity logging can negatively impact the viewer’'s performance, it is disabled by default. Enable it
from the Settings page in Customize Settings. Check the box labeled Create Log Files. Log files are
stored in C:\Program Files\PracticeBuilder\PBLogFiles. The filename contains the starting date and time
of the viewer session. Log files are purged when they are four days old.

eRAD PACS servers version 6.0 and later automatically upload activity logs to the server when the viewer
encounters an ungraceful termination, i.e., when the viewer crashes. The viewer takes longer to load the
first time after a crash because some of these logs may be large, or the network upload speed may be
slow. Uploaded log files are appended with the extension .sent. eRAD support can access uploaded files
from the server. Files that were not uploaded, specifically when using an eRAD PACS server prior to
version 6.0, have to be collected by the user and sent to eRAD support, when requested.

12.3Crash Logs

When the eRAD PACS viewer experiences an ungraceful termination, it can create a crash log. This log
file contains details about the viewer session and the point at which it crashed. Crash logs are useful for
eRAD support in identifying causes for unexpected anomalies in the viewer.
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Crash log generation is enabled by default. To change this setting, clear the checkbox labeled Create
Crash Dump on the Settings page in the Customize Settings window. Crash logs are stored in
C:\Programe Files\PracticeBuilder\PBLogFiles. The crash log contains the starting date and time of the
viewer session. Log files are purged when they are four days old.

eRAD PACS servers version 6.0 and later automatically upload crash logs to the server when the viewer
restarts. Uploaded crash logs are appended with the extension .sent. eRAD support can access uploaded
files from the server. Files that were not uploaded, specifically when using an eRAD PACS server prior to
version 6.0, have to be collected by the user and sent to eRAD support, when requested.
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